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1
ACS Main Screen

The Advanced Control Services main screen is displayed when you successfully log in to the
ACS UI. This screen displays icons that represent the configuration options available in ACS.
Click a button in the Advanced Control Services main screen to open the configuration screen
for that option.

Note

This Help set contains ACS component related information. Other component Help
sets are available at the following index page:

https://docs.oracle.com/en/industries/communications/convergent-charging-controller/
15.2/index.html

You can also use the search functionality in the index page to search for any keyword
across multiple Help sets.

ACS Configuration Options
The following table describes the Advanced Control Services configuration options.

Configuration Option Function

Control Plans Accesses the Control Plan Editor Overview where you configure your ACS
control plans.

Numbers Accesses the Numbers screen where you configure the access numbers that
trigger control plans such as service numbers (SN) or caller line identifier
(CLI) numbers.

Configuration Accesses the Configuration screen where you configure the ACS resources
used in control plans such as geography sets, holidays and announcements.

Resources Accesses the Resources screen where you configure service provider
resources such as termination ranges and number translations.

Customer Accesses the Customer screen where you configure service provider
information such as resource limits and contact information.

Tools Accesses the Tools screen where you configure system defaults such as
system languages, SMS user access, networks, and termination ranges.

Password Note: This option is not available to users who access ACS through the SMS.
For SMS logins, ACS uses the SMS security mechanism, so the user's
password must be changed through the SMS.

Accesses the Change Password screen. Users who can access this screen
can set up user passwords.

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 1 of 1

https://docs.oracle.com/en/industries/communications/convergent-charging-controller/15.2/index.html
https://docs.oracle.com/en/industries/communications/convergent-charging-controller/15.2/index.html


2
Passwords

For security reasons, the first time a customer uses ACS, they should change the user name
and password of the administrator user that the system provides for them. It is important to
inform the customer of this. This option is not available to users who open ACS through the
Service Management System (SMS).

Note: This is part of the ACS internal security mechanism, which is not required when run
through the SMS.

Changing Password
Note: This procedure can only be performed if you access the system via the ACS login
screen. If you log in to ACS through the SMS you will be unable to change your password
using this procedure.

Follow these steps to change your ACS user password.

1. Click Password on the ACS main screen.

Result: The Change Password screen appears.

2. Enter your current password.

3. Enter your new password.

4. Enter your new password again in the Confirm Password field.

5. Click Save.
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3
Customers

This topic explains how to configure customers in ACS.

Tiered Customer Structure
ACS allows the telco to directly provision individual resource-limited customers, or alternatively
to create a wholesale customer with a (larger) set of resource limits, and delegate to them the
ability to create individual customers, the sum of whose resource limits must never exceed
those of the wholesaler. This feature is called tiered customer management. A reseller is a
wholesaler that may in turn create and manage 'normal' customers, and/or other wholesale
customers (agents). Agents can only create normal customers.

The concept of telco-managed customers is unchanged by the advent of tiered customer
management. Telco managed customers are simply customers that never log into ACS but are
managed explicitly (and without resource limits) by the Telco.

The hierarchy of customer management thus looks like this:

• Telco

• Reseller

• Agent

• Customer

Resellers and agents are both implemented as ACS customers, because they both need to
have resource limits allocated to them. Resellers and agents can only set resource limits for all
their customers up to a combined total value that is less than or equal to their own resource
limits.

This allows them to be a kind of super-user in relation to those ACS customers attached to
them, for example. those customers that directly refer to them as their parent customer, or
indirectly (via one level of indirection only) as in the case of a reseller who can also see the
customers attached to their agents.

Resellers and agents may select any of their attached customers in the main customer combo
box at the top of various windows and ‘become’ that customer. It means the reseller/agent has
the means to edit their customers' configurations as desired.

Security Rules
When a customer is created, if the Create User for Customer check box is selected, an
administrator user, with level 5 permission, is also created. See Adding Customers. A reseller
may choose to change the permission level of an agent, to restrict what the agent is able to do.

As well as performing all tasks defined in Security level permissions, a user with permission
level:

• 5 or more (Reseller) can create and edit agents and customers, as long as the resource
limits allocated to them do not exceed those given to the reseller by the telco. Within the
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tiered hierarchy, a reseller may allocate, or move to other agents, customers under them. A
reseller cannot allocate customers to other resellers or their agents.

• 4 cannot create agents, but can create normal customers.

See Defining the Security Levels for details of ACS security levels.

Adding Customers
Follow these steps to add new a customer to the database.

1. On the Customer tab, click New.

Result: The New Customer screen is displayed.

2. In the Customer Name field, enter the name of the new customer.

3. In the Description field, enter a description of the new customer.

4. In the Customer Reference field, enter a reference number for the new customer.

Note: This field is optional, unless the parameter shown below is present in the
acsGui.bat/acsGui.sh (if you have logged on to ACS directly) or smsGui.bat/smsGui.sh
(if you have logged on through the SMS application) file, in which case it becomes
mandatory.

<param name=requireCustomerReference value="TRUE" />

5. Select the Customer Type from the drop down box. This can be:

• Normal

• Reseller [R]

• Agent [A]

6. Select what customer type the new customer is attached to

• Normal - Can attach to any of the options.

• Reseller - Attached to telco.

• Agent - Can attach to a reseller.

Note: Only the Telco (super-user) can see the Telco option.

7. A Resource Multiplier can be specified for a reseller or an agent.

The resource multiplier is used to scale the default resource limits that will be allocated to
the new customer. See Setting the Resource Limits for details.

Default values are:

• Reseller – 10

• Agent – 5

8. If:

• All the new customers' calls for service numbers and CLIs will use an override control
plan that is owned by the telco, select the Use override control plan check box and
go to Step 9.

• An override control plan is not required, leave this box cleared and go directly to Step
10.

Chapter 3
Adding Customers
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9. If you selected the Use override Control Plan check box in Step 8, select the Override
Control Plan that is to be used from the list.

10. From the Language drop down list, select the applicable language for your customer.

11. If required, enter a PIN in the PIN field.

12. If required, enter a management ID in the Management ID field.

13. If the customer is to be managed by the ACS administrator, select the Managed
Customer check box. By default this is selected.

Important: This indicates that this is not a self managed customer.

14. If you want ACS to allocate a user for your new customer, select the Create User for
Customer check box.

Note: If the Create user for Customer check box is selected the user name
"Administrator" and password "admin" will be allocated. It is important that the customer
changes the password for this user when they use the system for the first time.

When a new customer is added, a user of privilege level 5 will be supplied by the system.

15. In the Termination Number Range Rules screen section, select:

• Own Range to use the termination ranges set up on the Termination Ranges tab of the
ACS Resources screen.

• Default Range to use the default termination range set up on the Default Termination
Range tab of the ACS Tools screen.

• No Checking to accept the termination numbers without validation (Default).

16. Click Save.

Result: The new customer's details are saved in the database.

To change the default resource limits, go to Customer Resource Limits for details.

Related topic

Customers

Editing Customers
Follow these steps to edit customer information in the database.

1. In the table on the Customer tab, select the customer to edit.

2. Click Edit.

Result: The Edit Customer Details screen is displayed.

3. Change the customer details as required. See Adding Customers for details about the
fields.

Note: You cannot change the override control plan.

If you wish to change a reseller or agent that this customer is attached to, first clear the
combo box and press Enter to display the list to pick from.

4. Click Save.

Result: The details are saved and the screen will return to the main window.

Related topic

Customers

Chapter 3
Editing Customers
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Deleting Customers
Follow these steps to delete a customer from the database.

Warning: Deleting a customer record will delete all other configuration used by the customer.

1. In the table on the Customer tab, select the customer to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The customer is removed from the database.

Note: You cannot delete a customer if it is:

• A reseller (Type R) with an agent or customer

• An agent (Type A) with a customer

You will see an error message. You must delete, or re-attach to other resellers or agents, all
attached customers and/or agents first. See Tiered hierarchy.

Chapter 3
Deleting Customers
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4
Customer Resource Limits

The Resource Limits tab of the ACS Customer screen is used to manage and display the
resource limitations for each of your customers.

Only ACS system administrators have access to this tab. Users with privilege levels less than 6
will not see this tab.

Setting the Resource Limits
Follow these steps to set the resource limits for each of a customer.

1. On the Resource Limits tab, select the customer record to edit the resource limits for.

2. Click Edit.

Result: The Edit Customer Resource Limits screen is displayed. The groups within the
Public Set Access frame are populated with the names of sets made public on the
appropriate tabs on the ACS Configuration screen.

3. Select the maximum number for each of the fields in the Set Number Allowed frame.

Refer to Set Number Allowed Fields and Set Number Allowed Columns for a description
for each field.

Note: As you change the value in a field, the Available from Parent, Available To
Customer and Changes Pending fields are updated to track the change made.

4. Managed customers gain default access to all Public Set Access options.

Alternatively, select the appropriate check boxes to allocate sets for each group in the 
Public Set Access frame.

5. Click Save.

Result:

If there is available resource, the details are saved and the screen will return to the main
window.

If you have set a number to less than the available resources (that is, the Available field
displays a negative value), you will see an error. You will need to change the value before
saving.

Related topic

Customer Resource Limits

Edit Customer Resource Limits Fields
Here are the descriptions of fields and areas on the Edit Customer Resource Limits screen.
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Set Number Allowed Fields

Field Sets the maximum number of... Range Default

Users Users that the customer can configure. 0 - 1000 20

Event Counters Statistics counters that the customer can configure.
See Event Counters.

0 - 100000 10

Feature nodes in
Control Plan

Feature nodes that the customer can use in a
single control plan (including all sub control plans).

0 - 2000 100

Control Plans Control plans that the customer can use. 1 - 1000000 20

Control Plan Structures Control plan structures that the customer may
create.

Control plans are made up of control plan data and
a control plan structure. It is possible for many
control plans to use the same structure, provided
they each have their own data.

3 - 1000000 20

Announcement Sets Announcement sets that the customer can
configure. See Announcements.

Tip: You should set this value to 3 or more.

0 - 1000 1

Announcement Entries Announcement entries that the customer can
configure per announcement set. See 
Announcement Entries.

0 - 100000 20

Holiday Sets Holiday sets that the customer can configure. See 
Holidays.

0 - 1000 1

Holiday Entries Holiday entries that the customer can configure.
See Adding Holiday Entries.

0 - 10000 20

Geography Sets Geography sets that the customer can configure.
See Geography Sets.

0 - 1000 1

Geography Entries Geography entries that the customer can
configure. See Geography Sets and Entries.

0 - 20000 20

Set Number Allowed Columns
This table describes the function of each read-only display field to the right of the Set Number
Allowed fields.

Column Description

Available From Parent Displays how many of each resource limit is
available from the parent level.

If the user is at the top level, this column will
display two dots, meaning not applicable.

Directly Used Displays how many of the allocated resources are
being (directly) used by the customer.

Delegated Displays how many have been delegated (as limits)
to sub-customers - this will only have non-zero
values for resellers and agents. These resources
consume the customer's available count in the
same way as direct usage.

Available To Customer Displays how many of each resource limit is still
available for the customer to either use or delegate.

Chapter 4
Edit Customer Resource Limits Fields
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Column Description

Changes Pending The numbers in the first four columns total that in
the set number allowed field for that resource.

As you change the number, the Available to
Customer and Changes Pending fields for that
resource will change to track the difference.

After you save, this field will reset to blank.

Public Set Access
The groups of check boxes in the Public Set Access frame display all the public sets that are
available to the customer. Select the check boxes to allocate the specific public sets that the
customer will be allowed to access. Refer to:

• Feature Sets

• Announcements

• Geography Sets

• Holidays

Tip: Only previously configured sets will appear in each list of sets.

Chapter 4
Edit Customer Resource Limits Fields
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5
Customer Contacts

The Contacts tab of the ACS Customer screen is used to manage and display the contact
information for each customer.

The customer displayed in the Customer field is the customer for which the contacts are
displayed and managed.

Customer Contacts Fields
This table describes the function of each field.

Field Description

Contact Name The name of this contact

Telephone Number The main telephone number for this contact

Note: You can only enter digits in the number
fields.

Mobile The mobile telephone number for this contact

Pager The pager number for this contact

Fax The fax number for this contact

E-mail The email address for this contact

Comments Any required comments about this contact

Adding Customer Contacts
Follow these steps to add new customer contacts for a customer.

1. On the Contacts tab, click New.

Result: The New Customer Contacts screen is displayed.

2. Enter details for the contact, as described in Customer Contacts Fields.

3. Click Save.

The new customer contact's details are saved in the database.

Related topic

Customer Contacts

Editing Customer Contacts
Follow these steps to edit customer contact information for the customer.

1. From the Contacts tab, select the customer contact to edit.

2. Click Edit.

Result: The Edit Customer Contacts screen is displayed.
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3. Change the contact details, as described in Customer Contacts Fields.

4. Click Save.

Result: The details are saved and the screen will return to the main window.

Related topic

Customer Contacts

Deleting Customer Contacts
Follow these steps to delete a customer contact for a customer.

1. From the Contacts tab, select the customer contact to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The customer contact record is removed from the database.

Chapter 5
Deleting Customer Contacts
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6
Users

The Users tab of the ACS Customer screen is used to configure and display users for each
customer.

A user is an individual who can access ACS on behalf of the customer. A customer is the
person or company who purchases their telecommunication services from the telco.

Only users of privilege level 5 and above may add, edit or delete other users. Users of below
level 5 privilege may be prevented from seeing this tab by leaving the Users may access this
screen check box clear.

Note: This tab can only be accessed by the ACS system administrator.

Supplied User
For customers who wish to access ACS themselves, users must be set up. For customers who
are to be completely managed by the telecommunications provider, the Managed Customer
check box should be selected for the customer on the Edit Customer screen; this will allow the
telco to skip the following set up steps:

• Set up a privilege level 5 user in the Users tab

• Add termination ranges for the customer in the Termination Ranges tab on the ACS
Resources screen

• Allocate the resources that the customer can use in the Resource Limits tab

Each customer must have at least one user of privilege level 5 to enable them to effectively
use the ACS service themselves. When a new customer is added to ACS, the system assigns
a level 5 user with a user name and password of Administrator. Using this user ID, the
customer may set up other users of privilege level 5 or below as they wish. Additional users
are set up on the Users tab of the Customer screen.

Important: For security reasons, the first time the customer uses ACS, they should change the
username and password of the administrator user that the system provides for them. It is
important to inform the customer of this.

Users Fields
This table describes the function of each field in the ACS Users dialog.

Field Description

User Name The user name must be unique for the customer,
although there may be several customers with a
user “Mary Smith”, there may only be one user
“Mary Smith” for each customer.
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Field Description

Privilege Level Use the list to select the privilege level for the user.
Privilege levels are described in Defining the
Security Levels.

When creating new users, they may be assigned a
privilege level. Level 5 and 6 users may create
users of privilege levels 1-5.

Password This field allows you to enter the user's password.

For security reasons, this will not display the
characters that are actually entered. The password
will be displayed as a line of asterisks. Users are
required to enter a password.

Confirm Password This field allows you to enter the user's password
for a second time, to confirm that the entry of the
password is correct.

If the entries in both the logon Password and the
Confirm Password fields are not the same, then
the user cannot be saved.

For security reasons, the password will be
displayed as a line of asterisks. The user may not
be saved until a password has been entered and
confirmed correctly.

User Locked The check box indicates the lock status for the
user. This check box has two functions:

• It shows if the user is currently locked out of
the system. A user may become locked out of
the system if they have attempted to log on
unsuccessfully three times.

• It allows a user of privilege level 5 or above to
manually unlock a user who has become
locked out of the system if required; otherwise
they will be automatically unlocked in 12
hours.

A locked user may not log on, even with the correct
password, until they are unlocked. This added
security mechanism prevents unauthorized users
from guessing at a password until they get it
correct, thus gaining unauthorized access to the
system.

Note: You cannot manually lock a user. If
necessary, to prevent a user from accessing the
system, the system administrator should either
delete the user or change their password.

The User Locked check box is part of the ACS
internal security mechanism. If ACS has been
opened through the SMS, this functionality will not
be available because the SMS security mechanism
will be used instead.

Java Config Allows you to set Java configuration parameters to
customize the ACS User Interface (UI) for the user.
For example, you can define initial settings for the
Control Plan Editor (CPE) window by setting the
CPE parameter. For more information, see the
discussion on Configuring Control Plan Editor in
CPE User's Guide.

Chapter 6
Users Fields
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Adding Users
Follow these steps to add a new user.

1. On the Users tab, click New.

Result: The New Users screen is displayed.

2. Create the user details by filling in the fields, as described in Users Fields.

3. Click Save.

Result: The details are saved and you return to the Users tab.

4. If you wish users with privilege level 5 or less to have access this screen, select the Users
may access this screen check box (in the main Users tab).

Related topic

Users

Editing Users
Follow these steps to edit an existing user.

1. On the Users tab, select the user to edit.

2. Click Edit.

Result: The Edit Users screen is displayed.

3. Change the details, as described in Users Fields, as required.

4. Click Save.

Result: The details are saved and you return to the Users tab.

Related topic

Users

Deleting Users
Follow these steps to delete a user.

1. On the Users tab, select the user to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The user is removed from the database.

Chapter 6
Adding Users
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7
Control Plan Change

The Control Plan Change tab allows you:

• To replace the termination number in the termination node of a control plan

• For each service number on the ACS Numbers screen, to override the scheduled control
plan, with the predefined alternative control plan

Note: To override a scheduled control plan, the alternative control plan name must follow
this syntax:

<ServiceNumber><alternativeCallPlanNamePostfix>

For example, if service number 0800123456 uses control plan "ABC", the alternative
control plan for this service number must be named
0800123456_alternativeCallPlanNamePostfix.

Where alternativeCallPlanNamePostfix is the value specified in the
alternativeCallPlanNamePostfix parameter of the acs.conf file. For more information,
see ACS Technical Guide.

Tab Areas
This table describes the function of each area of the tab.

Field Description

Alternative control plans Allows you to activate or deactivate the alternative control plans.

State Text displays the current state of control plan activation:

• “Normal status: no control plan changes in effect.”
• “Emergency control plans activated.”

Termination number
substitution

Allows you to activate or deactivate the termination number substitution.

You can add, edit, and delete the termination number/replacement
number pair.

State Text displays the current state of number substitution:

• “Normal status, no termination number changes in effect.”
• “Termination numbers substituted.”

Activating Alternative Control Plan Changes
Follow these steps to activate the alternative control plan changes.

1. On the Control Plan Change tab, in the Alternative control plans area, if currently
deactivated, you can click Activate.

Result: The Activation Confirmation dialog appears.

2. Click Activate.

Result: Activates the control plans. The text (see Tab Areas) at the top of the following
tabs changes to display the new state of activation and substitution:
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• Control Plan Change tab

• Service Numbers tab of the Numbers screen (if any are activated)

Deactivating Alternative Control Plan Changes
Follow these steps to deactivate the alternative control plan changes.

1. On the Control Plan Change tab, in the Alternative control plans area, if currently
activated, you can click Deactivate.

Result: The Deactivation Confirmation dialog appears.

2. Click Deactivate.

Result: Deactivates the control plans. The text (see Tab Areas) at the top of the following
tabs changes to display the new state of activation and substitution:

• Control Plan Change tab

• Service Numbers tab of the Numbers screen (if any are activated)

Activating Termination Number Substitution
Follow these steps to activate the termination number substitution.

1. On the Control Plan Change tab, in the termination number substitution area, if currently
deactivated, you can click Activate.

Result: The Activation Confirmation dialog appears.

2. Click Activate.

Result:

• The termination number substitution is activated

• The text (see Tab Areas) changes to display the new state of activation and
substitution at the top of the Control Plan Change tab and the Service Numbers tab
of the Numbers screen (if any are activated)

Deactivating Termination Number Substitution
Follow these steps to deactivate the termination number substitution.

1. On the Control Plan Change tab, in the Termination number substitution area, if
currently activated, you can click Deactivate.

Result: The Deactivation Confirmation dialog appears.

2. Click Deactivate.

Result: The:

• Termination number substitution is deactivated

• The text (see Tab Areas) changes to display the new state of activation and
substitution at the top of the:

– Control Plan Change tab

– Service Numbers tab of the Numbers screen (if any are activated)

Chapter 7
Deactivating Alternative Control Plan Changes
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Adding a Termination Number Substitution
Follow these steps to add a termination number substitution.

1. On the Control Plan Change tab, click New...

Result: The New Termination Number substitution screen is displayed.

2. Enter the termination number and the replacement number.

3. Click Save.

Related topic

Control Plan Change

Editing a Termination Number Substitution
Follow these steps to edit a termination number substitution.

1. On the Control Plan Change tab, select a termination number/replacement number pair
from the table and click Edit...

Result: The Edit Termination Number substitution screen is displayed.

2. Make changes to the termination number and the replacement number.

3. Click Save.

Related topic

Control Plan Change

Deleting a Termination Number Substitution
Follow these steps to delete a termination number substitution.

1. On the Control Plan Change tab,select a termination number/replacement number from
the table and click Delete.

Result: The Deletion Confirmation dialog is displayed, with a confirmation of the
termination and replacement number pair.

2. Click Delete to delete the substitution.

Related topic

Control Plan Change

Chapter 7
Adding a Termination Number Substitution
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8
Geography Sets

The Geography tab of the ACS Configuration screen is used to add, edit and remove
geography sets and their respective entries.

Note: It is never possible to delete a geography set or entry that is currently in use by a
compiled control plan. Deleting a geography set will delete all entries in that set. Editing a
geography set or entry will cause all compiled control plans that use that geography set to be
recompiled.

Geography Set Definition
A geography set is a group of geography entries. A geography set may belong to a specific
customer, or may be public — usable by any customer. Here are some example geography
sets:

• North/South Island (Public)

• Major City Breakdown (Public)

• Pizza delivery company nearest call center to each major exchange (service provider
specific).

Geography Entry Definition
A geography entry is a calling area defined by a prefix in the dialed number. The prefix is a
code for the given location and can be used in whatever way ACS requires. For example, in
the geographic routing feature node it is matched to the calling party number.
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9
Geography Sets and Entries

Adding Geography Sets
Follow these steps to add a new geography set.

1. On the Geography tab, click New Set.

Result: The New Geography Set screen is displayed.

2. In the Geography Set field, enter the name of the set.

Geography set names must be unique for each customer. Sets do not need to be unique
between customers unless they are to be public, in which case they must be unique.

The name can be up to 50 alphanumeric characters in length, but may not be left blank.

3. If you require a:

• Public geography set (that is, you want the new set to be available to all users), select
the Public box

• Customer-specific geography set, leave the box not selected

4. Note: A private set may not be edited and made public, nor may a public set be edited to
become private.

5. Click Save to add the geography set to the database.

Result: The new geography set will be available in the drop-down list

Related topic

Geography Sets and Entries

Adding Geography Entries
Follow these steps to add a new geography entry to a geography set.

1. On the Geography tab, select the geography set to edit from the Geography Set drop
down list.

2. Click Edit Set.

Result: The Edit Geography Set screen is displayed.

3. Select the folder you would like to add the new entry to.

Result: Once selected, the folder name is displayed in the Location field.

4. Click Add Entry.

Result: The Add Entry Screen appears.

5. In the Name for New Entry: field, enter the name of the new geography entry.

6. Click Save.

Result: The geography entry will be added as a branch under the geography set name.
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7. Select the new geography entry from the Edit Geography Set screen.

8. If required, enter a prefix for the entry in the Prefix field.

9. Click Accept Changes.

Note: If the geography entry contains nested entries, a prefix is not required and the
Accept Changes button remains unavailable. If the geography entry does not contain
nested entries, the Accept Changes button becomes available when the Prefix field is
populated.

10. 10 Click Save.

Result: The geography set changes are added to the database.

Note: If the set is used in a compiled control plan, the compiler will attempt to recompile all
control plans that use the set and will display the compiler report. The compiler report gives
details of all the control plans that were affected by the change and provides a report on status
of each control plan.

Related topic

Geography Sets and Entries

Editing Geography Entry Prefixes
Follow these steps to add or edit prefixes for existing geography entries.

1. On the Geography tab, select the geography set to edit from the Geography Set drop
down list.

2. Click Edit Set.

Result: The Edit Geography Set screen is displayed.

3. Select the entry you would like to change the prefix for.

Result: Once selected, the entry name is displayed in the Location field.

4. In the Prefix field, make the necessary changes to the prefix.

5. Click Accept Changes.

Note: The Accept Changes only becomes available for entries that have no nested
entries below them.

6. Click Save.

Result: The geography set changes are saved to the database.

Note: If the edited geography set is used in a compiled control plan, the compiler will
attempt to recompile all control plans that use the set and will display the compiler report.
The compiler report gives details of all the control plans that were affected by the change
and provides a report on status of each control plan.

Related topic

Geography Sets and Entries

Deleting Geography Entries
Follow these steps to remove a geography entry.

1. In the Edit Geography Set screen, select the geography entry to delete.

Chapter 9
Editing Geography Entry Prefixes

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 2 of 3



2. Click Remove Entry.

Result: The geography entry is deleted.

3. Click Save.

Result: The geography set changes are saved to the database.

Note: Deleting a geography entry will cause all compiled control plans that use that
geography set to be recompiled and will display the compiler report. The compiler report
gives details of all the control plans that were affected by the change and provides a report
on status of each control plan.

Deleting Geography Sets
Follow these steps to remove an existing geography set from the database.

1. On the Geography tab, select the geography set to delete from the Geography Set drop
down list.

2. Click Delete Set.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The geography set is deleted.

Tip: It is not possible to delete a geography set that is used in a control plan. To delete this
geography set, the control plans that use the geography set must first be changed to use
another set. Once this set is not used by any node in any control plan, then it may be
deleted.

Chapter 9
Deleting Geography Sets
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10
Geography Regions

Adding Geography Regions
Follow these steps to create a geography region, and add geography entry prefixes to that
region.

1. On the Geography tab, click Edit Regions.

Result: The Edit Geography Regions screen is displayed.

2. In the Available regions field, enter the name of the region.

This field may be used to search for and select existing regions or create new regions.

3. From the Geography Tree, select the geography entry or geography prefix that is to be
part of the selected region.

4. Click Connect to connect the selected geography entry or prefix to the selected region.

Note: Where a geography entry is connected to a region, then all prefixes below that entry
are also connected to the same region unless a prefix is specifically connected to a
different region.

5. Add all entries and prefixes to the region as required.

6. Once the region is complete, click Cancel to return to the Geography tab.

Note: All changes to a region are automatically saved to the database.

Displaying all Nodes in a Region
Follow these steps to display all nodes (that is, geography entries and prefixes) that are
connected to a specified region.

1. In the Available Regions combo box, either enter a new name or select a name from the
drop-down list.

Note: The combo box may be used to search for and select existing regions or create new
regions. See Combo boxes for details on how to use this field.

2. Click Show Connections.

Result: The entries and prefixes that are connected to the region will be highlighted in the
Geography Tree.

Disconnecting from a Region
Follow these steps to disconnect a geography entry or prefix from a region.

1. From the Geography tab, click Edit Regions.

Result: The Edit Geography Regions screen opens, with the Geography Tree tab active.

2. From the geography tree, select the geography entry or prefix to disconnect.
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Result: If the geography entry or prefix has nodes associated with it, node names will
appear in the Regions connected to selected nodes field of the Geography Tree tab.

3. In the Regions connected to selected nodes field, click the node to disconnect.

4. Click Disconnect.

5. Click Cancel to return to the Geography tab.

Note: The changes will still be saved to the database.

Finding a Geography entry
Follow these steps to locate a geography entry (node) in a geography tree by name.

1. On the Geography tab, click Edit Regions.

Result: The Edit Geography Regions screen is displayed.

2. In the Find nodes named field, enter the name of the node (geography entry) to searched
for.

3. Click Find.

Result: Entries that match the search criteria will be displayed on the Names tab.

4. Select the entries to be located in the geography tree and click Show In Tree.

Result: The Geography Tree tab is displayed with the selected entries highlighted.

Chapter 10
Finding a Geography entry
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11
Holidays

You use the Holidays tab to configure holiday sets and holiday records for each of your
customers.

A holiday set is a set of day-of-year records that mark specific days as being "holiday" days.

About Updated Holiday Set Data in Control Plans
Customers can use holiday set data in Day Of Year feature node configurations in their control
plans (for example, to route calls to a messaging service when their businesses are closed).

When you update the entries in a holiday set, all the control plans that reference the updated
holiday set in a Day Of Year feature node are recompiled automatically. However, if a control
plan was already in the control plan cache when the holiday set data was updated, because
the control plan is being triggered by platform traffic, then the updates will not be available until
the recompiled control plan is reloaded into the cache. This creates a delay between
recompilation and new data being available on the SLC.

Control plans are reloaded into the control plan cache at regular intervals, and when the SLEE
is restarted. You may be able to configure the frequency with which the control plan cache is
flushed for some services. For example, you configure when to flush the control plan cache for
the CCS service by configuring the following parameters in the ccsSvcLibrary section of the
eserv.config configuration file:

• callPlanAndDataCacheFlushTime

• callPlanAndDataCacheMaxAge

For more information, see CCS Technical Guide.

For information about control plan configuration, see CPE User's Guide.

Adding Holiday Sets
Follow these steps to add a new holiday set.

1. On the Holidays tab, click New Set.

Result: The New Holiday Set screen is displayed.

2. In the Holiday Set field, enter the name of the set.

Note: Each holiday set name must be unique for a particular customer - but two different
customers may have sets with the same name. If the holiday set is to be saved as a public
set, then the name must be unique. The set name may be up to 50 alphanumeric
characters in length, but cannot be left blank.

3. In the Description field, enter a description of the set.

4. If you require a:

• Public holiday set, select the Public check box.

• Customer-specific holiday set, leave the box not selected.
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5. Note: A private set may not be edited and made public, nor may a public set be edited to
become private.

6. Click Save to add the new holiday set to the database.

Related topic

Holidays

Editing Holiday Sets
Follow these steps to edit an existing holiday set.

1. On the Holidays tab, select the holiday set to edit from the Holiday Set drop down list.

2. Click Edit Set.

Result: The Edit Holiday Set screen is displayed.

3. Make the necessary changes to the description.

Note: You cannot change the Holiday Name or change the public/customer-specific status.

4. Click Save.

Result: The holiday set changes are saved to the database.

Note: Editing a holiday set or holiday entry causes all compiled control plans that use that
holiday set to recompile. The compiler report gives details about the status of each affected
control plan.

Related topic

Holidays

Deleting Holiday Sets
Follow these steps to delete an existing holiday set.

Note: Deleting a holiday set will delete all holiday entries in that set. It is not possible to delete
a holiday set that is currently in use by a compiled control plan.

1. From the Holidays tab, select the holiday set to delete.

2. Click Delete Set.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The holiday set is removed from the database.

Tip: It is not possible to delete a holiday set that is used in a control plan. To delete this holiday
set, the control plans that use the holiday set must first be changed to use another set. Once
this set is not used by any node in any control plan, then it may be deleted.

Related topic

Holidays

Adding Holiday Entries
Follow these steps to add a new holiday entry to an existing holiday set.

Chapter 11
Editing Holiday Sets
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1. On the Holidays tab, select the holiday set to add a new holiday entry to from the Holiday
Set drop down list.

2. Click New.

Tip: The New button is located at the bottom of the screen. The new button at the top of
the screen is New Set.

Result: The New Holiday screen is displayed.

3. In the Name field, enter the name of the holiday entry.

4. From the Start Date and End Date drop down boxes, select a start and end date.

Tip: Holiday entries may not overlap. Each day may only belong to one holiday within the
holiday set.

5. In the Description field, enter a description of the holiday entry.

6. Click Save to add the holiday entry to the holiday set selected in step 1.

Note: Adding an entry to a set that is used in compiled control plans will cause all control plans
that use that set to be recompiled and will display the compiler report. The compiler report
gives details of all the control plans that were affected by the change and provides a report on
status of each control plan.

Related topic

Holidays

Editing Holiday Entries
Follow these steps to edit an existing holiday entry in a holiday set.

1. On the Holidays tab, select the holiday set which contains the holiday entry to edit.

2. From the table, select the holiday entry to edit.

3. Click Edit.

Tip: The Edit button is located at the bottom of the screen. The edit button at the top of the
screen is Edit Set.

Result: The Edit Holiday screen is displayed.

4. Make the necessary changes to the Start and End dates and description.

Note: You cannot edit the Name field.

5. Click Save.

Result: The holiday entry changes are saved to the database.

Note: Editing a holiday set or holiday entry will cause all compiled control plans that use that
holiday set to be recompiled and will display the compiler report. The compiler report gives
details of all the control plans that were affected by the change and provides a report on status
of each control plan.

Related topic

Holidays

Deleting Holiday Entries
Follow these steps to delete an existing holiday entry from a holiday set.

Chapter 11
Editing Holiday Entries
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1. On the Holidays tab, select the holiday set which contains the holiday entry to delete.

2. From the table, select the holiday entry to delete.

3. Click Delete.

Tip: The Delete button is located at the bottom of the screen. The delete button at the top
of the screen is Delete Set.

Result: The Confirm Delete prompt is displayed.

4. Click OK.

Result: The holiday entry is removed from the holiday set in the database.

Tip: It is not possible to delete a holiday entry that is used in a control plan. To delete this
holiday entry, the control plans that use it must first be changed to use another holiday entry.
Once this entry is not used by any node in any control plan, then it may be deleted.

Note: Deleting a holiday entry will cause all compiled control plans that use that holiday set to
be recompiled and will display the compiler report. The compiler report gives details of all the
control plans that were affected by the change and provides a report on status of each control
plan.

Related topic

Holidays

Chapter 11
Deleting Holiday Entries
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12
Announcements

All the announcements that are used in your customer control plans must belong to an
announcement set. Announcement sets are a convenient way of grouping common
announcements together.

An announcement set may belong to a specific customer or may belong to no customer, in
which case the announcements it contains are public (that is, they can be used by any
customer). For example:

• General announcements (public)

• Please hold announcements (public)

• Warehouse mail order announcements (customer-specific)

• Warehouse head office announcements (customer-specific)

Note: It is not possible to delete an announcement set that is currently in use by a compiled
control plan. Deleting an announcement set will delete all announcement records in that set.
Editing an announcement set or announcement entry will cause all compiled control plans that
use that announcement set to be recompiled.

Announcement Set Fields
This table describes each field of an Announcement Set screen.

Field Description

Announcement Set The name of the set.

Note: This field cannot be changed after it is first
saved.

Description A description of the set.

Public Controls the availability of this set.

If selected, the set is a public announcement set
and can be used by all users of the system.

If not selected, the set is customer-specific and can
only be used by the ACS customer which created
it.

Notes:
• A private set may not be edited and made

public, nor may a public set be edited to
become private.

• This field cannot be changed after it is first
saved.

Adding Announcement Sets
Follow these steps to add a new announcement set.

1. On the Announcements tab, click New Set.
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Result: The New Announcement Set screen is displayed.

2. Configure this record by entering data in the fields on this screen.

For information about the fields on this screen, see Announcement Set Fields.

3. Click Save to save the details to the database.

Result: The new announcement set will be available from the announcement set drop
down list.

Related topic

Announcements

Editing Announcement Sets
Follow these steps to edit an existing announcement set.

1. On the Announcements tab, select the announcement set to edit from the
Announcement Set drop down list.

2. Click Edit Set.

Result: The Edit Announcement screen is displayed.

3. Edit the fields to make the required changes.

For information about the fields in this screen, see Announcement Set Fields.

4. Click Save.

Result: The announcement set changes are saved to the database.

Note: Editing an announcement set will cause all compiled control plans that use that
announcement set to be recompiled and will display the compiler report. The compiler
report gives details of all the control plans that were affected by the change and provides a
report on status of each control plan.

Related topic

Announcements

Deleting Announcement Sets
Follow these steps to delete an existing announcement set.

Warning: Deleting an announcement set will delete all announcement entries in that set.

1. On the Announcements tab, select the announcement set to delete from the
Announcement Set drop down list.

2. Click Delete Set.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The announcement set and all its announcement entries are removed from the
database.

Tip: It is not possible to delete an announcement set that is used in a control plan. To
delete this announcement set, the control plans that use the announcement set must first
be changed to use another set. Once this set is not used by any node in any control plan,
then it may be deleted.

Chapter 12
Editing Announcement Sets
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Announcement Entries
Announcement entries are contained within an announcement set. The telecommunications
provider must record each announcement onto a Specialized Resource Function (SRF). This
announcement must be assigned a:

• Resource Name (the name or location of the SRF on which it is stored)

• Resource ID (the identification of the audio file on the SRF that gives the exact location of
the announcement)

The ACS system requires the following for each announcement entry:

• Language

• Resource Name

• Resource ID

This allows ACS to determine exactly where the announcement recording is located and the
language in which it is recorded - as shown in the diagram below:

A preferred language is set for each ACS customer. This is the language in which all
announcements are played in control plans for that customer. If an announcement mapping
does not exist for the selected language, the system will use the announcement mapping for
the system's default language for that particular instance.

The system needs an address to locate the announcement. For this reason, the
Announcements screen should not be closed until at least one of the announcement mappings
defined uses the default language.

When a control plan encounters this announcement, it will attempt to use the customer's
preferred language. If no mapping exists for that announcement/language, then it will attempt
to use the default language. If a mapping does not exist for the announcement in the default
language, then the announcement cannot be played (a system error will be logged and the call
will be terminated).

Announcement Entry Fields
This table describes the function of each field.

Field Description

Name The name of the new announcement entry.

Note: This field cannot be changed after it has been saved for the first time.

Description A description of the new announcement entry.

Language The default language for the announcement. This field is populated by the
Language tab on the ACS Tools screen.

Resource Name The name of the SRF which will play the announcement.

Note: This must match the srfName parameter in the acs.conf file. See ACS
Technical Guide.

Chapter 12
Announcement Entries
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Field Description

Resource ID The ID number of the audio file of the announcement.

VARS Mapping The VARS mapping to use to construct the announcement. This field is
populated by the VARS Mapping tab.

Adding Announcement Entries
Follow these steps to add announcement entries to an existing announcement set.

1. On the Announcements tab, select the announcement set to add an announcement entry
to.

2. Click New.

Tip: The New button is located at the bottom of the screen. The new button at the top of
the screen is New Set.

Result: The New Announcements screen is displayed.

For a description of each field on this screen, see Announcement Entry Fields.

3. Complete the Name and Description fields.

4. In the Mapping Editor section, add the announcement mapping. Select a language and
type of mapping for the announcement entry:

• For standard announcements, select the Resource ID + Resource Name option. Go
to Step 5.

• For announcements that have variable announcement rules specified, select the VARS
Mapping option. Go to Step 6.

For more information, see VARS Mapping.

5. If Resource ID + Resource Name Mapping was selected in step 4:

• Configure the Resource Name and Resource ID.

• Click Add.

• Go to step 8.

Result: The language and resource mapping are added to the announcement entry.

6. If VARS Mapping was selected at step 4:

• Select a name from the VARS Mapping drop-down list.

• Click Add.

Result: The language and VARS mapping are added to the announcement entry.

7. Click Save.

Result: The announcement entry will be added to the announcement set selected in step
1.

Note: Adding an entry to a set that is used in compiled control plans will cause all control plans
that use that set to be recompiled and will display the compiler report. The compiler report
gives details of all the control plans that were affected by the change and provides a report on
status of each control plan.

Related topic

Announcements

Chapter 12
Adding Announcement Entries
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Editing Announcement Entries
Follow these steps to edit an existing announcement entry, or remove a language mapping.

1. On the Announcements tab, select the announcement set which contains the
announcement entry to edit.

2. From the table, select the announcement entry to edit.

3. Click Edit.

Tip: The Edit button is located at the bottom of the screen. The edit button at the top of the
screen is Edit Set.

Result: You see the Edit Announcements screen.

4. If required, change the description in the Description field. For more information about the
fields on this screen, see Announcement Entry Fields.

5. To change a language mapping, select the mapping to change.

Result: The mapping is displayed in the Mapping Editor area.

Update the fields and click Add.

6. To add a new mapping, enter new details in the Mapping Editor section.

Select a language and type of mapping for the announcement entry:

For standard announcements, select the Resource ID + Resource Name option. Go to
Step 6.

• For announcements that have variable announcement rules specified, select the VARS
Mapping option. Go to Step 7.

7. If Resource ID + Resource Name Mapping was selected in step 5:

• Configure the Resource Name and Resource ID.

• Click Add.

• Skip step 7.

Result: The language and resource mapping will be added to the announcement entry.

8. If VARS Mapping was selected at step 5:

• Select a name from the VARS Mapping drop-down list.

• Click Add.

Result: The language and VARS mapping will be added to the announcement entry.

9. To remove a mapping from the table, select it and click Remove.

10. Click Save.

Result: The announcement entry changes are saved to the database.

Note: Editing an announcement entry will cause all compiled control plans that use that
announcement set to be recompiled and will display the compiler report. The compiler report
gives details of all the control plans that were affected by the change and provides a report on
status of each control plan.

Related topic

Announcements

Chapter 12
Editing Announcement Entries
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Deleting Announcement Entries
Follow these steps to delete an announcement entry from a selected announcement set.

1. On the Announcements tab, select the announcement set which contains the
announcement entry to delete.

2. From the table, select the announcement entry to delete.

3. Click Delete.

Tip: The Delete button is located at the bottom of the screen. The delete button at the top
of the screen is Delete Set.

Result: The Confirm Delete prompt is displayed.

4. Click OK.

Result: The announcement entry is removed from announcement set in the database.

Tip: It is not possible to delete an announcement entry that is used in a control plan. To
delete this announcement entry, the control plans that use it must first be changed to use
another announcement entry. Once this entry is not used by any node in any control plan,
then it may be deleted.

Note: Deleting an announcement entry will cause all compiled control plans that use that
announcement set to be recompiled and will display the compiler report. The compiler report
gives details of all the control plans that were affected by the change and provides a report on
status of each control plan.

Chapter 12
Deleting Announcement Entries
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13
Variable Announcement Rule Sets

The VARS tab is used to define the rules for a Variable Announcement Rule Set (VARS).
VARS are used for announcements that vary depending on the grammatical rules of the
language. Variable announcement rule sets allow these grammatical rules to be observed
within the played announcement.

The VARS name (set name) is unique. It is used by the VARS Mapping tab to identify which
VARS to map. Each rule is comprised of at least one or more expressions. Multiple
expressions are concatenated with either a logical AND or logical OR.

Each expression conforms to the following syntax:

variablePart operator1 argument1 [operator2 argument2]

The syntax supports a maximum of five tokens. The last two tokens (operator2, argument2)
are optional. These are only required depending on the operator1 operation. 'variablePart'
represents one of the variable announcement parts.

A grouping policy can be optionally applied to each rule where the order of evaluation is
important.

How VARS is Used in an Announcement Entry
The following example illustrates how a VARS is used in an announcement entry.

An announcement contains two placeholder parts:

"On date your balance is variable"

The variable part of the announcement will play a different audio file depending upon the
number of free SMSs that the subscriber has remaining.

• 0 free SMSs (rule 1)

• 1 free SMs (rule 2)

• A pair of SMSs (rule 3)

• n free SMSs (rule 4)

The variable part is set up on the VARS tab as follows:

• Rule 1 is

IF [Part 2] = 0

• Rule 2 is

IF [Part 2] = 1

• Rule 3 is

IF [Part 2] = 2

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 1 of 3



• Rule 4 is IF [Part 2] > 2

Using the VARS Mapping tab, each rule is mapped to the resource name (that is, SRF) and
resource ID of each audio file.

Using the Announcements tab, the VARS mapping is specified for an announcement entry.

Variable Announcement Rule Set Fields
This table describes the function of each field.

Field Description

Add Rule You can construct up to four parts to a rule using
the operator fields.

Part Select the part of the expression that the line
applies to.

Comparison operators Select from:

= equal to

!= not equal to

> greater than

< less than

>= greater than or equal to

<= less than or equal to

% percentage

+ plus

- minus

* multiply

/ divide

Boolean operators Select from:

• AND
• OR

Grouping Policy Allows you to place brackets around the selected
parts of the expression where the order of
evaluation is important.

Existing Rules Displays each rule and its boolean expression.

Adding a VARS
Follow these steps to add a new VARS and add rules to the rule set.

1. From the VARS tab, click New.

Result: The New Variable Announcement Rule Set screen is displayed. See Variable
Announcement Rule Set Fields for a description of each field.

2. In the Set Name field, enter the VARS name.

3. In the Add Rule area, configure the new rule by constructing the boolean expression.

4. Click Add.

The new rule will be added to the VARS and will be displayed in the Existing Rules table.

5. Click Save to save the changes to the database.

Related topic

Chapter 13
Variable Announcement Rule Set Fields
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Variable Announcement Rule Sets

Editing a VARS
Follow these steps to edit an existing VARS.

1. On the VARS tab, select the VARS to edit.

2. Click Edit.

Result: The Edit Variable Announcement Rule Set screen is displayed. See Variable
Announcement Rule Set Fields for a description of each field.

3. Make the changes required.

To add a rule, follow the procedure described in Adding a VARS.

To remove a rule, select it in the Existing Rules table and click Remove.

To change a rule:

a. Select the rule in the table.

Result: The details will be displayed in the Add Rule area.

b. Change the rule details and click Update.

4. Click Save to save the changes to the database.

Related topic

Variable Announcement Rule Sets

Deleting a VARS
Follow these steps to delete an existing VARS.

1. On the VARS tab, select the VARS to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK to delete the VARS record.

Chapter 13
Editing a VARS
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14
VARS Mapping

The VARS Mapping tab on the ACS Configuration screen is used to map each rule in a VARS
to a unique resource name and resource ID combination. This combination is used to
determine the elementary message ID that is forwarded to the switch.

The mapping name is unique. It is used by the Announcement Entries to determine which
VARS to map to.

VARS Mapping Fields
This table describes the function of each field.

Field Description

Mapping Name The name of the mapping.

Rule Set The name of the rule set.

Note: This field cannot be changed after it has
been saved for the first time.

Rule List of VARS rules, with the rule description, as
listed on the VARS tab. For more information, see 
Variable Announcement Rule Sets.

Resource Name The name of the SRF which will play the
announcement.

Note: This must match the srfName parameter in
the acs.conf file. See ACS Technical Guide.

Resource ID The ID number of the audio file of the
announcement.

Mappings Displays the mappings for each rule against the
Resource name and ID.

Adding a VARS Mapping
Follow these steps to add a new VARS mapping.

1. On the VARS Mapping tab, click New.

Result: The New Variable Announcement Rule Set Mapping screen is displayed.

For a description of each field on this screen, see VARS Mapping Fields.

2. In the Mapping Name field, enter the name for this VARS mapping.

Tip: The VARS mapping name must be unique for the customer, although two different
customers may have the same VARS mapping name.

3. From the Rule Set drop down list, select the VARS which contains the rule to map to a
resource.

Tip: This drop down list only contains previously configured VARS. To add a new VARS,
see Variable Announcement Rule Sets.

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 1 of 2



4. In the Map Rule section, select the rule from the top left drop down box.

5. In the Resource Name field, enter the name of the SRF which will play the announcement.

Note: This must match the srfName parameter in the acs.conf file. See ACS Technical
Guide.

6. In the Resource ID field, enter the ID number of the audio file which contains the
announcement.

7. Click Map to process the VARS mapping rule.

Result: The mapped rule will appear in the Mappings table.

Tip: You must enter a VARS mapping for each rule in the rule set.

8. Click Save to save the new VARS mapping to the database.

Related topic

VARS Mapping

Editing VARS Mappings
Follow these steps to edit an existing VARS mapping.

1. On the VARS Mapping tab, select the VARS mapping to edit.

2. Click Edit.

Result: The Edit Variable Announcement Rule Set Mapping screen is displayed.

For a description of each field on this screen, see VARS Mapping Fields.

3. Amend the VARS mapping as required.

Tip: To display the details of an existing mapping in the Map Rule area, select it from the
Mappings table. Click Map to update the mapping's details.

4. Click Save to save the changes to the database.

Related topic

VARS Mapping

Deleting a VARS Mapping
Follow these steps to delete an existing VARS mapping.

1. On the VARS Mapping tab, select the VARS mapping to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK to remove the VARS mapping from the database.

Chapter 14
Editing VARS Mappings
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15
Feature Sets

Feature node sets must be set up to allow customers to use feature nodes in their control
plans.

You use the Feature Sets tab to configure and maintain the ACS feature sets. A feature set is
a convenient way of grouping feature nodes. Customers are generally allocated one or more
feature sets. The feature nodes from those feature sets can be used in any control plan the
customer creates.

When a feature set (or group of feature sets) has been configured for a customer, only the
feature nodes associated with the set (or sets) will be available in the control plan feature
palette. The customer will only be able to use these nodes when they are creating their control
plans.

Feature sets are created and maintained by the ACS system administrator. Therefore, this
screen is only available to the ACS system administrator.

Adding Feature Sets
Follow these steps to add a new feature node set.

1. On the Feature Sets tab, click New Set.

Result: The New Feature Node Set screen is displayed.

2. Enter the name of the new feature set in the New set name field.

3. Click Save.

Result: The new feature set is saved to the database.

Tip: The feature node set is created with all nodes cleared. Follow the procedure below to Edit
the feature node set.

Related topic

Feature Sets

Editing Feature Sets
Follow these steps to edit a feature set, and configure the feature nodes available to the
selected customer.

1. On the Feature Sets tab, select the feature set you require from the feature node list.

2. Click Edit Set.

Result: The Edit Feature Node Set screen is displayed.

3. The screen contains all the available feature nodes. For ease of use, all nodes have been
grouped according to use, under one of these tabs.. Navigate between the tabs and select
the check boxes beside each node to select the feature nodes you require for your
customer.

To make a feature node:
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• Available to the customer, ensure the relevant check box is selected.

• Not available to the customer, ensure the relevant check box is not selected.

4. Click Save to save the feature set changes to the database.

Note: When the feature set is saved, ACS will recompile any control plans that use that feature
set. If feature nodes that are used in compiled control plans are removed from a feature node
set, customers who use this set may no longer be able to successfully compile their control
plans.

Related topic

Feature Sets

Deleting Feature Sets
Follow these steps to delete an existing feature set.

1. On the Feature Sets tab, select the feature set from the feature node set drop down list.

2. Click Delete Set.

Result: The Confirm Delete prompt is displayed.

3. Click OK to remove the feature set from the database.

Warning: You cannot delete a feature set that is being used in a current customer control plan.

Chapter 15
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16
Profile Tag Details

In a service application like CCS, you may want to set up subscriber profile groups. One of the
fields of a subscriber profile group is the profile field. The contents of the profile field are
obtained from an ACS customer profile group.

To use subscriber profiles, you must first set up customer profiles in ACS. You do this from the
Profile Tag Details tab of the ACS configuration screen.

Profiles can also be established for:

• Prefix trees

• Ordered prefix trees

• Arrays

For detailed information, see the Profile Blocks and Fields topic in Feature Nodes Reference
Guide.

Profile Tag Types
The tag names for profile fields are defined on the Profile Tag Details tab in the ACS
Configuration screen.

The following hard coded profile data types are supported:

Data Type Description

Announcement Data (Ann Id, Lang) -> SDF Name and SDF Ann ID. Used by the Global
Profile - Internal use

Array An array is a series of elements of the same type placed in contiguous
memory locations that can be individually referenced by adding an index
to a unique identifier.

Example: Tag 123456 array:

Boolean true, false (1 or 0)

Byte A single byte integer (0 to 255).

Date A date, in Unix time, that is, seconds since January 1 1970 GMT.

Discount Specification 4 bytes for 1st discount, 4 bytes for 2nd discount, 8 bytes for maximum
charge in the subunit of the currency, for example, in cents.

Hunting Config An array of structure, each structure containing the details for each
number in a hunting list.

1. Addr - numeric string. This is the telephone number to ring.

2. VPN Network ID - unsigned 32-bit integer. 0 meaning off-net.

3. Timeout - unsigned 32-bit integer. This is how long to let it ring for
before going on the the next number.

Integer 64-it signed or 32-bit signed integer. 32 bits will be used for values which
can be represented by 32 bits.
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Data Type Description

Limited Numeric String A limited numeric string. Valid characters are 0-9.

Note: The limit and the value are each stored in a separate profile block,
but with the same tag code:

• The limit is stored in either the product type profile, or customer
profile.

• The value is stored in the profile block configured in the Check
Limitations feature node.

For example, if tag 78787878 is a limited numeric string, the maximum
length can be stored as an integer under tag 78787878 in the product
type profile and the actual value can be stored as a string under tag
78787878 in the subscriber profile.

Long Triple Consisting of 3 signed 4 byte integers (12 bytes).

Used for switch node exits in the control plan Profile.

Limited Ordered Prefix Tree A limited ordered prefix tree is made up of a limited list of numbers.

Note: The limit and the value are each stored in a separate profile block,
but with the same tag code. These are stored in the profile blocks
configured in the Check Prefix Tree Capacity feature node.

Miscellaneous Can contain anything

Numeric String A string, but can contain only numbers. Valid characters are 0-9.

Number List Sub-profile block containing prefix string maps. Used in the Number
Lookup and Translation node.

Ordered Prefix String An ordered prefix tree comprising an ordered list of numbers

Patterns Stores patterns, in the format used by the Number Matching node

Prefix Tree Mapping of digit prefixes to integer.

Example:
"111" maps to 10

"222" maps to 20

Prefix String Map Mapping of digit prefixes to digit string.

Example:
"111" maps to "234"

"222" maps to "456"

Price The price, without the currency symbol or decimal point.

Example: "1143" for $11.43

Profile Block A mapping of integer tags

Raw Data Arbitrary bytes of any length

Short Signed 16-bit integer

String A non limited ASCII string

Time The 24 hour time, without the colon between hours and minutes.

Example: "2357" for 23:57

Unsigned 32-bit Integer 32-bit unsigned integer

Unsigned 64-bit Integer 64-bit unsigned integer

VARS Used in the Global Profile. Stores variable announcement rule set in the
same format as that created on VARS tab of ACS Configuration screen.

VARS Mapping Used in the Global Profile. Stores variable announcement rule set
mapping in the same format as that created on VARS Mapping tab of
ACS Configuration screen.

VXML Announcement Voice XML announcement location. A string containing a URL. Used in
the DAP Play VXML Announcement node.

Chapter 16
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Data Type Description

Zone A set of shape definitions for the area covered by the zone. Shapes may
be circular or rectangular and are defined by their coordinates.

Note: You can set up and populate zone tags but they may only be used
if the Location Capabilities Pack (LCP) is installed.

Filtering Profile Tags
You can filter Profile tags to reduce the time it takes to locate tags in the list, allowing you to
define and create services more efficiently. You can filter Profile tags by the name, type, or tag
(ID) value or you can specify Name, Type & Tag to search all three columns. The procedure is
the same for each option.

Follow these steps to filter Profile tags on the Profile Tag Details screen:

1. In the Filter by text-input field, enter the value that you want to match in the list. You can
enter a value that matches either the entire target value, or a portion of it. For example,
you might have several items in the list that have abc as part of the name and you want to
select all of them.

2. Select the column you want to search from the Name, Type & Tag drop down list. If you
select the Name, Type & Tag item, ACS attempts to match the value against all three
columns.

3. Select the Prefix only checkbox if you want to match your search value against only the
beginning of the target value. For example, if you entered abc as your search value and
you want to match only values in the Name column that begin with "abc", select the Prefix
only checkbox. If, however, you want to match both abcdef and fedabc in the Name
column, do not select Prefix only.

Selection occurs as soon as you enter a value in the Filter by text-input field, based on the
current criteria in the Name, Type & Tag drop down list and the Prefix only checkbox. If
you change the search criteria, selection occurs again based on the new values that you
specify.

Adding Profile Tags
Follow these steps to add new profile tags to the list .

1. On the Profile Node Details tab, click New.

Result: The New Profile Tag screen displays.

2. In the Profile Tag Name field, enter a name to identify the tag.

3. In the Profile Tag Type drop-down list, select the required property.

4. In the Profile Tag and Parent Profile Tag fields, enter the decimal value of the tags.

Note: These values should be within the value range allocated.

5. In the Parameter Type drop down list, select one of the following parameter types:

• Undefined – Use this setting if you are creating the profile tag for any profile block
other than Call Context. This is the default.

• Input – Used by the Call Context profile block only. When incoming profile data is
mapped to the Call Context profile block, the data value is inserted in the InitialDP for
the call.
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• Output – Used by the Call Context profile block only. When outgoing profile data is
mapped to the Call Context profile block, nothing happens.

Note: The Call Context profile block is supported for backwards compatibility only. If you
map this profile tag to a Call Context profile bock, you will see a "–" in the Profile Block
Type field of the Profile Tag Mapping tab.

6. Click Save.

Result: The new profile tag appears in the list and is stored in the database.

Related topic

Profile Tag Details

Editing Profile Tags
To edit an existing profile tag, follow these steps.

1. On the Profile Tag Details tab, select the profile you require from the profile list.

2. Click Edit.

Result: The Edit Profile Tag screen displays.

3. Make the changes required.

Warning: If you change the profile tag type for a profile tag that is accessed by a feature
node in your control plans, then you must perform the following steps to ensure the new
data type is used by the feature node. For each affected control plan and feature node:

a. Re-open and then save the feature node configuration in the control plan.

b. Save and recompile the control plan.

4. Click Save.

Result: The updated profile tag row appears in the list and its details are stored in the
database.

Related topic

Profile Tag Details

Deleting Profile Tags
Follow these steps to remove a profile tag.

1. On the Profile Tag Details tab, select the profile from the profile list.

2. Click Delete.

Result: The Confirm Delete screen displays.

3. Click Ok.

Result: The profile tag is removed from both the list and the database.

Chapter 16
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17
Profile Tag Mapping

The Profile Tag Mapping tab enables you to map a profile tag to a profile block.

For more information about profiles, see CPE User's Guide.

Adding Profile Tag Mappings
Follow these steps to add a new profile tag mapping.

1. On the Profile Tag Mapping tab, click New.

Result: The New Tag/Profile Mapping screen displays.

2. From the Profile Block drop-down list, select the profile block.

3. From the Profile Tag drop-down list box, select the required tag.

4. Click Save.

Result: The new profile tag mapping appears in the list and is stored in the database.

Related topic

Profile Tag Mapping

Deleting Profile Tag Mapping
Follow these steps to remove a profile tag mapping.

1. On the Profile Tag Mapping tab, select the mapping from the list.

2. Click Delete.

Result: The Confirm Delete screen displays.

3. Click Ok.

Result: The profile tag mapping is removed from both the list and the database.

Editing Profile Tag Mapping
Follow these steps to edit an existing profile tag mapping.

1. On the Profile Tag Mapping tab, select the profile you require from the profile list.

2. Click Edit.

Result: The Edit Tag/Profile Mapping screen displays.

3. Make the changes required.

4. Click Save.

Result: The updated profile tag row appears in the list and its details are stored in the
database.

Related topic
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Profile Tag Mapping

Chapter 17
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18
Table Lookup Mapping

The Table Lookup Mapping tab enables you to search a customer’s table lookup datasets for
prefix number and code mappings.

Each available table lookup dataset contains the prefixes and code mappings for a group of
related codes, for example, for a specific geographic area or suburb.

Public and Private Table Lookup Datasets
A table lookup dataset can be public or private. A privately owned table lookup dataset belongs
to a specific customer. It is only available to that customer and the parent customers linked to
that customer in the customer hierarchy. A publicly owned table lookup dataset is available to
all customers.

Searching a Dataset for a Prefix or a Mapping Code
To search a customer’s table lookup dataset for a prefix number or a mapping code:

1. In the ACS Configuration window, select the customer from the Customer list.

2. On the Table Lookup Mappings tab, select the required table lookup dataset from the
Dataset list.

3. (Optional) To search for prefixes that are mapped to a specific code, enter the code or the
initial digits of the code in the Lookup Result field.

4. (Optional) To search for the codes mapped to a specific prefix number, enter the prefix or
the initial digits of the prefix in the Lookup Input field.

5. Click Search.

The table on the Table Lookup Mapping tab lists the prefixes and codes that match the
criteria you entered. The prefixes are listed in the Lookup Input field and their
corresponding codes are listed in the Lookup Result field.

Tip: To view all the prefixes and code mappings in a dataset leave both search fields
blank.
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19
Triggers

Oracle Communications Billing and Revenue Management (BRM) is able to trigger end user
notifications at any point during a call or session based on actual and forecast usage, to
ensure the notifications are delivered at the earliest possible moment. The following real-time
notification scenarios are currently possible with BRM:

• Threshold notifications (for example, low balance threshold breach)

• Subscription expiry warning notifications

• Recurring usage notifications (for example, notifications for every specified number of MB
of usage)

• Tariff change notifications (for example, peak -to off-peak rate change, or free minutes
exhaustion)

Note: Tariff change notifications are not currently supported in Convergent Charging Controller.

Convergent Charging Controller receives the BRM in-session notifications (embedded in
authorization and reauthorization responses) through the BRM Charging Driver (BCD). The
BCD actions extract any BRM notifications and stores them in specified ACS profile fields.

Each authorization or reauthorization response from BRM may contain zero or more in-session
notifications. The notifications can trigger control plans at the point they are received. It is
possible to deliver a notification or announcement for each in-session notification provided in
each response.

You use the Triggers tab to configure control plan trigger definitions for each of your
customers. A trigger specifies the control plan to use and the profile tags to pass to the
triggered control plan in its incoming session data.

Trigger Fields
This table describes the function of each field.

Field Description

Name The name of the trigger.

Public A control plan trigger definition can be made
public, which will make it available to any service
provider, or private, which will make it available
only to the owning service provider.

Control Plans The control plan invoked by this trigger definition.
The control plan is run when the trigger is invoked
by Convergent Charging Controller, for example; to
handle BRM in-session notifications.

The control plan drop down list displays all the
control plans a subscriber can use.

Tip: This list can be shortened by using the
Search By field and then Search.
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Field Description

Search By Use initial characters of the control plan name or
combine with % (match on any number of
characters), or _ (match on a single character).

Examples:
Search for e%SMS will find all control plan names
beginning with e and containing SMS.

Search for e_han%SMS will find all control plan
names beginning with e, containing the string han
in positions 3 to 5, and containing SMS.

The list can be further restricted by entering a
maximum number of names to show in the Max
Rows field.

Profile Tags This table displays a list of source profile tags to be
copied into the Incoming Session Data of the
triggered control plan.

Adding Control Plan Triggers
Follow these steps to add a new control plan trigger.

1. On the Triggers tab, click New.

Result: The New Trigger screen displays.

2. Configure this record by entering data in the fields on this screen.

For information about the fields on this screen, see Trigger Fields.

3. Add Trigger Tags or Edit Trigger Tags, or Edit Trigger Profiles for the trigger tags listed in
the table.

4. Click Save.

Result: The new trigger appears in the list and is stored in the database.

Related topic

Triggers

Editing Control Plan Triggers
Follow these steps to edit an existing control plan trigger.

1. On the Triggers tab, select the trigger you require from the table.

2. Click Edit.

Result: The Edit Trigger screen displays.

3. Make the changes required. For information about the fields on this screen, see Trigger
Fields.

4. Add Trigger Tags or Edit Trigger Tags, or Edit Trigger Profiles for the trigger profiles listed
in the table.

5. Click Save.

Result: The updated trigger appears in the list and its details are stored in the database.

Chapter 19
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Related topic

Triggers

Deleting Control Plan Triggers
Follow these steps to delete a control plan trigger.

1. On the Triggers tab, select the trigger to delete from the table.

2. Click Delete.

Result: The confirm delete dialog displays.

3. Click OK to confirm.

Related topic

Triggers

Adding Trigger Tags
Follow these steps to add a source profile tag to the list of tags for this trigger.

1. On the New Trigger or Edit Trigger window, click New.

Result: The New trigger tag window is displayed. Note that the Edit trigger tag window
displays the same fields.

2. Select from the Data Type, Location and Field drop down lists the profile field containing
the source tag.

The in-session notification tags are prefixed with ISN.

3. To select the override target field, select the Override Target Field check box, then select
the field from the drop down.

4. Click Save.

Related topic

Triggers

Editing Trigger Tags
Follow these steps to edit the source profile tag details.

1. On the New Trigger or Edit Trigger window, select the trigger tag to edit in the table.

2. Click Edit.

Result: The Edit trigger tag window is displayed.

3. Update the fields, described in Adding Trigger Tags, as required.

4. Click Save.

Related topic

Triggers

Chapter 19
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Editing Trigger Profiles
Follow these steps to delete trigger profile tags from a trigger.

1. On the New Trigger or Edit Trigger window, select the trigger profile tag to delete in the
table.

2. Click Delete.

Result: The delete confirmation dialog is displayed.

3. Click Apply to confirm.

Related topic

Triggers

Chapter 19
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20
Notifications

You can create templates for notification messages.

Templates are used by some ACS feature nodes. They can also be used by other applications
(for example, CCS).

Examples of activities that other applications can use notification templates for are:

• Control plans

• Business process logic (BPL tasks)

• Credit transfers

• Periodic charges

• Profile updates

• Real-time notifications

• Heavy user bonuses.

Templates incorporate provision for selecting the way the notification message is transported,
whether it is through Messaging Manager or a notification interface.

Notification Types
In ACS, SMS notification templates are classified and stored by application and type. A
combination of application and type is called a notification type. A notification type may contain
more than one notification template but each template must use a different language.

Finding Notification Type
This function is used to lessen the number of rows in the table.

Follow these steps to find an existing notification template.

1. 1 On the Notifications tab, select the Filter by Notification Name check box.

Result: The Search button and search criteria field become available.

2. 2 Enter the search criteria in the text field.

Note: The search is not case sensitive, the characters must appear sequential, but start
anywhere in the Notification name.

For example, ON will return any Notification that has ON or on somewhere in the name.

3. 3 Click Search.

Result: All matches will be listed in the tab table.
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Template Matching
Template matching is based on customer ID, template ID and language ID (either the
subscriber's language, or the language specified in the node dialog) in the following order:

Customer Template Language

Control Plan Node Node or subscriber profile

Control Plan Node Global default

NULL (Global) Node Node or subscriber profile

NULL (Global) Node Global default

Note:

• When the notification feature node is processed it shall attempt to retrieve the template
based upon the language ID, template ID and customer ID.

• If no template is found for the specified language, the node will attempt to find a template
based on the customer, default language and template ID

• If no template is found for the customer and language, the node will attempt to find a global
template based on language and template ID

Languages
Templates can be prepared in multiple languages. If possible, a notification is sent in the
language of the receiving party. If the language of the receiving party is not on the notification
template, a message in the default language is sent.

The default language is defined for the customer or service provider.

You set up other languages using the ACS Tools screen. See Language.

Adding a Notification Type
Follow these steps to a create a notification type.

1. In the upper part of the Notifications tab, click New.

Result: The New Notification Type screen is displayed.

2. In the Customer field, select the customer specific or global option for notification delivery.

Note: This field is only available when the user has permission to edit global notifications.

3. In the Application Name field, type a name that identifies the application to you.

Notes:

• You must not leave the Application Name field blank.

• You may enter up to 16 alphabetical or numerical characters.

• The name may have to match the application that sends the notification. For example,
CCS notifications from the VWS all have application name CCS.

4. In the Notification Type field, enter a name that identifies the type of notification to you.

Notes:

Chapter 20
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• You must not leave the Notification Type field blank.

• You may type up to 32 alphabetical or numerical characters.

Result: The Save button becomes active.

5. In the Delivery Mechanism section, select the:

• Transport from the drop down list - this is the method by which the notification is sent.

• Message Class from the drop down list - this determines whether a SMS is stored in
the phone's SIM (that is, normal behavior), or presented to the subscriber as a flash
message and not stored.

• Subscriber Opt-Out from the drop down list - this determines what notification types
the subscriber can opt out from receiving.

Notes:

• The message class list changes depending on the transport selected, and is used for
SMS notifications only.

• Opt-Out option --Not Used-- means that subscribers cannot opt out of this notification.

6. In the Sender Address frame, perform one of the following actions:

• Select the profile location containing the sender address from the Data Type,
Location and Field drop down lists

• Enter a specific address - select Fixed Value from the Data Type drop down list and
then type the address in the Fixed Value field.

7. In the Delivery Time frame, optionally set a delivery time restriction:

• Select the Not Before check box to force delivery of the message to be after the time
selected in the two drop down lists of hours and minutes.

• Select the Not After check box to force delivery of the message to before the time
selected in the two drop down lists of hours and minutes.

Notes:

• The delivery time options apply to VWS notifications only.

• If the Not Before time is after the Not After time, then notifications are delivered
between the not before time on one day and the not after time on the next day.

8. Click Save.

Result: The new notification type is added to the Notifications tab table.

Tip: If the search feature has been used and the new entry is not a match against the
search criteria, it will not appear in the table. Either change the search criteria or deselect
the Find by check box.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Related topic

Notifications
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Editing a Notification Type
To edit a notification type, follow these steps.

1. On the Notifications tab, find the notification type to edit. See Finding Notification Type.

2. Select the notification type to change in the table row.

3. Click Edit.

Result: The Edit Notification Type screen is displayed.

4. Change the relevant drop down list options as required.

5. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Related topic

Notifications

Deleting a notification
To delete a notification type, follow these steps.

1. On the Notifications tab, find the notification type to delete. See Finding Notification Type.

2. Select the notification type to delete in the table row.

3. Click Delete.

Result: The Delete Notification? screen displays.

4. Click Delete.

Result: The notification type is removed from the Notifications table.

Rules for Recharge Notifications
When a user recharges the account, the system searches the database for the notification to
trigger. The search is based on a search string formed by a combination of voucher name,
EDR scenario, balance type, and service provider. The search string is formed in the following
order and looked for in the database:

1. If the voucher name exist in the database, follow this order:

a. Voucher Name + EDR Scenario + Service Provider

b. Voucher Name + EDR scenario + NULL

c. Skip to search string 3.

2. If voucher name does not exist in the database, follow this order:
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a. "AccountRecharge" + BalanceTypeString + Service Provider

b. "AccountRecharge" + BalanceTypeString + NULL

3. "AccountRecharge" + Service Provider

4. "AccountRecharge" + NULL

Chapter 20
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21
Notification Template Editor

Notification templates are used to create messages containing variable information embedded
within them.

For example, a message might be:

Your current balance is 20 dollars.

Where the 20 dollars would be a variable part that changes every time the template is used.

Adding a Notification Template
To create a notification template, follow these steps.

1. On the Notifications tab, find the notification type to add templates to. See Finding
Notification Type.

2. Select the notification type to add templates to from the table row.

3. In the lower part of the screen, click New.

Result: The New Notification Template screen is displayed.

Note: Variable parts are only available if Open Notifications has been activated

4. If necessary, select a language from the Language drop-down list box.

Note: You must select a language which has not already been assigned to a notification
template listed under the notification type you chose in step 1.

5. In the work area, enter the text of the message that the template will contain.

Notes:

• You may enter up to 512 alphabetical or numerical characters.

• If the Arabic language was selected at step 3, you may enter Arabic characters.
However whichever language is selected you can enter any Unicode characters.

• You must not leave the work area blank.

Result: The Save button becomes active.

6. If a template containing variable parts is required, use the icon list on the left side to insert
the required parts. Click and drag an icon to the place in the text that it is required and
release the mouse.

Result: The Notification Variable screen opens, with the variable part option selected in
Source Group field matching the icon name.

Each variable part can have one of several configuration options, depending on the field/
profile tag selected as the source of the variable part. See Value Formatting Types for
more information.

This is the list of variable parts avalible in the Source Group field.

• Balance - enables you to insert balance information into the template.
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• Charge - enables you to insert charging information into the template.

• Periodic - enables you to insert periodic charge information into the template.

• Profile - enables you to insert subscriber information into the template.

• Recharge - enables you to insert recharge information into the template.

• Reward - enables you to insert rewards information into the template.

• SPM - enables you to insert subscriber management information into the template.

• Session - enables you to insert session information into the template.

• Wallet - enables you to insert subscriber wallet information into the template.

See Variable part fields for information about which variable part type is available for each
source group.

7. Click Preview to review what the notification will be like.

Result: The Template Preview dialog displays the notification.

8. Click OK.

Result: The notification template is stored in the database, classified for the notification
type you chose at Step 1.

Note: When saved, each field entry used for a variable part has an associated ON profile tag
defined which is used to store the value of the field when an open notification reaches the SLC.

Related topic

Notification Template Editor

Editing a Notification Template
Follow these steps to edit a notification template.

1. On the Notifications tab, find the notification type associated with the template requiring
changes. See Finding Notification Type.

2. Select the notification type to edit from the table row.

Result: All the templates for the notification are listed.

3. Select the template to change by clicking in the template table row.

4. In the lower part of the screen, perform one of the following actions:

• Click Delete to remove the template

• Click Edit to change the template

Result: If editing, the Edit Notification Template screen is displayed.

Notes:

Each variable part can have one of several configuration options, depending on the field or
profile tag selected as the source of the variable part. See Value Formatting Types for
more information.

This is the list of variable parts.

• Balance – Enables balance information to be inserted into the template.

• Charge – Enables charging information to be inserted into the template.

• Periodic – Enables periodic charge information to be inserted into the template.

Chapter 21
Editing a Notification Template
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• Profile – Enables subscriber information to be inserted into the template.

• Recharge – Enables recharge information to be inserted into the template.

• Reward – Enables rewards information to be inserted into the template.

• SPM – Enables subscriber management information to be inserted into the template.

• Session – Enables session information to be inserted into the template.

• Wallet – Enables subscriber wallet information to be inserted into the template.

5. If required, select a different language from the Language drop-down list.

Note: You must not select a language already assigned to a notification template listed
under the notification type you chose at step 1. If you do, an error message appears when
you try to save the notification template at step 6.

6. Edit the Text field as needed.

The template variable part icons can be:

• Moved to another position – Click on the icon and drag the red line to the new insertion
point.

• Deleted – Click on the icon to open the Notification Variable dialog and then click
Delete.

• Added – Click on the required icon and drag it to the desired location in the text.

• Edited – Click on the icon to open the Notification Variable dialog. The relevant
Notification Variable screen for the variable part opens.

7. Click Preview to review what the notification will be like.

Result: The Template Preview dialog displays the notification.

8. Click OK.

Note: When saved, each field entry used for a variable part has an associated ON profile tag
defined which is used to store the value of the field when an open notification reaches the SLC.

Related topic

Notification Template Editor

Deleting a Notification Template
Follow these steps to delete a notification template.

1. On the Notifications tab, find the notification type associated with the template requiring
deletion. See Finding Notification Type.

2. Select the notification type to edit from the table row.

Result: All the templates for the notification are listed.

3. Select the template to delete, by clicking in the template table row.

4. In the lower part of the screen, click Delete.

Result: The Confirm Delete screen is displayed.

5. Click Ok.

Result: The notification template is removed from the database.

Chapter 21
Deleting a Notification Template
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22
Value Formatting Types

Any notification template can have any number of variable parts, configured using the
Notification Variable screen. Each variable part can have one of several configuration options,
depending on the field/ profile tag selected as the source of the variable part. See Notification
Template Editor for more information about notification templates.

Notes:

• Each of the variable parts may have extra fields to choose from in the top panel. For
example, when you choose a Balance source group, you get a combo-box to choose
which balance type you want. When you select Profile, you get the standard combo-
boxes to choose a profile tag.

• Some of the variable parts let you choose Server to determine in the formatting panel.
This means use the formatting specified for that type of data in another part of the system,
see Defined Definitions for examples.

The available format types for variable parts are:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Defined Definitions
These are examples of definitions defined elsewhere in the system. This is not an exhaustive
list, just a sample.

Definitions on the Wallet Management > Balance Type Translations tab for balance
formatting:

• Balance / Value

• Charge / Value

• Recharge / Value

Definitions on the Wallet Management > Balance Type Translations tab for balance expiry
formatting for:

• Balance / Expiry

• Recharge / Expiry

Definition on the Wallet Management > Wallet Name Translation tab for:

• Wallet / Expiry
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Boolean Format Type
Follow these steps to designate location and formating for a boolean variable part.

1. In the Variable Source frame, select the variable part source from the Field drop down
list.

Warning: The Source Group drop down list shows the variable part type associated with
the icon selected in the Notification Template screen and should be not be changed.

2. Select the Balance Type from the drop down list.

Note: The field balance type matches the Field selected.

3. Enter a Default Value that is used when there is no content or problem with the source
location.

4. Configure the Value Formatting (..) frame, appropriate to the variable source. See:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Related topic

Value Formatting Types

Date/Time Format Type
Follow these steps to designate location and formating for a date/time variable part.

1. In the Variable Source frame, select the variable part source from the Field drop down
list.

Warning: The Source Group drop down list shows the variable part type associated with
the icon selected in the Notification Template screen and should be not be changed.

2. Enter a Default Value that is used when there is no content or problem with the source
location.

3. Configure the Value Formatting (..) frame, appropriate to the variable source. See:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Related topic

Value Formatting Types

Chapter 22
Boolean Format Type
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Integer Format Type
Follow these steps to designate location and formatting for an integer variable part.

1. In the Variable Source frame, select the variable part source from the Field drop down list

Warning: The Source Group drop down list shows the variable part type associated with
the icon selected in the Notification Template screen and should be not be changed.

2. Select the source Balance Type from the drop down list.

Note: The field balance type matches the Field selected.

3. Enter a Default Value that is used when there is no content or problem with the source
location.

4. Configure the Value Formatting (..) frame, appropriate to the variable source. See:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Related topic

Value Formatting Types

Prefix Tree Format Type
Follow these steps to designate profile location and formating for a variable part.

1. In the Variable Source frame, leave the Source Group and Field with their default profile
and empty values.

Warning: The Source Group drop down list shows the variable part type associated with
the icon selected in the Notification Template screen and should be not be changed.

2. Select the source location using the Data Type, Location and Field drop down lists.

3. Enter a Default Value that is used when there is no content or problem with the source
location.

4. Configure the Value Formatting (..) frame, appropriate to the variable source. See:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

Chapter 22
Integer Format Type
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• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Related topic

Value Formatting Types

String format type
Follow these steps to designate string location and formating for a variable part.

1. In the Variable Source frame, select the variable part source from the Field drop down
list.

Warning: The Source Group drop down list shows the variable part type associated with
the icon selected in the Notification Template screen and should be not be changed.

2. Enter a Default Value that is used when there is no content or problem with the source
location.

3. Configure the Value Formatting (..) frame, appropriate to the variable source. See:

• Setting Boolean Configuration

• Setting DateTime Configuration

• Setting Integer Configuration

• Setting Prefix Tree Configuration

• Setting String Configuration

Related topic

Value Formatting Types

Setting Boolean Configuration
Follow these steps to set boolean formating.

1. In the Value Formatting (Boolean) section of the Notification Variable screen, select the
options for setting the boolean values.

2. To use a predefined format, select Use predefined format, then select the format from the
drop down list.

3. To specify a format, select Use these terms, then enter what text will be displayed for true
and false values.

4. To save the changes, click Save.

To exit without saving anything, click Cancel.

To remove the variable part from the notification, click Delete.

Related topic

Value Formatting Types

Setting DateTime Configuration
Follow these steps to format a date/time variable part.

Chapter 22
String format type
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1. In the Value Formatting (Date/Time) section of the Notification Variable screen, select the
options for setting the date and time values.

2. To use a definite date and time, select Absolute date, then select the predefined date and
time format from the drop down list.

For date and time format descriptions see Date formats and Time formats.

3. To insert the amount of time between now and the date/time being formatted, select
Elapsed time, then select the check boxes as required.

Examples:

• Select Months,and Days for "x months, y days"

• Select Weeks, Days, Hours for "x weeks, y days, z hours"

Note: Change the joiner value to make grammatically correct messages, for example
replace , with and for the Days row would change the example to "x weeks, y days and z
hours"

4. To save the changes, click Save.

To exit without saving anything, click Cancel.

To remove the variable part from the notification, click Delete.

Related topic

Value Formatting Types

Date Formats
This table list the date formats and their examples.

Format Format Example

d/MM/yyyy 10/07/2009

MM/d/yyyy 07/10/2009

dddd, d MMMM yyyy Friday, 10 July 2009

d MMMM yyyy 10 July 2009

d/MM/yy 10/07/09

MM/d/yy 07/10/09

yyyy-MM-dd 2009-07-10

d-MMM-yy 10-Jul-09

d.MM.yyyy 10.07.2009

d MMM. yy 10 Jul. 09

d MMMM yyyy 10 July 2009

MMMM yy July 09

MMM-yy Jul-09

Date Format Key
This table describes the symbols used in the date formats.

Symbol Description

d Day of month

Chapter 22
Setting DateTime Configuration
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Symbol Description

dd Two-digit day of month

dddd Name of day of week

MM Two-digit month

MMM Abbreviated month name

MMMM Full month name

yy Two-digit year

yyyy Four-digit year

Time Formats
This table lists the time formats and their examples.

Format Format Example

h:mm am/pm 4:03 pm

h:mm:ss am/pm 4:03:54 pm

hh:mm am/pm 04:03 pm

hh:mm:ss am/pm 04:03:54 pm

HH:mm 16:03

HH:mm:ss 16:03:54

Time Format Key
This table describes the symbols used in the time formats.

Symbol Description

h Hour, 0-12

hh Two-digit hour, 0-12

HH Hour, 0-23

mm Two-digit minute

ss Two-digit second

am/pm am/pm indicator

Setting Integer Configuration
Follow these steps to format an integer variable part.

1. In the Value Formatting (Integer) section of the Notification Variable screen, select the
option for setting the integer value.

2. To use a predefined format, select Use predefined format and then select the format from
the drop down list.

3. To specify a format, select Use this format and then enter the values as relevant.

• Divide by – The number to divide by to convert the output value from small units to
large units. This specifies how to interpret the number being presented.

Chapter 22
Setting Integer Configuration
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• Digits (whole part) – The number of digits before an assumed decimal point, this is
the minimum space allocated width of the whole part of the number. May cause
padding to the left.

• Digits (fractional part) – The number of digits after the decimal point.

• Decimal place separator – The character that signifies the decimal point, this will be
skipped if there is no fractional part.

• Prefix characters – Characters to add to the front of the number.

• Suffix characters – Characters to add after the number, this will be skipped if there is
no fractional part.

For example:

Received number to be formatted: 12345

• Divide by: 100

• Digits (whole part): 4

• Digits (fractional part): 2

• Decimal place separator: ,

• Prefix characters: $

• Suffix characters: c

Output: $ 123,45c

4. To save the changes, click Save.

To exit without saving anything, click Cancel.

To remove the variable part from the notification, click Delete.

Related topic

Value Formatting Types

Setting Prefix Tree Configuration
Follow these steps to format a prefix tree variable part.

1. In the Value Formatting (Prefix Tree) section of the Notification Variable screen, select
the option for setting the prefix tree values.

2. Enter the prefix tree field Separator to use in the notification. The prefix tree will be
presented as a list of items separated by the text in this box.

3. To save the changes, click Save.

To exit without saving anything, click Cancel.

To remove the variable part from the notification, click Delete.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Chapter 22
Setting Prefix Tree Configuration

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 7 of 8



Related topic

Value Formatting Types

Setting String Configuration
Follow these steps to format a string variable part.

1. In the Value Formatting (String) section of the Notification Variable screen, select the
options for setting the string values.

2. Select the Format and trim as follows option as required:

• as-is – Whatever the profile or default content is already saved as.

• UPPER CASE – Source is changed to all upper case characters.

• lower case – Source is changed to all lower case characters.

• Title Case – Source is changed to upper case characters for start of each word.

3. Optionally, select the Trim to max length check box, then entry the maximum length
allowed.

Note: The source string will be truncated to this value by removing characters from the end
of the string.

4. To save the changes, click Save.

To exit without saving anything, click Cancel.

To remove the variable part from the notification, click Delete.

Related topic

Value Formatting Types

Chapter 22
Setting String Configuration
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23
Termination Ranges

Termination number ranges are set up on the Termination Ranges tab of the ACS Resources
screen.

A termination range is a mask used to validate the input of a termination number.

The ACS system administrator must assign termination number ranges for each customer. A
customer may use their own termination numbers in their control plans, but they cannot edit
the termination ranges that are assigned to them. Only the ACS system administrator can edit
termination number ranges.

Tip: It is not necessary to set termination ranges in this screen if the customer is a managed
customer (that is, the Adding customers check box on the Customer screen was selected).

Termination ranges can only be added, edited or deleted by the ACS system administrator.
When editing a termination number range that is currently being used by a compiled control
plan, the control plan will be recompiled and the compiler report will be displayed. There may
be several control plans to be compiled, so this process may take some time.

Note: It is not possible to delete a termination range that is currently in use by a customer
control plan. Editing a termination range will cause all compiled control plans that use that
range to be recompiled.

Adding Termination Ranges
Follow these steps to add a new termination range.

1. On the Termination Ranges tab, click New.

Result: The New Termination Range screen is displayed.

2. In the Range Model Prefix field, enter the prefix for the termination number, for example
an area code, such as 04, restricting the number to that national area code.

3. From the Minimum Digits and Maximum Digits boxes, select the minimum and
maximum length of the termination number.

4. Click Save.

Result: The details are saved and the screen returns to the main window.

If the new termination number is used in a compiled control plan, the compiler report will be
displayed. The compiler report gives details of all the control plans that this change caused
to be recompiled and their status.

Related topic

Termination Ranges

Editing Termination Ranges
Follow these steps to edit an existing termination range.

1. On the Termination Ranges tab, select a termination range to edit.
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2. Click Edit.

Result: The Edit Termination Range screen is displayed.

3. Make the required changes to the fields.

4. Click Save.

Result: The details are saved and the screen will return to the main window.

If the new record is used in a compiled control plan, the compiler report will be displayed.
The compiler report gives details of all the control plans that this change caused to be
recompiled and their status.

Related topic

Termination Ranges

Deleting Termination Ranges
Follow these steps to delete an existing termination range.

1. From the Termination Ranges tab, select the termination range you want to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The termination range is removed from the database.

Chapter 23
Deleting Termination Ranges
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24
Number Translations

Use the Number Translations tab on the ACS Resources screen to map numbers to a
termination range. Several numbers may map to the same termination range if required.
Number translations are used in the Number Lookup node.

This node will look up a number that has been entered by the caller and translate it to a
termination number.

The number translation mappings may be viewed by all users, but may only be added, edited,
or deleted by users with permission level 4 and above.

Adding Number Translations
Follow these steps to configure number translations.

1. On the Number Translation tab, click New.

Result: The New Number Translation screen is displayed.

2. In the Input Number field, enter the input number.

Note: The input number must be unique for the customer and will accept up to 20 valid
characters, where valid characters are 0-9, A-F, * and #.

3. From the Number Range drop down list, select the termination range.

4. In the Termination Number field, enter the termination number.

5. Click Save.

Result: The details are saved and the screen returns to the main window.

Related topic

Number Translations

Editing Number Translations
Follow these steps to edit an existing number translation.

1. On the Number Translation tab, select from the table the number translation record to
edit.

2. Click Edit.

Result: The Edit Number Translation screen is displayed.

3. Change the details as required.

4. Click Save.

Result: The changes are saved to the database.

Related topic

Number Translations
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Deleting Number Translations
Follow these steps to delete an existing number translation.

1. From the Number Translation tab, select the number translation to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The number translation is removed from the database.

Chapter 24
Deleting Number Translations
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25
Default Termination Numbers

You use the Default Termination No tab of the ACS Resources screen to allocate default
termination numbers for your customers.

Default termination numbers are used where a search does not locate a termination number in
a control plan.

A customer can only have one default termination number, and it is necessary that the
termination number is within the range of termination numbers that have been allocated to that
customer.

Allocating Default Termination Numbers
Follow these steps to allocate a default termination number.

1. On the Default Termination No tab, select the customer to allocate a default termination
number to.

2. Click Edit.

Result: The Edit Default Termination Number screen is displayed.

3. From the Number Range drop down list, select the number range of the termination
number.

4. In the Termination Number field, enter the termination number.

5. Click Save.

Result: The details are saved.

If the new record is used in a compiled control plan, the compiler report will be displayed.
The compiler report gives details of all the control plans that this change caused to be
recompiled and their status.

Related topic

Default Termination Numbers
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26
Event Counters

The Event Counters tab of the ACS Resources screen displays the event counters for each
customer. Each event counter is maintained separately.

Event counters simply count an event. They may be accessed at runtime and can be used, for
example, for televoting. Counters can be queried in real-time on the Statistics Chart screen.

It is not possible to delete an event counter that is currently in use by a compiled control plan.
Editing an event counter will cause all compiled control plans that use that record to be
recompiled.

The ACS system administrator allocates customers a maximum number of counters on the
Edit Customer Resource Limits screen. Users of sufficient privilege (level 4 and above) may
add, delete, and rename their event counters within that limit.

Adding Event Counters
Follow these steps to add a new event counter.

1. On the Event Counters tab, click New.

Result: The New Event Counter screen is displayed.

2. In the Counter field, enter the name of the event counter.

Note: Event counter names must be unique for that customer, that is, two customers may
have counters called 'Stats1', but a customer may not have two counters called 'Stats1'.

3. Click Save.

Result: The details are saved and you return to the Event Counters tab.

Related topic

Event Counters

Editing Event Counters
Follow these steps to edit an existing event counter.

1. On the Event Counters tab, select from the table the event counter record to edit.

2. Click Edit.

Result: The Edit Event Counter screen is displayed.

3. Change the details as required.

4. Click Save.

Result: The changes are saved to the database.

Related topic

Event Counters
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Deleting Event Counters
Follow these steps to delete an existing event counter.

1. On the Event Counters tab, select the event counter to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed

3. Click OK.

Result: The event counter is removed from the database.

Chapter 26
Deleting Event Counters
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27
Tariff Codes

Use the Tariff Codes tab on the ACS Resources screen to add new tariff codes for your
customer. Tariff codes are used to return charging information to the switch. This information
can be sent either in an SCI or an FCI operation.

The component type (SCI or FCI) will determine how the tariff code is delivered to the service
switching point (SSP).

If the component type is set to:

• SCI, then the tariff code will be sent to the switch in an INAP Send Charging Information
operation

• FCI, then the tariff code will be sent to the switch in an INAP Furnish Charging Information
operation

Tariff codes are used by the Set Tariff Code node to send charging information to the switch.

Adding Tariff Codes
Follow these steps to add a new tariff code for your customer.

1. On the Tariff Codes tab, click New.Result: The New Tariff Code screen is displayed.

2. In the Tariff Name field, enter a name for the new tariff code.

3. In the Tariff Code field, enter a code for the new tariff code.

4. Select whether the tariff code should be marked to be sent in an SCI component or FCI
component.

Note: The tariff code is a hexadecimal code that is usually provided by the switch
manufacturer. The tariff code can only be added by the system administrator or ACS Level
6 users.

5. Click Save.

Result: The details are saved and the screen returns to the Tariff Codes tab.

Related topic

Tariff Codes

Editing Tariff Codes
Follow these steps to edit an existing tariff code.

1. On the Tariff Codes tab, select the tariff code to edit.

2. Click Edit.

Result: The Edit Tariff Code screen is displayed.

3. Change the details as required.

4. Click Save.
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Result: The changes are saved to the database.

Related topic

Tariff Codes

Deleting Tariff Codes
Follow these steps to delete an existing tariff code.

1. On the Tariff Codes tab, select the tariff code to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The tariff code is removed from the database.

Chapter 27
Deleting Tariff Codes
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28
Incoming Number Restrictions

Allowed and barred numbers in the ACS Resources screen are provisioned on a per customer
basis.

Each customer has one incoming and one outgoing list. Each of these lists must be classed as
either “Allowed” or “Barred”.

• Allowed numbers are allowed only if they occur in the list. If the list is empty then no
numbers are allowed – everything is barred.

• Barred numbers are barred only if they occur in the list. If the list is empty then no
numbers are barred – everything is allowed.

Use with Call Filtering Node
While the primary use of the lists is to allow or bar, based on service number (incoming, or CLI
(outgoing) they may in fact be used to compare against any type of number available in the 
Call Filtering feature node in the ACS Control Plan Editor.

The lists can be applied in control plans by selecting the service number profile or CLI profile in
the Call Filtering node in the CPE. As mentioned earlier, these lists may be used to match
against any type of number but are labeled “Incoming” and “Outgoing” for convenience.

Examples:

1. You have an INCOMING ALLOWED list containing the numbers 555-1234, 555-1235, and
555-1236. Calls to the service numbers 555-1234, 555-1235, and 555-1236 are allowed
but calls to all other numbers are not allowed, so a call to 444-5555 would not be allowed.

2. You have an INCOMING BARRED list containing the same numbers. Calls to the service
numbers listed will not be allowed; calls to all other service numbers are allowed.

3. You have an OUTGOING ALLOWED list containing the same numbers. An outgoing call to
CLI 555-1234 would be allowed (as would 555-1235 and 555-1236). Outgoing calls to any
other CLI would be be barred.

4. You have an OUTGOING BARRED list containing the same numbers. An outgoing call to
CLI 555-1234 would be barred (as would 555-1234 and 555-1236). Outgoing calls to any
other CLI would be allowed.

Use with Prefix Tree Branching Node
The Prefix Tree Branching node allows you to select incoming or outgoing list data and branch
on whether the number is in that list or not. Used in conjunction with other nodes, such as 
Profile Branching, you can determine whether it is the barred or allowed list and branch
accordingly.

Number Restrictions Tab Fields
Here is a description of the fields used when setting incoming and outgoing number
restrictions.
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Field Description

Restriction List Displays the list of restricted numbers in the number profile. You can:

• Add new numbers to the list using the New Number field
• Delete numbers in this list by highlighting the number and clicking Delete

List Type Each ACS customer has one incoming and one outgoing restriction list. The
list must be classed as either "Allowed" or "Barred".

If list type is:

• Allowed – Numbers are allowed only if they occur in the list. If the list is
empty then no numbers are allowed - everything is barred.

• Barred – Numbers are barred only if they occur in the list. If the list is
empty then no numbers are barred - everything is allowed.

Ignore Select this check box if you want to ignore the restricted numbers list
displayed.

New Number Use this field to add a new number to the restricted numbers list.

Enter the new number then click Add to send it to the list.

Editing Incoming No. Restrictions
Follow these steps to edit numbers in an incoming number restrictions list.

Tip: You can set number restrictions at the SN or CLI level in the Numbers screen.

1. On the Incoming No. Restrictions tab, select the type of list from the List Type drop
down list. If you select Allowed, only listed numbers will be allowed. If you select Barred,
all numbers are allowed, except for the listed numbers.

2. If you want the incoming number restrictions to be ignored for this customer, select the
Ignore check box.

3. In the New Number field, enter a number to add to the list and click Add.

Result: The number will be added to the restriction list.

4. From the Restriction List, select a number to remove and click Remove.

Result: The number will be removed from the restriction list.

5. Click Save.

Result: The changes will be saved to the database.

Chapter 28
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29
Outgoing Number Restrictions

Allowed and barred numbers in the ACS Resources screen are provisioned on a per customer
basis.

Each customer has one incoming and one outgoing list. Each of these lists must be classed as
either “Allowed” or “Barred”.

• Allowed numbers are allowed only if they occur in the list. If the list is empty then no
numbers are allowed – everything is barred.

• Barred numbers are barred only if they occur in the list. If the list is empty then no
numbers are barred – everything is allowed.

Use with Call Filtering Node
While the primary use of the lists is to allow or bar, based on service number (incoming, or CLI
(outgoing) they may in fact be used to compare against any type of number available in the 
Call Filtering feature node in the ACS Control Plan Editor.

The lists can be applied in control plans by selecting the service number profile or CLI profile in
the Call Filtering node in the CPE. As mentioned earlier, these lists may be used to match
against any type of number but are labeled “Incoming” and “Outgoing” for convenience.

Examples:

1. You have an INCOMING ALLOWED list containing the numbers 555-1234, 555-1235, and
555-1236. Calls to the service numbers 555-1234, 555-1235, and 555-1236 are allowed
but calls to all other numbers are not allowed, so a call to 444-5555 would not be allowed.

2. You have an INCOMING BARRED list containing the same numbers. Calls to the service
numbers listed will not be allowed; calls to all other service numbers are allowed.

3. You have an OUTGOING ALLOWED list containing the same numbers. An outgoing call to
CLI 555-1234 would be allowed (as would 555-1235 and 555-1236). Outgoing calls to any
other CLI would be be barred.

4. You have an OUTGOING BARRED list containing the same numbers. An outgoing call to
CLI 555-1234 would be barred (as would 555-1234 and 555-1236). Outgoing calls to any
other CLI would be allowed.

Use with Prefix Tree Branching Node
The Prefix Tree Branching node allows you to select incoming or outgoing list data and branch
on whether the number is in that list or not. Used in conjunction with other nodes, such as 
Profile Branching, you can determine whether it is the barred or allowed list and branch
accordingly.

Number Restrictions Tab Fields
Here is a description of the fields used when setting incoming and outgoing number
restrictions.
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Field Description

Restriction List Displays the list of restricted numbers in the number profile. You can:

• Add new numbers to the list using the New Number field
• Delete numbers in this list by highlighting the number and clicking Delete

List Type Each ACS customer has one incoming and one outgoing restriction list. The
list must be classed as either "Allowed" or "Barred".

If list type is:

• Allowed – Numbers are allowed only if they occur in the list. If the list is
empty then no numbers are allowed - everything is barred.

• Barred – Numbers are barred only if they occur in the list. If the list is
empty then no numbers are barred - everything is allowed.

Ignore Select this check box if you want to ignore the restricted numbers list
displayed.

New Number Use this field to add a new number to the restricted numbers list.

Enter the new number then click Add to send it to the list.

Editing Outgoing No. Restrictions
Follow these steps to edit numbers in an outgoing number restrictions list.

Tip: You can set number restrictions at the SN or CLI level in the Numbers screen.

1. On the Outgoing No. Restrictions tab, select the type of list from the List Type drop
down list. If you select Allowed, only listed numbers will be allowed. If you select Barred,
all numbers are allowed, except for the listed numbers.

2. If you want the outgoing number restrictions to be ignored for this customer, select the
Ignore check box.

3. In the New Number field, enter a number to add to the list and click Add.

Result: The number will be added to the restriction list.

4. From the Restriction List, select a number to remove and click Remove.

Result: The number will be removed from the restriction list.

5. Click Save.

Result: The changes will be saved to the database.

Chapter 29
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30
Least Cost Routing

Use the Least Cost Routing tab on the ACS Resources screen to manage and maintain least
cost routing configuration. Least cost routing enables calls to be routed differently by replacing
prefixes to the destination address.

The tab updates the Simple LCR fields in the "Customer" profile. They are applied in control
plans using any of the following feature nodes:

• Terminate to Pending TN

• Attempt Terminate to Pending TN

• Attempt Terminate to Pending TN with Duration

Using Least Cost Routing
Follow these steps to add or edit the least cost routing for the selected customer.

1. Select the customer for whom least cost routing is to be added.

2. Enter the prefixes that are to be used for least cost routing.

• Old National: The 'National' prefix that is to be matched in the normalized number for
least cost routing to be applied.

• New National: The prefix that is to replace the "Old National prefix" in numbers that
matched the old national prefix.

• Old International: The 'International' prefix that is to be matched in the normalized
number for least cost routing to be applied.

• New International: The prefix that is to replace the "Old International prefix" in numbers
that matched the old international prefix.

3. Click Save to commit the changes to the database.

Note: This least cost routing will be applied to all calls for the selected customer.
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31
Service Numbers

A service number is the number that is dialed by other parties when they contact the customer.

Note: Service numbers can only be deleted by an ACS system administrator.

Service Number Fields
This table describes the function of each field when adding and editing a service number.

Field Description

Number Use to specify the number that will be dialed by a
caller, (for example: 0800747733). The number
may be up to 32 numeric characters in length
(dependant on your network configuration) but may
not be left blank.

Warning: Each individual service number must be
unique.

New service numbers can only be added by the
ACS administrator.

Allocated To The name of the reseller or agent this number is
allocated to.

Note: This field is only visible if you are a reseller,
or agent, (See Tiered Customer Structure) and you
have logged into ACS as a standalone application
(See Accessing ACS as a Standalone Application).

Network Select the network or accept the ‘Any’ network
default.

Control plans are selected based on a service
number and network pair. This allows users of the
same service numbers on different networks to be
routed to different call plans, if required. Any
number of network keys may be configured as
identifiers for each network. Networks are set up
on the Networks tab of the ACS Tools screen.

The system matches the set keys with the
information contained in an incoming call to identify
the originating network and route the call
accordingly.

Number Range Select an existing number range for the customer if
required. This is dependent on what termination
range policy is set at the customer level. This
number range is used by the follow me number
(described below).
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Field Description

Follow Me Number Used to put the follow me number into the service
number profile, which is used by the Set Pending
TN From Profile node.

See CPE User's Guide for more information about
follow me numbers.

Note: This must be within the selected number
range (described above) or if no number range
selected, may be left blank.

Language The default language for interactions
(announcements and notifications) with this
number.

PIN Use to specify the PIN that will be put into the
service number profile, which is used by PIN
Authorisation node.

Play Toll Free Beep Select to play the toll free beep.

The toll free beep announcement set and entries
are set up on the Global Configuration tab of the
ACS Tools screen.

Access Code Management

Field Description

Code Length Select the minimum and maximum number of digits
for the access codes for the customer.

Access Code Enter the access code and then click Add to send
it to the list.

Access Code Policy

Field Description

Use Default Use the default access code policy that is set up
on the Global Configuration tab of the ACS Tools
screen.

Not Required The user is not required to enter an access code.

Required and Verified The user is required to enter an access code and
the code will be verified against the above access
code list.

Required and Not Verified The user is required to enter an access code but
the code will not be verified against the above
access code list.

Restriction Number Management

Chapter 31
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Field Description

List Type The service number has an incoming restriction list. The list must be classed
as either "Allowed" or "Barred" but cannot be both.

If list type is:

• Allowed: populate this list with numbers/prefixes that are to be allowed
for use. All numbers/prefixes outside of this list will not be allowed. For
example, from a prefix list of 09, 07, 04 and 03, if you enter 07 into the
allowed list then all other prefixes will not be allowed - except 07.

• Barred: Set the number to bar at an individual service number level.
Tip: The actual filtering is implemented using the Prefix Tree Branching
feature node in a control plan.

Number Use this field to add a new number to the barred/allowed numbers list.

Enter the new number then click Add to send it to the list.

Tip: You can enter the full number, a partial number or a prefix in this field.

Ignore Select this check box if you want to ignore the barred/allowed numbers list
displayed.

Adding Service Numbers
Follow these steps to create a new service number.

1. On the Service Numbers tab, click New to the right of the Service Number field.

Result: The New Service Number screen is displayed.

2. Populate the appropriate fields with the required data, referring to Service Number Fields
for detailed input descriptions.

3. Click Save.

Result: The new service number is created and you are returned to the Service Numbers
tab.

Related topic

Service Numbers

Editing a Service Number
Follow these steps to edit an existing service number.

1. From the Service Numbers tab, select the number to edit from the Service Number field.

2. Click Edit.

Result: The Edit Service Number screen is displayed.

3. Populate the appropriate fields with the required data, referring to Service Number Fields
for detailed input descriptions.

4. Click Save.

Result: The edited service number is saved and you are returned to the Service Numbers
tab.

Related topic

Service Numbers

Chapter 31
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Deleting a Service Number
Follow these steps to delete an existing service number.

1. From the Service Numbers tab, select the number to delete from the drop down list.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK to confirm the deletion of the number.

Result: The service number is deleted and you are returned to the Service Numbers tab.

Related topic

Service Numbers

Associating FCI Data with a Service Number
Follow these steps to specify the FCI data that you want to associate with a service number.

Note: The FCI data is stored in the FCI profile fields in the service number profile block.

1. In the ACS UI, open the Numbers window and select the ACS customer from the
Customer list.

2. On the Service Numbers tab, select the service number you want from the Service
Number list.

3. Click Edit.

The Edit Service Number window opens.

4. In the FCI Data Management area, enable or disable FCI inap interaction by selecting or
deselecting FCI On.

5. Specify the FCI service code in the FCI Service Code field. Enter an integer in the range 0
(zero) to 65535.

6. Specify the FCI country code in the FCI Country Code field. Enter a string of up to three
hexadecimal digits.

7. Click Save.

The FCI data for the selected service number is saved to the FCI profile tags in the service
numbers profile block.

Chapter 31
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32
CLI Numbers

A calling line identifier (CLI) number is used to identify the phone number that call originates
from.

Note: CLI numbers can only be deleted by an ACS system administrator.

CLI Number Fields
This table describes the function of each field when adding and editing a CLI number.

Field Description

Number Caller line identification (CLI). This is the telephone
number of the calling party.

Allocated To The name of the reseller or agent this number is
allocated to.

Note: This field is only visible if you are a reseller
or agent (See Tiered Customer Structure) and you
have logged into ACS as a standalone application
(See Accessing ACS as a Standalone Application).

Network Select the network or accept the ‘Any’ network
default.

Control plans are selected based on a service
number and network pair. This allows users of the
same service numbers on different networks to be
routed to different call plans, if required. Any
number of network keys may be configured as
identifiers for each network. Networks are set up
on the Networks tab of the ACS Tools screen.

The system matches the set keys with the
information contained in an incoming call to identify
the originating network and route the call
accordingly.

Number Range Select an existing number range for the customer if
required. This is dependant on what termination
range policy is set at the customer level. This
number range is used by the follow me number
(described below).

Follow Me Number Used to put the follow me number into the CLI
profile, which is used by the Set Pending TN From
Profile node.

See CPE User's Guide for more information about
follow me numbers.

Note: This must be within the selected number
range (described above) or if no number range
selected, may be left blank.

Language The default language for interactions
(announcements and notifications) with this
number.

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 1 of 3



Field Description

PIN Use to specify the PIN that will be put into the CLI
number profile, which is used by PIN Authorisation
node.

Play Toll Free Beep Select to play the toll free beep.

The toll free beep announcement set and entries
are set up on the Global Configuration tab of the
ACS Tools screen.

Access Code Management

Field Description

Code Length Select the minimum and maximum number of digits
for the access codes for the customer.

Access Code Enter the access code and then click Add to send
it to the list.

Access Code Policy

Field Description

Use Default Use the default access code policy that is set up
on the Global Configuration tab of the ACS Tools
screen.

Not Required The user is not required to enter an access code.

Required and Verified The user is required to enter an access code and
the code will be verified against the above access
code list.

Required and Not Verified The user is required to enter an access code but
the code will not be verified against the above
access code list.

Restriction Number Management

Field Description

List Type The CLI number has an outgoing restriction list. The list must be classed as
either "Allowed" or "Barred" but cannot be both.

If list type is:

• Allowed: Populate this list with numbers/prefixes that are to be allowed
for use. All numbers/prefixes outside of this list will not be allowed. For
example, from a prefix list of 09, 07, 04 and 03, if you enter 07 into the
allowed list then all other prefixes will not be allowed - except 07.

• Barred: Set the number to bar at an individual service number level.
Tip: The actual filtering is implemented using the Prefix Tree Branching
feature node in a control plan.

CLI Use this field to add a new number to the barred/allowed numbers list.

Enter the new number then click Add to send it to the list.

Tip: You can enter the full number, a partial number or a prefix in this field.

Ignore Select this check box if you want to ignore the barred/allowed numbers list
displayed.

Chapter 32
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Adding CLI Numbers
Follow these steps to create a new CLI number.

1. On the CLI Numbers tab, click New to the right of the CLI Number field.

Result: The New CLI Number Screen is displayed.

2. Populate the appropriate fields with the required data, referring to CLI Number Fields for
detailed input descriptions.

3. Click Save.

Result: The new CLI number is created and you are returned to the CLI Numbers tab.

Related topic

CLI Numbers

Editing a CLI Number
Follow these steps to edit an existing CLI number.

1. From the CLI Numbers tab, select the number that to edit from the CLI Number field.

2. Click Edit.

Result: The Edit CLI Number Screen is displayed.

3. Populate the appropriate fields with the required data, referring to CLI Number Fields for
detailed input descriptions.

4. Click Save.

Result: The edited CLI number is saved and you are returned to the CLI Numbers tab.

Related topic

CLI Numbers

Deleting a CLI Number
Follow these steps to delete an existing CLI number.

1. From the CLI Numbers tab, select the number to delete from the drop down list.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK to confirm the deletion of the number.

Result: The CLI number is deleted and you are returned to the CLI Numbers tab.

Related topic

CLI Numbers

Chapter 32
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33
Control Plan Schedule

The ACS Numbers screen enables you to perform the following control plan scheduling tasks
for a service number or CLI number.

Call Schedule

• Schedule or un-schedule a control plan

• Delete historical control plan schedules

What is a Control Plan?

A control plan is similar to a flow chart. Control plans essentially define the decisions and
actions that are made when a call is routed from source to destination. A control plan may
consist of multiple unique decision points or actions called feature nodes. Control plans are
constructed in ACS using the ACS Control Plan Editor (CPE).

Important: This topic provides CPE overview information in direct relevance to the Numbers
screen in ACS and its functions only. Refer to CPE User's Guide for further information.

Using Control Plan Schedules
Follow these steps to unschedule control plans for service numbers or CLI numbers from the
ACS Numbers screen and to delete historical schedule entries.

The table allows many scheduling entries to be entered for the selected number, but each
instance must have a different effective date. This allows a customer to schedule changes to
the control plans a service number or CLI number uses.

Tip: This topic provides CPE overview information in direct relevance to the Numbers screen in
ACS, and its functions, only. You must see CPE User's Guide for further information.

1. On the relevant tab of the Numbers screen, select the number that scheduling changes are
required for, in the Numbers area of the screen.

2. Select an existing scheduled control plan from the Scheduled Control Plans table.
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Tip: When you select a scheduled control plan, the control plan is highlighted in the
Control Plans table, and the template is highlighted in the Templates table.

3. The following functions are now available to you on the Scheduled Control Plans frame
of the screen, as shown on the example screen above:

• Unschedule – Go to step 4 to detach a control plan from the current service.

• Delete – Go to Step 5 to remove the selected control plan from the system.

4. Click Unschedule to detach this control plan from the current service.

Result: The control plan now displays as historical and is therefore no longer scheduled
for activity within the current service.

5. With the control plan selected on the Scheduled Control Plans table, click Delete.

Tip: Only historical control plans are able to be deleted from this table as they are no
longer scheduled for activity within the current service.

Warning: Unscheduling all control plans for a service number or CLI number will
discontinue processing of calls for that number.

Click Delete to confirm.

6. See Using Templates on the Numbers Screen for more Numbers screen information.

Chapter 33
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34
Control Plans

The Control Plans frame of the ACS Numbers screen enables you to perform the following
control plan functions for a service number or CLI number.

Control Plans

• Edit an existing control plan by launching the CPE

• Rename an existing control plan

• Schedule a control plan

• Edit termination numbers for a control plan that contains only one termination node

• Delete an existing control plan

Important: This topic provides ACS Control Plan Editor overview information in direct
relevance to the Numbers screen in ACS and its functions only. Refer to CPE User's Guide for
further information.

Using Control Plans on the Numbers screen
Follow these steps to manage control plans for service numbers or CLI numbers from the ACS
Numbers screen.

Important: This topic provides CPE overview information in direct relevance to the Numbers
screen in ACS, and its functions, only. Refer to CPE User's Guide for further information.

1. In the Control Plans frame on the Numbers screen perform one of the following actions:

• Select an existing control plan from the table

• Enter the control plan name in the Control Plans field and click Find

Notes:

• The As at date fields are available to aid you in your search for the 'most recent'
version(s) of a control plan.

• Click Reset to restore the date default and clear your search results from the Control
Plans field.

• Press Enter to restore the full control plan list in the table, after performing a search
which displays only a selection of control plans.
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Tip: When you select a control plan, the control plan's template is also highlighted in the
Templates table below.

2. The following functions are now available to you on the Control Plans frame of the screen,
as shown on the example screen above:

• Edit – See Editing a Control Plan.

• Delete – See Deleting a Control Plan.

• Rename – See Renaming a Control Plan.

• Schedule – See Scheduling a Control Plan.

• T/N – See Editing Termination Numbers.

Tip: See Using Templates on the Numbers Screen for more ACS Numbers screen
information.

To create a new control plan from this screen, you click New Control Plan in the
Templates frame. See Creating a Control Plan.

Editing a Control Plan
Follow these steps to edit a control plan, using the Numbers screen.

1. Highlight the control plan to edit in the table in the control plans area of the Numbers
screen, and click Edit.

Result: The Edit Control Plan prompt appears.

2. Make your selection:

• Click Read Only to open the template (on which the control plan was created) as read
only. This means that the structure cannot be changed; no nodes can be added or
deleted.

• Click Writable to open the template (on which the control plan was created) in edit
mode. This means that you are able to change the structure; nodes can be added and
deleted.

Result: The control plan is opened in the ACS Control Plan Editor window.

3. Make your edits and Save as per the standard CPE procedure.

Chapter 34
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Result: You are returned to the ACS Numbers screen, with the updated control plan
displayed in the control plan table.

Related topic

Control Plans

Deleting a Control Plan
Follow these steps to delete a control plan, using the Numbers screen.

1. With the control plan selected in the table in the Control Plans frame of the Numbers
screen, click Delete.

Notes:

• The Delete button is not enabled if a control plan is displayed on the Scheduled
Control Plans table, irrespective of schedule status (Scheduled, Active or Historical).

• This action completely removes the control plan from the system, it will not be able to
be reinstated. The Delete button in the Scheduled Control Plans frame above simply
removes the scheduling of the control plan for use within the system at the scheduled
time, and leaves the control plan within the system for future use if required.

Result: You see a delete confirmation prompt.

2. Click Delete to confirm.

Result: The control plan is deleted from the system.

Related topic

Control Plans

Renaming a Control Plan
Follow these steps to rename a control plan, using the Numbers screen.

1. With the control plan selected in the table in the Control Plans frame of the Numbers
screen, click Rename.

Result: The Rename Control Plan screen is displayed.

2. In the New name field, enter the new control plan name and click Save.

Result: You are returned to the Numbers screen, with the updated control plan displayed
in the Control Plans table.

Related topic

Control Plans

Scheduling a Control Plan
Follow these steps to schedule a control plan, using the Numbers screen.

1. With the control plan selected in the table in the Control Plans frame of the Numbers
screen, click Schedule.

Result: The Schedule Control Plan screen is displayed.

2. From the Date and Time drop down boxes, select the date and time required and click
Save.

Chapter 34
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Result: You are returned to the Numbers screen, with the control plan now displaying in
the Scheduled Control Plans table.

Notes:

• Each control plan scheduled must have a unique date and time pair so that the system
can determine which control plan to use at any given time.

• The date and time entered in this screen determine when the system is to begin using
this control plan for calls made to the service number or CLI number.

This scheduling entry will be used until the next scheduling entry (in time order) becomes
active; the system date is 'equal to' or 'after' the date/time pair set for this schedule entry.

Related topic

Control Plans

Editing Termination Numbers
If a control plan contains only one termination node, follow these steps to edit the termination
number, using the Numbers screen.

1. With the control plan selected in the table in the Control Plans frame of the Numbers
screen, click T/N.

Result:

If the control plan:

• Contains a termination node, the Configure Termination screen appears. Go to Step 2.

• Has no termination nodes, you see an error.

2. From the Number Range drop down box, select the number range.

In the Termination Number field, enter or edit the termination number for the control plan.

Click Save.

Result: You are returned to the Numbers screen and a new instance of the control plan
appears in the Control Plan table.

Note: You are now able to schedule this control plan as required.

Related topic

Control Plans

Chapter 34
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35
Templates

The Templates frame of the ACS Numbers screen enables you to perform the following control
plan template functions for a service number or CLI number.

Control plan templates:

• Create a new control plan template by launching the CPE

• Edit an existing template by launching the CPE

• Rename an existing template within the Numbers screen

• Create a new control plan based on an existing template by launching the CPE

• Delete an existing and unattached (not used by a control plan) template

Important: This topic provides ACS Control Plan Editor overview information in direct
relevance to the Numbers screen in ACS and its functions only. Refer to CPE User's Guide for
further information.

Using Templates on the Numbers Screen
Follow these steps to manage control plan templates for service numbers or CLI numbers from
the Numbers screen.

Important: This topic provides CPE overview information in direct relevance to the Numbers
screen in ACS, and its functions, only. Refer to CPE User's Guide for further information.

1. In the Templates frame on the Numbers screen, perform one of the following actions:

• Select an existing template from the Templates table

• Enter the template name in the Templates field and press Enter

2. Tip: To clear your search results from the Templates table, delete the search data in the
Templates field and press Enter. The Templates table now displays the full template list.

Tip: If the template selected is associated with a control plan then the control plan is also
highlighted in the Control Plans table above.

3. The following functions are now available to you on the Templates frame of the screen, as
shown on the example screen above:

• Edit – See Editing a Control Plan Template.

• Copy – See Copying a Control Plan Template.

• Delete – See Deleting a Control Plan Template.

• Rename – See Renaming a Control Plan.

• New Template – See Creating a new Control Plan Template

• Use Template – See Creating a Control Plan based on a Template.

• New Control Plan – See Creating a Control Plan.

Tip: See the Using Control Plans on the Numbers screen procedure for more Numbers
screen information.
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Editing a Control Plan Template
Follow these steps to edit a control plan template, using the Numbers screen.

1. Highlight the control plan template to edit in the table in the Templates frame of the
Numbers screen, and click Edit.

Result: The selected template is opened in the ACS Control Plan Editor window.

2. In the CPE, make your edits and Save the control plan template.

Result: You are returned to the Numbers screen in ACS, with the updated template
displayed in the templates table.

Related topic

Templates

Copying a Control Plan Template
Follow these steps to copy a control plan template, using the Numbers screen.

1. With the control plan template selected in the table in the Templates frame of the Numbers
screen, click Copy.

Result: The control plan template will be copied, compiled and saved; you see a screen,
showing the progress of the copy procedure.

2. Click Close.

Result: You are returned to the Numbers screen, with the new control plan template,
named "Copy of original control plan template name", displayed in the Control Plan
Template table.

Related topic

Templates

Deleting a Control Plan Template
Follow these steps to delete a control plan template, using the Numbers screen.

1. With the control plan template selected in the table in the Templates frame of the Numbers
screen, click Delete.

Result: The Really delete? prompt is displayed.

2. Click Delete to confirm and the template is removed from the Templates table.

Click Don't Delete to retain the template.

Result: You are returned to the ACS Numbers screen.

Related topic

Templates

Renaming a Control Plan Template
Follow these steps to rename a control plan template, using the Numbers screen.

Chapter 35
Editing a Control Plan Template
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1. With the control plan template selected in the table in the Templates frame of the Numbers
screen, click Rename.

Result: The Rename Template - template name screen is displayed.

2. In the New name field, enter the new template name and click Save.

Result: You are returned to the Numbers screen, with the updated template displayed in
the Templates table.

Related topic

Templates

Creating a new Control Plan Template
Follow these steps to create a new template, using the Numbers screen.

1. On the Numbers screen, click New Template.

Result: The New Template prompt appears.

2. Make your selection:

• Click Control Plan and Template to create a new template and control plan.

• Click Template Only to create a new template only.

3. Result: The CPE is then launched displaying the new template and/or control plan, as
illustrated in Editing a Control Plan Template.

4. Create your new template and/or control plan and click Save as per the standard CPE
procedure.

Result: You are returned to the Numbers screen in ACS, with the new template and/or
control plan displayed in the Templates table.

Creating a Control Plan based on a Template
Follow these steps to create a new control plan based on a template, using the Numbers
screen.

1. With the control plan template selected in the table in the Templates frame of the Numbers
screen, click Use Template to create a new control plan based on the selected template.

Result: The New Control Plan based on Existing Template prompt appears.

2. Make your selection:

Click Read Only to open the template (that is to be used for the control plan) as read only.
This means that the structure cannot be changed; no nodes can be added or deleted.

Click Writable to open the template (that is to be used for the control plan) in edit mode.
This means that you are able to change the structure; nodes can be added and deleted.

Result: The CPE is launched displaying the new template and/or control plan, as
illustrated in Editing a Control Plan Template.

Tip: The "Control Plan Name" will be the service number or CLI number selected.

3. Create your new control plan and click Save as per the standard CPE procedure.

Result: You are returned to the Numbers screen in ACS, with the new template and/or
control plan displayed in the Templates and/or Control Plans table.

Related topic

Chapter 35
Creating a new Control Plan Template
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Templates

Creating a Control Plan
Follow these steps to create a control plan, using the Numbers screen.

1. With the control plan template selected in the table in the Templates frame of the Numbers
screen, click New Control Plan.Result: The CPE is then launched ready for a new
template and/or control plan to be created.

Tip: The "Control Plan Name" will be the service number or CLI number selected.

2. Create your new control plan and click Save as per the standard CPE procedure.

Result: You are returned to the Numbers screen in ACS, with the new template and/or
control plan displayed in the Templates and/or Control Plans table.

Related topic

Templates

Chapter 35
Creating a Control Plan
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36
Search for Numbers

The Search for Numbers screen allows you to search the database for records that match the
criteria entered into the fields on the screen. You can provide pattern criteria for the service
number and CLI numbers to look for, as well as for other associated values, including customer
name, customer number and active control plan.

To access the Search for Numbers screen, on the Numbers screen, click Search.

Searching for Numbers
Follow these steps to search for a specific database record, using the Search for Numbers
screen.

1. Enter the search criteria into all required fields.

Tip: Any fields left blank will show all records in the database. Blank fields do not limit the
search at all.

2. Click Find to display the results in the database that match all entered fields.

3. Select the line in the Search Results table that is required.

Click Select.

Result: The Search for Numbers screen will close and the CLI Numbers or Service
Numbers tab of the Numbers screen will be populated with the selected database record.

Search for Numbers Fields and Buttons
This table describes the function of each field and button.

Field Description

Customer Name Allows you to specify a pattern to match customer
names. The search will match any customer name
starting with the provided pattern.

Customer Number Allows you to specify a pattern to match customer
numbers (also called customer references). The
search will match any customer number starting
with the provided pattern.

Service Number Allows you to specify a pattern to match service
numbers. The search will match any existing
service number containing the pattern as a prefix.

CLI Number Allows you to specify a pattern to match CLI
numbers. The search will match any existing CLI
containing the pattern as a prefix.

Active Control Plan Allows you to specify a pattern to match existing
control plans. The search will match any existing
control plan containing the pattern as a sub-string
(not has to be necessarily a prefix).
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Field Description

Find Click this button to launch the search function. The
button will be disabled if no pattern is provided
through any of the text fields.

Reset Click this button to clear the content of all text
fields.

Search filter options This group of options will further restrict the entries
to be displayed by the Search Results table:

• Show all will displayed all found data
• Customer only will just display customer

name and customer Number
• Service numbers only will restrict the output

to matched service numbers
• CLI numbers only will restrict the output to

matched CLI numbers

Search Results This table shows the results from the search after
clicking the find button. It presents five columns to
show the customer name, customer number,
service number, CLI number and active control
plan.

Select When this button is clicked after you have selected
one entry from the Search Results table, the
screen closes and the selected data is displayed in
the corresponding Service Numbers or CLI
Numbers panel in the Numbers screen.

Search Criteria
The entries in the Search Results table will be displayed according to the following criteria:

• CLI and service numbers are searched independently and displayed together in the same
table

• In order for a CLI or service number to be displayed, the customer name, customer
number, service number and active control plan must be matched

• An empty pattern in a field is considered to be an automatic match for that field

• An empty pattern in the Active Control Plan field will match the active control plan for any
CLI or service number including those without an active control plan

• In any case, you must fill in at least one pattern field in order to make the Find button
active

Chapter 36
Search Criteria
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37
Language

You use the Language tab on the Tools screen to specify the languages that you require for
ACS.

Note: ACS has the English language set as the default option.

If you require additional languages then you must add them using the steps outlined in this
section. To view the system Language options you need to click the Tools button in the ACS
main screen. The Tools screen is displayed with the Language tab open by default.

Languages and Announcements
The table on the Language tab displays the languages that are currently available in the
system.

Languages are used mainly by announcements. Each recording of an announcement that is
entered into the system must have a language associated with it. This allows the
announcements to be selected for a customer by language. It is important to define a default
language for the entire system.

Note: Languages can only be edited and maintained by the ACS system administrator. Details
cannot be edited directly into the table. If you want to make any changes to the language
entries, you must click Edit.

Language Fields
Here is a description of the fields used when setting a language.

Field Description

Name The language currently configured for ACS

Message Index The language that will be used for customer text messaging. This index
number is specified when the message is being sent and ACS applies
the appropriate language.

SRF Index Some SRF (Specialized Resource Function) announcement boxes
support an optional language parameter.

This parameter can be used with features such as speaking account
balances to ensure that the appropriate language translation algorithm
is used.

If you are using an SRF box that does not support this parameter, or if
you are not using announcements with dynamically generated content,
then this field does not need to be specified.

Change Customer The customer name

Changer User The name of the user who allocated or edited the record

Change Date The date when the record was allocated or last edited

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 1 of 3



Setting the Language Maps
Follow these steps to configure your ACS language maps.

1. On the Language tab, click New.

Result: The Language screen displays.

See Language Fields for details.

2. In the Language field, enter the new name of the language.

3. If you are using Short Text Messaging, enter the appropriate index number in the Message
Index field.

4. If you are using SRF, enter the appropriate index number in the SRF Index field.

5. Click Add.

Result: The new language map appears in the list.

6. Select the Default Language for the language mapping.

7. Click Save to save the changes to the database.

Related topic

Language

Changing Language Maps
Follow these steps to change your ACS language maps.

1. On the Language tab, click Edit.

Result: The Language screen is displayed.

See Language Fields for details.

2. Select the language from the table.

3. Change the details in the fields, as required.

4. Click Change to implement changes.

5. Click Save to record your changes.

Related topic

Language

Removing Languages
Follow these steps to remove a language from your ACS language maps.

1. On the Language tab, click Edit.

Result: The Language screen is displayed.

2. Select the language from the table and click Remove.

Result: The Confirm Language Removal prompt is displayed.

3. Click Ok.

Chapter 37
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4. Click Save to record your changes.

Chapter 37
Removing Languages
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38
Access Management

You use the Access Management tab in the Tools screen to allocate the customers that are
visible to the SMS user. This screen has a limiting function as SMS users automatically have
full access to all ACS customers, an SMS user's access is only limited when ACS customers
are selected and placed in this list. Therefore an empty Selected ACS Customers list gives full
access to all SMS users.

Access Management Fields
Here is a description of the fields used when managing access.

Field Description

SMS Application User Use this field to select the SMS application user whose ACS customers
you wish to view or configure

You can search for a user on this box. Refer to Searching the database.

Any records found are displayed in the area below this field.

Available ACS Customers Use this box to search for the available ACS customers that have been
configured for the current SMS application user. Refer to Searching the
database.

Any records found are displayed in the area below this field.

Selected ACS Customers Use this field to search for the selected ACS customers that have been
configured for the current SMS application user. Refer to Searching the
database.

Any records found will be displayed in the area below this field.

Adding Access to an ACS Customer
Follow these steps to add access to an ACS customer.

1. From the SMS Application User drop down list, select the user for whom the ACS
customer access is to be granted.

2. Search and select the customer(s) that you wish to give the SMS application user access
to in the Available ACS Customers field.

Click Add.

Result: The new customer(s) will appear in the Selected ACS Customers list.

The SMS application user will now be able view and manage data for the ACS customer(s)
added to the Selected ACS Customers list only.

Removing Access to an ACS Customer
Follow these steps to remove access to an ACS customer.

1. Select the SMS application user, for whom the ACS customer access is to be granted,
from the drop down list.
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2. Search and select the customer(s) that you wish to give the SMS application user access
to in the Available ACS Customers field.

Click Remove.

Result: The new customer(s) will be removed from the Selected ACS Customers list.

Chapter 38
Removing Access to an ACS Customer
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39
Networks

You use the Networks tab of the Tools screen to configure networks in ACS.

This tab displays all the networks that have been configured in the system.

Note: Each network is maintained separately.

Only ACS users with permission level 6 or above can access this tab.

Control plans are selected based on a service number (SN) and network pair. This allows
users of the same SN on different networks to be routed to different control plans, if required.
Any number of network keys may be configured as identifiers for each network. The system
matches the set keys with the information contained in an incoming call to identify the
originating network and route the call accordingly.

It is not possible to delete a network that is currently in use by a compiled control plan. Editing
a network will cause all compiled control plans that use that record to be recompiled.

Networks Tab Fields
Here is a description of the fields used when managing networks.

The table on the tab displays the network keys that have been configured for the selected
network. Any number of network keys may be configured as identifiers for each network. The
system matches the set keys with the information contained in an incoming call, to identify the
originating network and route the call accordingly.

Note: While no two network keys can be identical, it is possible for the individual node, port, or
service key ranges to overlap. For example, two network keys may have overlapping node and
port ranges, as long as the service key ranges do not overlap.

Field Description

Network Use to navigate through the list of configured networks

Node Start The number of the first node in the range of nodes for the selected
network

Node End The number of the last node in the range of nodes for this network

Port Start The number of the first port in the range of ports for this network

Port End The number of the last port in the range of ports for this network

SK Start The number of the first service key in the range of service keys for this
network

SK End The number of the last service key in the range of service keys for this
network

Change Customer The customer name

Change User The name of the user who allocated or edited the record

Change Date The date when the record was allocated or last edited
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Adding Networks
Follow these steps to add a new network.

1. On the Networks tab, click New (beside the Network drop-down list).

Result: The New Network screen is displayed.

2. In the Network field, enter the name of the new network.

3. In the Description field, enter a description of the new network.

4. Click Save.

Result: The changes are saved and you return to the Networks tab.

Related topic

Networks

Editing Networks
Follow these steps to edit an existing network.

1. On the Networks tab, select the network to edit from the Network table.

2. Click Edit (beside the Network drop-down list).

Result: The Edit Network screen is displayed.

3. Change the network name and description as required.

4. Click Save.

Result: The changes are saved and you return to the main window.

Related topic

Networks

Deleting Networks
Follow these steps to remove a redundant network configuration.

1. On the Networks tab, select the Network to delete from the Network table.

2. Click Delete (beside the Network drop-down list).

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Result: The network is removed from the database.

Adding Network Keys
Follow these steps to add a new network key to the selected network configuration.

1. On the Networks tab, select the network to add a key to from the Network drop down list.

2. Click New at the bottom of the tab.

Result: The New Network Key screen is displayed.

Chapter 39
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See Networks Tab Fields for details.

Tip: You are not required to enter ranges, but if the start of a range is entered, an end of a
range must also be entered. The end of a range must be greater than or equal to the start
of a range.

3. In the Node Start and Node End fields, enter the start and end of the node range. The
node is the originating point code.

4. In the Port Start and Port End fields, enter the start and end of the port range. The port is
the destination subsystem number.

5. In the SK Start and SK End fields, enter the start and end of the service key range.

6. Click Save.

Result: The details are saved and you return to the Networks tab.

Related topic

Networks

Editing Network Keys
Follow these steps to edit network keys.

1. On the Networks tab, select the network to edit from the Network drop down list.

2. Select the network key from the table.

3. Click Edit at the bottom of the tab.

Result: The Edit Network Key screen is displayed.

4. Change the details as described in Networks Tab Fields.

5. Click Save.

Result: The changes are saved and you return to the main window.

Related topic

Networks

Deleting Network Keys
Follow these steps to remove redundant network keys from the selected network.

1. On the Networks tab, select the network to edit from the Network drop down list.

2. Select the network key from the table.

3. Click Delete at the bottom of the tab.

Result: The Confirm Delete prompt is displayed.

4. Click OK.

Result: The network key record is deleted from the database.

Chapter 39
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40
Default Termination Range

The Default Termination Range tab enables you to add, edit and delete the default
termination number ranges that apply to the following feature nodes:

• Unconditional Termination

• Attempt Termination

• No Lookup and Translation

• Follow Me Number

These default ranges are assigned to the customer on the New Customer dialog box of the
ACS Customer screen. See Adding Customers.

Note: For more information about setting up individual customer termination number ranges
see the Termination Rangestab of the ACS Resources screen procedure.

Default Termination Range fields
Here is a description of the fields used when managing default termination ranges.

Field Description

Termination Number Range The default termination number ranges that are currently configured for
ACS.

Prefix The prefix of the termination number.

Minimum Digits The minimum number of digits permitted for the termination number.

Maximum Digits The maximum number of digits permitted for the termination number.

Adding a Default Termination Range
Follow these steps to add a new default termination range.

1. On the Default Termination Range tab, click New.

Result: The New Termination Range screen is displayed.

See Default Termination Range fields for details.

2. In the Prefix field, enter the prefix for the termination number.

3. In the Minimum Digits field, enter the minimum number of digits.

4. In the Maximum Digits field, enter the maximum number of digits.

Result: As you type, the Range Model field displays the termination range, with the
minimum digits after the prefix displayed as Xs and the maximum digits displayed as Ys,
for example 0800XXYYYY.

5. Click Save.

Related topic

Default Termination Range
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Editing a Default Termination Range
Follow these steps to edit an existing default termination range.

1. On the Default Termination Range tab, select the default termination range to edit.

2. Click Edit.

Result: The Edit Termination Range screen is displayed.

3. Change the value as required. See Default Termination Range fields for details.

4. Click Save.

Related topic

Default Termination Range

Deleting a Default Termination Range
Follow these steps to remove an existing default termination range.

1. On the Default Termination Range tab, from the table, select the default termination
range to delete.

2. Click Delete.

Result: The Confirm Delete prompt is displayed.

3. Click OK.

Chapter 40
Editing a Default Termination Range
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41
Global Configuration

The Global Configuration tab enables you to:

• Set the announcement set and entry to be used for the Beep announcement.

Important: These announcements must be on a CS2 INMAP capable SSP in order to
work correctly. See ACS Technical Guide for more information.

• Choose to display the time, date and version numbers or just the time and date on the
Control Plans table on the ACS Numbers Screen.

• Set the default access code policy that is referenced from the Access Code List on the 
Service Numbers tab and CLI Numbers tab on the ACS Numbers screen.

• Increase or decrease the maximum number of ACS self management sessions allowed.

Global Configuration Fields
The following tables describe the function of each field on the Global Configuration tab.

Beep Announcement Fields

Field Description

Announcement Set The announcement set to be used for the Beep announcement.

Announcement Entry The announcement entry to be used for the Beep announcement.

Note: See Announcements for more information about announcement
entries.

Control Plan Display Fields

Field Description

Version Numbers, Time and
Date

Select to display the version numbers on the control plan tables on the
ACS Numbers screen.

Time and Date Only The time and date is always displayed. Select this option to ensure that
the versions numbers are not displayed on the Control Plan tables on
the ACS Numbers screen.

Note: See ACS Numbers for more information about managing control
plans on the ACS Numbers screen.

Default Access Code Policy Fields

This function applies to the Access Code Entry node.

Field Description

Not Required The user is not required to enter an access code.

Required and Verified The user is required to enter an access code and the code will be
verified against the list in the Access Code Management frame on the
Service Number screen or CLI screen.
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Field Description

Required and Not Verified The user is required to enter an access code but the code will not be
verified.

Note: See Service Numbers and CLI Numbers for more information.

Max ACS Database Sessions Increase or decrease the maximum number of ACS self management
sessions allowed.

Warning: Ensure that this number does not exceed the total maximum
number of system sessions allowed. Contact your system administrator
for more information.

Editing the Global Configuration Settings
Follow these steps to edit the Global Configuration settings.

Note: There is only one set of Global Configuration settings within the system.

1. On the Global Configuration tab click Edit.

Result: The Edit Global Configuration screen appears.

See the Global Configuration Fields for this screen for more information.

2. In the Beep Announcement frame, for the Beep announcement, from the drop down lists,
select the appropriate:

• Announcement set

• Announcement entry

3. In the Control Plan Display frame, select the option you wish to have displayed on the
control plan. The options are:

• Version Numbers, Time and Date

• Time and Date Only

4. In the Default Access Code Policy frame, select the option for the appropriate default
access code policy. The options are:

• Not Required

• Required and Verified

• Required and Not Verified

5. In the Max ACS Database Sessions field, enter or select the required maximum number
of database sessions that can exist at the same time.

6. Click Save to save the new settings.

Result: The screen will return to the Global Configuration tab; note that this will now
display the most recent setting update information above the buttons at the bottom of the
screen.

Related topic

Global Configuration

Chapter 41
Editing the Global Configuration Settings
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42
ACS Event Chart Screen

The ACS Event Chart screen allows you to generate, display and print statistical 2-D and 3-D
graphs of event counters.

Tip: The event counters are set up on the New Event Counter screen.

Viewing Event Charts
Follow these steps to view event charts.

1. On the ACS Event Chart screen, select the Customer and press Enter.

Result: The system will return a list of all statistics generated for the selected customer.

2. Select the required event counter from the Counters list.

3. To view the graph in:

• 3D, select the 3-D Style check box

• 2D, leave the check box not selected

4. If you wish to display deltas on the graph, select the Show Deltas check box.

5. You can change the intervals that the statistic graph view is updated in the Interval (secs)
box.

6. Press Enter.

Result: The statistical graph will be displayed in the bottom area of the screen.

Printing Events Charts
Once you have generated a chart on the screen, you can print it by clicking Print.
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43
Getting Started with the Control Plan Editor

About Control Plans
You use the ACS Control Plan Editor (CPE) to create control plans. Control plans define how to
perform service-logic, based on factors such as the type of service, geographic location, time
of day, and so on. You can use control plans for routing calls, subscriptions and activations,
sending notifications, charging for a voice or a data session, providing IVR and self-care logic,
and so on.

A control plan is a service-logic flowchart that consists of a collection of connected feature
nodes. Each feature node defines a particular decision point or action that occurs in the
service-logic. You build a control plan by adding the feature nodes that provide the decisions
and actions you need, to a work space, called the control plan canvas. You then connect the
feature nodes in the canvas to define the service-logic.

Feature nodes provide service functions such as playing announcements, sending
notifications, and branching based on session data. A feature node can have one or more exits
which are connected to other feature nodes using branches. An exit from a feature node may
only have one branch connected to it, but many branches can connect in to a feature node.
The exit that a session takes when leaving a feature node is determined by the functionality of
that feature node and the session data. For example, for a voice call, a Day Of Week feature
node may have an exit that is applicable for one or more days of the week. The day that a call
is made on determines the exit taken from the feature node, and the service logic will follow the
branch connected to that exit to determine which action to take for that day.

See CPE User's Guide for more information about control plans.

About Types of Control Plans
You can configure a control plan to be public, private, or global:

• A public control plan is available to and can be used by all customers. You specify whether
a control plan is public when you create the control plan.

• A private control plan belongs to and is used by a particular customer only. A control plan
that is not public or global is private by default.

• A global control plan is associated with a specific service configured for use in Convergent
Charging Controller, and applies to all customers who use that service.

You specify whether a control plan is global when you save the control plan by giving it a
name that corresponds to the service to which it applies. Global control plans are
automatically assigned to the operator's default customer account.

Control Plan Update Interval
Control plans are stored in the database when saved and then cached at intervals in the SLC.
The cached control plans are used at run-time for service-logic processing. This means that
changes to control plans may not be immediately available for service-logic processing.
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Because new control plans do not exist in the cache already, a new control plan will be loaded
into the cache the first time it is required, and so should be available for use immediately.

The control plan update interval may be configurable for some services. For information on
configuring the control plan update interval for a service, see the technical guide for that
service.

About Control Plan Structures and Data
A control plan consists of a control plan structure and control plan data. The structure is the
service-logic flowchart (the collection of feature nodes in the control plan and the connections
between them). The data is the feature node configuration data that you set after you add
feature nodes to a control plan.

You can create multiple control plans that use the same control plan structure, but different
feature node configuration data. You might do this when you want to use the same control plan
structure for similar services, but base the routing on different session criteria for each service.

When you save a control plan, you specify a name for both the structure and the data. You can
save both using the same name. If you want to reuse the control plan structure with a different
set of data, then save the control plan structure and data using a different name for each. The
system identifies a control plan by the name you give to the control plan data.

About Control Plan Names and Properties
When you save a control plan, the version number, compile status, and public status of the
control plan is saved with the name. The CPE displays these properties in dialog boxes where
you select from a list of control plan names. The syntax is:

name(Vn, compile_status, public_status)

Where:

• name is the name of the control plan

• n is the version number of the control plan

• compile_status is one of the following:

– S: Successfully saved without errors

– E: Saved with errors

Note: Only successfully compiled control plans with a compile status S can be
activated for use with a service.

• public_status is the value Public if a control plan structure is public or is based on a public
structure. If the control plan is private, this property is not displayed.

For example:

Prepaid_Charging_Service(V2, S, Public)

Understanding the CPE User Interface

About the CPE User Interface
The following figure shows the Control Plan Editor (CPE) user interface (UI):
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The following sections describe the main areas of the CPE UI.

ACS Customer List and Node Field
To the right of the toolbar buttons is the Customer list. This list is accessible to ACS
administrators with privilege levels 6 or 7, and to all users who access ACS from the SMS UI.
This list displays the user name at the top and the names of the other ACS customer accounts
you have permission to access. Select another customer in the list and the feature palette will
display the feature nodes that have been set up for that customer.

Note: The CPE closes the control plan currently displayed in the canvas when you select
another customer.

The Node field displays the number of the feature node that is currently selected in the control
plan canvas. Each feature node is assigned a sequential number when you add it to the
canvas. This number is useful for searching and troubleshooting. To select a different feature
node in the canvas, type the number or name of the feature node in the Node field and click
Enter.

When saving a control plan, a report is generated that highlights any errors in the control plan
and specifies the number of the feature node in which the error occurred.

Note: The feature node number may not necessarily indicate how many feature nodes have
been used in the control plan. When you delete a feature node from a control plan, that node's
number is not reassigned. However, if you delete the feature node with the highest node
number, that number will be reassigned to the next feature node that you add.
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Feature Palette
On the left of the UI is the feature palette, which contains the names of feature groups. A
feature group is a set of feature nodes that are related to a common function.

To display the feature palette if it is not visible, or to hide the feature palette from view, click the

Palette button on the toolbar: 

Note: If you open an existing control plan as read-only, the feature palette is not displayed.

Float your cursor over the feature group name to display the feature nodes in the group. You
can filter which feature nodes are displayed by using the Search Palette box at the top of the
feature palette panel. See Finding Feature Nodes in the Feature Palette.

You can display a short description of a feature node in the feature group by floating your
cursor over the feature node. The description appears at the bottom of the feature group.

Note: The feature groups and feature nodes you see in the CPE are those that the CPE
system administrator has previously set up for you. If you do not see a feature node or feature
group that supplies the functionality that you need, contact your CPE system administrator.

Canvas
In the center is the CPE canvas where you build your control plans. You drag feature nodes
from the feature groups to the control plan canvas. All control plans begin with a Start feature
node. Each path in a control plan must end with an End feature node.

To add feature nodes to a control plan and connect them, see Working with Feature Nodes.

Search Results
The search results lists the feature nodes found in the canvas when you perform a search. You
enter the search criteria in the search field above the search results panel. See Searching for
Feature Nodes in the CPE Canvas for more information about searching for feature nodes.

Tips:

• To locate a feature node on the canvas that is listed in the search results, pass the mouse
pointer over the feature node name in the search results panel. The CPE highlights the
feature node in green in the search results panel and in your control plan on the canvas.

• Select a feature node in the search results tab to select it in the canvas and display
information about the feature node's connections in the node inspector panel.

Search Results Panel
On the right of the UI is the search results panel. It contains the following tabs:

• Search Results

• Issues

To display or hide the search results panel, click the Inspector button on the toolbar: .
Note: This also updates the CPE view preferences for your user. For more information, see 
About Setting and Resetting View Preferences.
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Issues
The CPE displays a list of issues that may prevent the control plan in the canvas from
compiling on the Issues tab of the search results panel. The following list is an example of the
types of issues:

• The feature node has no incoming connections.

• The feature node has one or more unconnected exits.

• The feature node contains invalid configuration data.

• The feature node version differs from the latest.

If you open or import a control plan that contains feature nodes with issues, this tab displays in
the search results panel.

Tips: If you click on an issue in the list, the feature node is selected and centered on the
canvas.

The CPE automatically updates the issues list by removing feature nodes from the list as you
configure them. If there are no issues, the tab is inactive.

Node Inspector
Below the search results panel is the node inspector panel. When you select a feature node or
a connector line in the canvas, the node inspector displays the following information about the
selected feature node or the feature nodes connected to the connector line:

• The feature node number and name; for example, 5. Set WalType for the Set Wallet Type
feature node.

• Node type and node fast key; for example, Set Wallet Type: swt, where Set Wallet Type
is the feature node type and swtis the feature node fast key.
Fast keys are abbreviations for the feature nodes that you can use as search criteria when
tracing control plans in the canvas. For more information about control plan tracing, see 
Troubleshooting Control Plans Using Control Plan Tracing.

• Any comments configured for the listed feature nodes. For more information about adding
feature node comments, see Adding Feature Node Comments.

• A list of incoming nodes and the names of their exit branches. Incoming nodes are the
feature nodes connected to the selected node and that come just before the selected
feature node in the control plan.

• A list of node exits. Node exits are the selected feature node's exit branches that lead to
other feature nodes in the control plan. If an exit is connected to a feature node, that
feature node is listed in the node inspector. If an exit is not connected to another feature
node, the node exit in the node inspector will be red.

Tips:

• To browse the feature node selection history and display information in the node inspector
about a previously selected node, click the arrow keys on the toolbar.

• To locate a feature node on the canvas that is listed in the node inspector, pass the mouse
pointer over the feature node name in the node inspector. The CPE highlights the feature
node in green in the node inspector panel and in your control plan on the canvas.

• To display information about a connected feature node, select the feature node in the node
inspector. The CPE also selects and centers the feature node in the canvas.
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• To display or hide the inspector panel, click the Inspector button on the toolbar: .

Note: This also updates the CPE view preferences for your user. For more information,
see About Setting and Resetting View Preferences.

About Setting and Resetting View Preferences
You set the CPE view preferences for your user ID each time you:

• Change the feature node title style. See Switching Between Feature Node Title Styles for
more information.

• Display or hide the grid, or change the grid proportions. See Using the CPE Canvas Grid
for more information.

• Display or hide the node inspector panel. See Node Inspector for more information.

The CPE saves the view preferences configuration for your user ID. The next time you access
the CPE, the Control Plan Editor window displays using your saved view preferences.

You can configure the CPE view preferences for individual SMS users and ACS users. For
more information, see CPE User's Guide.

The Control Plan Editor window displays using the default view preferences if no view
preferences have been set for your user. The default view preferences are those configured for
the SU user. If no view preferences have been set for the SU user, then the following defaults
are used:

• Display feature nodes in the canvas with all view options selected.

• Display the grid and set the grid proportions to 20.

• Display the inspector panel.

To reset your user view preferences to the default view, select Reset to Default View from the
View menu.

Note: Selecting Reset to Default View also makes the feature palette visible in the CPE
window, and sets the canvas magnification to actual size.

Changing the CPE Canvas Magnification
The canvas magnification controls the visual size of feature nodes in the canvas.

To change the canvas magnification, from the View menu select one of the following:

• Actual Size to display CPE canvas at the standard size

• Zoom In to scale up the CPE canvas and decrease the viewing area

• Zoom Out to scale down the CPE canvas and increase the viewing area

• Zoom To Fit to make all feature nodes in the control plan visible on the canvas

Tip: Double click the canvas background to:

• Zoom to fit a control plan that is bigger than the canvas.

• Zoom back to actual size a zoomed out control plan and center the control plan on the
double click point.

• Left double click also deselects the currently selected feature nodes. To retain the current
selection, right double click.

Chapter 43
Understanding the CPE User Interface

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 6 of 17



Using the CPE Canvas Grid
The CPE canvas grid can help you to align the feature nodes in the canvas whether or not the
grid is visible. The grid options control the grid size and behavior:

• To display the grid, select Grid from the View menu.

• To hide the grid, deselect Grid from the View menu.

• To change the grid proportions:

1. Select Grid granularity from the Tools menu.
The Snap-To-Grid dialog box appears.

2. Move the control pointer to change the grid proportion.

3. Click OK.

• To automatically align feature nodes to the grid, select Snap All To Grid from the Tools
menu.

• To resize feature nodes in the canvas so that their height and width are a multiple of the
grid size, select Resize All To Grid from the Tools menu.
For example, if the grid granularity is 50, then all feature nodes in the canvas will be
resized so that their heights and widths are the nearest multiple of 50. A node that is
currently 61 high and 132 wide will be resized to 50 high and 150 wide.

Tip: Hiding or displaying the grid, or changing the grid proportions, updates the CPE view
preferences for your user. For more information, see About Setting and Resetting View
Preferences.

Displaying User and Control Plan Information
Your user information includes your user name, customer name, permission level and session
ID. The control plan information includes the names of the current control plan structure and
data, the number of feature nodes in the control plan, whether the control plan has been
modified, and the date of the last modification. This information may be needed by your
technical support person if you encounter any technical issues.

To view user and control plan information, select Properties on the Tools menu or click the
Properties icon in the toolbar.

Working in Multiple Control Plans Simultaneously
You can work in multiple control plans at the same time. This is useful for comparing control
plans or copying and pasting feature nodes from one control plan to another.

To open multiple control plans, you start a new instance of the CPE for each control plan you
want to open:

In the CPE, select New Window from the File menu.

Working with Feature Nodes

Finding Feature Nodes in the Feature Palette
To help you find the feature nodes you want to add to a control plan, you can filter which
feature nodes are displayed in the feature palette.
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To filter which feature nodes are displayed in the feature palette, enter the search criteria in the
Search Palette field at the top of the feature palette panel. As you type, the CPE dynamically
updates the feature nodes available in each group by matching the entered text against the
following data:

• Feature node name

• Feature node fast key

• Feature node configuration parameter names

• Feature node exits

For example, if you enter "vo" in the search field, then the groups in the feature palette will
include only those feature nodes with the text "vo" in their name (for example, "voucher type
recharge") or in their associated data.

If there are no matching feature nodes in a group, then the feature group will disappear from
the feature palette.

Note: The Base group of feature nodes is always available and cannot be filtered.

Tips:

• The number of matching feature nodes in each remaining group is displayed in brackets
next to the feature group name.

• To clear the search criteria and restore the unfiltered feature palette, click the  icon in
the Search Palette field.

Adding Feature Nodes to a Control Plan
To add a feature node to a control plan, do one of the following:

• Drag the feature node icon from the feature group to the canvas.

• Click on the feature node icon in the feature group and then click in the canvas.

About Viewing Feature Node Properties
The feature node icons on the CPE canvas display the following properties by default:

• The feature node title above each feature node. By default the title includes the feature
node number and node name.

• A representative icon image for the feature node.

• The connector lines that connect feature nodes. Connector lines are solid if telephony is
active for that branch or dotted if telephony is not active. When the feature node is
selected:

– Red lines indicate input paths.

– Blue lines indicate exit paths.

• The telephony icon on feature nodes that use telephony capabilities.

• For feature nodes that contain comments, a yellow comment box at the top right corner of
the feature node.

• The feature node exits. Each feature node exit has a name. Feature node exits are:

– Solid if telephony is allowed

– Hollow if telephony is not allowed
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– Colored red if the exit is unconnected

Except for feature node exits, you can specify which of these properties is displayed. See 
Modifying Viewable Properties for Feature Nodes.

This figure shows the viewable properties for the Change Pin feature node.

Modifying Viewable Properties for Feature Nodes
All feature node icon properties in the CPE canvas are visible by default. See About Viewing
Feature Node Properties for more information about the properties.

To change the viewable properties for feature nodes:

From the View menu, select or deselect one or more of the following options:

• All displays all node properties.

• Node Title displays feature node titles above the feature nodes.

• Icons displays the icon images on feature node icons.

• Connections displays the connector lines between feature nodes.

• Telephony displays the telephony icon for feature nodes that have telephony capabilities,
and identifies the feature node exits that do not allow telephony. When Telephony is
selected, non-telephony exits appear grayed out on feature nodes.

Switching Between Feature Node Title Styles
The feature node icons in the CPE canvas can display one of the following node title formats:

• Feature node number and name

• Feature node name only

• Feature node number only

• No title

To change the format of the node title, select Next Node Title Style from the View menu to
change to the next format in the list.

To quickly switch to the next node title format, type "N".
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Tip: Changing the node title format updates the CPE view preferences for your user. For more
information, see About Setting and Resetting View Preferences.

Resizing Feature Nodes
You may want to resize certain feature nodes in the CPE canvas. You can make them bigger
so that they are easier to locate and their properties are easier to see. Or you can make them
smaller so that you can see more feature nodes on the CPE canvas without scrolling.

To resize a feature node, click and drag the resizing handle in the bottom right of the feature
node.

Copying and Pasting Feature Nodes
You can copy one or more feature nodes and paste them into the same control plan or into
another control plan in a different CPE window. The feature node configurations are also
copied.

You can use the standard copy-and-paste keyboard shortcuts or toolbar icons to copy and
paste feature nodes. You can also search the CPE canvas for specific feature nodes and then
select Select All Found Nodes from the Edit menu to select those feature nodes for copying.
For information about searching, see Searching for Feature Nodes in the CPE Canvas.

About Connecting Feature Nodes
The exits for a feature node define all the possible routes that the service-logic may take after
passing through the feature node. All the exits for a feature node must be connected to another
feature node in the control plan. You can connect multiple exits to the same feature node if
required. For example, you might connect the Abandoned, Routing Failure, and Abort exits of
the Attempt Termination feature node to the same End feature node.

Some feature nodes require an active session with the connected user to perform their
function, for example, to play an announcement. These telephony feature nodes will have
some exits that support telephony and some, such as the exit for call abandoned, that do not
support telephony. You can only connect exits that support telephony to a telephony feature
node.

You can configure the number of exits for some feature nodes, such as the Dynamic Switch
feature node. Configuring an additional exit allows you to define an additional branch in the
service-logic. See Editing Feature Node Exits for more information.

Viewing Node Exit Bubble Help
The feature nodes in the CPE canvas incorporate bubble help boxes for each feature node
exit. Exits are the dots at the bottom of the feature node icons. The bubble help includes
information about the exit branch.

To specify whether to display exit bubble help, select or deselect the Display Node Exit Info
option from the Tools menu.

To view exit bubble help, pass the mouse pointer over an exit. Information about the exit
connection appears. The text in quotes is the name of the exit. If the feature node has two or
more unconnected exits, then the bubble help includes help about connecting all the exits for
the feature node.
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Editing Feature Node Exits
You can edit the number of available exits for some feature nodes to provide additional
branches in the service-logic.

Note: This option is unavailable for feature nodes that have a fixed number of exits.

To edit the number of exits for a feature node:

1. Select the feature node in the CPE canvas that you want to edit.

2. Do one of the following to open the Edit Node Structure dialog box:

• Press Alt+Enter.

• Right-click on the feature node and select Edit Node Exits.

3. The Edit Node Structure dialog box opens.

4. In the Branch field, enter the number of exits the feature node should have or use the
arrow buttons to change the number of exits.

5. Click Save.

The Edit Node Structure dialog box closes and the feature node icon has the configured
number of exits.

Connecting Feature Nodes
You connect two feature nodes by dragging a line from an exit on the source feature node to
the target feature node.

You can also:

• Simultaneously connect all unconnected exits

• Select the exits to connect
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Simultaneously Connecting All Unconnected Exits
To simultaneously connect all the unconnected exits in the source feature node to a target
feature node, press the Alt key while clicking on an unconnected exit and dragging a line to the
target feature node.

Note: If the target feature node uses telephony, only those exits from the source feature node
that allow telephony will be connected to the target feature node.

Selecting the Exits to Connect
To select multiple exits in the source feature node and connect them to a target feature node:

1. Press the Shift key and click and drag a line from an unconnected exit in the source
feature node to the target feature node.

The Manage Node Exits dialog box appears.

2. Select one of the following options to enable the feature node exit check boxes:

• Unfilled exits only to enable the check boxes for all remaining feature node exits.

• Any valid exit to enable the check boxes for all valid feature node exits.

Tip: Invalid connections are connections from a non-telephony exit to a telephony node.

3. Do one of the following:

• To quickly connect the enabled exits to the target feature node, click one of the
following buttons in the Mass connect section:

– All to connect all the available exits

– Telephony to connect exits that support telephony

– Non-Telephony to connect exits that do not support telephony

• To connect only some of the enabled exits to the target feature node, check the boxes
for the exits you want to connect in the Connect these exits section.

4. Click Done.

About Configuring the Type of Connector Line
There are two types of feature node connector line:

• Angled connector lines bend around feature nodes where possible instead of crossing over
them. This is the default. Angled connector lines are colored when highlighted:

– Red lines indicate input paths.

– Blue lines indicate exit paths.

• HV connector lines use a combination of horizontal and vertical lines to connect feature
nodes and may cross over other feature nodes. HV connector lines can be black or colored
when highlighted.

You can configure the type of connector line to use for SMS users, ACS users, and individual
users. For more information, see CPE User's Guide.

Note: The control plan structure is not affected by the type of connector line.
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Deleting a Feature Node Connection
You can delete a single connection or simultaneously delete multiple connections between two
feature nodes.

Deleting a Single Connection Between Two Feature Nodes
To delete a single connector line between two feature nodes:

1. Click the exit in the source feature node for the connection you want to delete.

The connector line is selected.

2. Do one of the following:

• Click the Delete icon on the toolbar.

• Grab the connector line and drag it away from the target node.

The selected connection is deleted.

Simultaneously Deleting Multiple Connections Between Two Feature Nodes
To simultaneously delete multiple connections between two feature nodes

1. Press the Shift key and click and drag a line from an exit in the source feature node to the
feature node from which to delete connections. Do this even if there is already a connector
line from all exits.

The Manage Node Exits dialog box appears.

2. Do one of the following:

• To delete all the connections between the two nodes, in the Mass connect panel, click
None.

• To delete only some connections between the two nodes, deselect the check boxes for
the exits that you want to disconnect.

3. Click Done.

Searching for Feature Nodes in the CPE Canvas
You can search the CPE canvas for feature nodes that are unconfigured or for feature nodes
that match you search criteria. An unconfigured feature node is a feature node that meets any
of the following conditions:

• It has no incoming connections

• It has one or more exit ports that are not connected to another feature node

• It contains invalid configuration data

• It has not been saved (the feature node is red)

Note: Unconfigured feature nodes are automatically listed in the Issues tab.

Tip: To locate a feature node on the canvas that is listed in the search results, pass the mouse
pointer over the feature node name in the search results. The CPE highlights the node in green
in the search results and in your control plan on the canvas.
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Searching for Unconfigured Feature Nodes
To search for feature nodes that are unconfigured, select Unconfigured Nodes from the list
next to the Search Canvas field. The CPE displays a list of the unconfigured nodes in the
search results panel.

Tip: The CPE automatically updates the search results by removing nodes from the list as you
configure them.

Searching for Feature Nodes Based on Search Criteria
The CPE searches on all feature node properties by default.

To search for feature nodes in the CPE canvas that match your search criteria:

1. (Optional) From the list next to the Search Canvas field, select one of the following
options:

• A feature node property, such as Name or Type, to search for feature nodes with that
specific property.

• Parameters to search for feature nodes that have certain configuration parameters.

• Geo Routing to search for feature nodes that route a specified number or number
prefix through a non-default exit branch of the Geographical Routing feature node.

Note: You configure the default exit branch when you configure the Geographical
Routing feature node.

2. In the Search Canvas field, enter the search criteria. To search:

• Feature node properties, enter the property details.

• Parameters, enter the parameter name.

• Geo-routing, enter the geo-routing number prefix and press Enter.

The CPE lists the matching feature nodes in the search results panel.

Tips:

• To clear your search criteria and the search results, click the  icon in the Search
Canvas field.

• Select a feature node in the search results panel to display information about the feature
node in the node inspector panel.

Reloading Customer Data
Customer data is data that you or another administrator configure in the ACS UI, such as
geography sets and announcements sets.

You should periodically reload customer data from the database to ensure that your control
plan feature nodes contain the most current data. If you or another administrator update
customer data in the ACS UI while you are working on your control plans, that data is only
available after you reload it.

For example, if you updated an announcement set, then reload customer data to make the
changes available in the CPE.

To reload customer data, select Reload Customer Data from the Tools menu.
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Printing Control Plans
You can print a control plan using the standard dialog for your operating system or by using the
postscript dialog.

Printing a Control Plan by Using the OS Dialog
To print a control plan by using the standard dialog for your operating system:

1. Open the control plan to print.

2. From the File menu, select Print and then Sun Dialog.

The print dialog box for your operating system opens.

Note: The Sun print dialog defaults to the standard dialog for the current operating system.

3. Configure the printing options as required.

4. Click Print.

Printing a Control Plan by Using the Postscript Dialog
To print a control plan by using the postscript dialog:

1. Open the control plan to Print.

2. From the Filemenu, select Print and then Postscript Dialog.

The Print Control Plan dialog box appears.

3. Configure the printing options as required, noting the following:

• The print command on a Windows system is "print" where a print command exists. If
you have difficulty, see you system administrator.

• In the Print command options, enter the port of the target printer. The default port is
lpt1. If lpt1 is not mapped to the appropriate printer, see your system administrator to
set the correct mapping.

• The margin widths are measured in printer's points, which is approximately 1/72 inch.

• The Scale field is currently not used.

• If the Fit to page check box is selected, the control plan is printed in proportion to its
appearance on the screen.

4. Click Print.

Tip: To end a print job after it has started printing, click Cancel in the print progress dialog.

Keyboard Shortcuts
The CPE provides the following keyboard shortcuts in addition to the standard shortcuts for
copying, cutting, and pasting:

• Keyboard shortcuts for using the CPE

• Keyboard shortcuts for adding feature nodes

• Keyboard shortcuts for navigating feature node configuration windows
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Keyboard Shortcuts for Using the CPE
The shortcut keys work from anywhere in the CPE window unless you have clicked in an area
of the window where you can enter data, such as in a search field.

Here are the shortcut keys for using the CPE.

Action Keys

Exit from the CPE after prompting you to save the existing control plan. Alt + F4

Scroll around the CPE canvas or the feature palette. Arrow keys

Change which feature node is selected. Alt + arrow keys

Select all the valid unconnected exits on a feature node and connect
them to a target feature node.

Alt + drag node exit

Display the Manage Node Exits screen, enabling you to select the exits
to connect. See Selecting the Exits to Connect.

Shift + drag node exit

Select a series of feature nodes. Ctrl + arrow keys

Select the numbered feature node in addition to the feature nodes
currently selected in the CPE canvas

Tip: To select a feature node that has more than one digit, press the
number keys in close succession.

Number keys

Open the configuration window for the selected feature node. Enter

Open the Edit Node Structure dialog box if the number of exits can be
changed for the selected feature node.

Alt + Enter

Select all the feature nodes in the CPE canvas. Ctrl + A

Copy the selected feature nodes. Ctrl + C

Switch the display of feature node parameters on and off. Ctrl + D

Display parameter data for a feature node. Ctrl + right click

Switch the canvas grid on and off. G

Change the feature node title format to the next format in the list. N

Switch the display of the telephony icon on the feature node on and off. T

Display the Save dialog box for exporting a control plan to file. Ctrl + E

Select all the feature nodes found by a canvas search that are listed in
the search results.

Ctrl + F

Clean up the control plan margins and center the control plan in the
CPE canvas.

Ctrl + H

Display the Open dialog box for importing files. Ctrl + M

Clear the existing control plan from the canvas and display a blank
canvas.

Ctrl + N

Open the Open Existing Control Plan dialog box. Ctrl + O

Open the postscript Print Control Plan dialog box. Ctrl + P

Save the current control plan. Ctrl + S

Open the operating system Print dialog box. Ctrl + U

Paste the copied feature nodes to the bottom right of the selected
feature node.

Ctrl + V

Remove the selected feature nodes. Ctrl + X

Display feature nodes on the canvas at their default size. Ctrl + 0 (zero)

Decrease the magnification level (zoom out) of the canvas. Ctrl + - (minus)

Increase the magnification level (zoom in) of the canvas. Ctrl + = (equals)
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Action Keys

Move the control plan around the canvas. Alt + click and drag canvas
background

Keyboard Shortcuts for Adding Feature Nodes
You can add these feature nodes to a control plan using the specified shortcut keys.

Feature Node Keys

Attempt Termination Alt+A

Attempt Terminate to Pending TN Alt+Shift+A

Calling Party Alt+C

Calling Party Category Alt+Shift+C

Proportional Distribution Alt+D

End Alt+E

Geographical Routing Alt+Shift+G

Selection Dependant Routing Alt+M

Play Announcement Alt+P

Disconnect Call Alt+R

Start

Tip: If there is already a Start node in the control plan, pressing this key
combination selects the Start node.

Alt+S

Time of Day Alt+T

Unconditional Termination Alt+U

Unconditional Terminate to Pending TN Alt+Shift+U

Day of Week Alt+W

Day of Year Alt+Y

Insert another copy of the most recently added feature node at the
current location on the canvas.

Alt + double click

Keyboard Shortcuts for Navigating Feature Node Configuration Windows
In the feature node configuration windows, you can navigate around the buttons and fields
using the following keyboard shortcuts:

Action Key Combination

Move to the next field or button. Tab

Move to the previous field or button. Shift+Tab

Move to the next group of fields and/or buttons. Ctrl+Tab

Move to the previous group of fields and/or buttons. Ctrl+Shift+Tab

Activate the selected button or save data entered in a field. Space or Enter

Display any keys that have been assigned to the buttons on a feature
node configuration dialog box. To activate the button, press Alt and the
underlined character.

Alt
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44
Creating and Managing Control Plans

Creating Control Plans
You can create a control plan from a blank canvas or create a control plan from an existing
control plan structure.

Creating a Control Plan from a Blank Canvas
When creating a control plan from a blank canvas, you can configure feature nodes as you add
them to the control plan or any time after adding them.

To create a new control plan from a blank canvas:

1. From the Control Plan Editor File menu, select New.

The CPE displays a new control plan in the canvas, consisting of a single Start node.

2. Locate the feature nodes in the feature palette that you want to add to the control plan and
drag them to the canvas.

Tips:

• To quickly find a feature node, enter search criteria for the feature node in the Search
Palette field.

• You can copy and paste feature nodes from another control plan. The feature node
configuration will also be copied.

3. Position the feature nodes to define the service-logic and then connect them by dragging
lines from the exits on each feature node to the next feature node or nodes in the control
plan.

Note: All feature node exits must be connected before the control plan is valid.

4. Configure the feature nodes in the control plan. For each feature node, perform the
following steps:

a. Open the feature node configuration dialog box by doing one of the following:

• Double-click the feature node.

• Right-click the feature node and select Edit Node Data.

• Click the Edit Node Data button for the feature node in the search results or in the
node inspector panel.

b. Enter the configuration data required by the control plan. For information on the
configuration fields click the Help button in the feature node configuration dialog box.

c. Click Save.

Note: You must configure all the feature nodes to complete the control plan.

5. Verify that the control plan is complete.

a. Click the check mark button on the toolbar:
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The Check Report dialog box appears, displaying a message that verifies whether or
not the control plan is complete.

b. Click OK.

c. If the control plan is complete, proceed to the next step. If the control plan is not
complete, complete the control plan before proceeding to the next step.

Tip: On the canvas, unconfigured feature nodes are colored pink. To find all unconfigured
feature nodes, select Unconfigured nodes from the search canvas list.

6. Click the Save button in the tool bar or select Save from the File menu.

The Save Data/Structure dialog box appears.

7. In the Plan Structure field, enter a unique name for the control plan structure.

8. In the Control Plan Data field, enter a name for the control plan data:

• If you want to reuse the control plan structure with different set of data, give the data a
unique name.

• To make the control plan a global service control plan, give the control plan data the
name Global Screeningservice_name, where service_name is the name of the
service to which the control plan applies. For example, Global Screening ACS. The
service name must correspond to the service name defined in the acs.conf
configuration file for the appropriate application.

9. (Optional) In the MF Identifier field, specify an MF identifier of up to eight digits for the
control plan.

Note: You use the MF identifier in the Activate Control Plan feature node in dial-up
management control plans such as the ACS Management control plan.

10. (Available only to ACS administrators with privilege level 6 or 7.)

To make the control plan structure a public control plan structure, select the Public
Structure check box.

11. (Optional) If you want the structure to appear as a template in the ACS Numbers window,
select the Show In Template Grid check box.

12. (May not be available to all users.)

If the control plan is to be invoked by a third party or imported through WSDL, select the
WSDL operation from the Generate WSDL for operation list.

13. Click Save.

The CPE validates, compiles, and then saves the new control plan. For information about
control plan validation, see Validating Control Plans.

Related Information

• For information about simultaneously connecting multiple node exits from a source feature
node to a target feature node, see Connecting Feature Nodes.

• For information about deleting connections between feature nodes, see Deleting a Feature
Node Connection.

• For more information about control plans, see CPE User's Guide.

Chapter 44
Creating Control Plans

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 2 of 14



• For information about viewing a control plan WSDL file in the OSD Operations tab, see
OSD User's and Technical Guide.

• For information about importing a control plan WDSL file into DAP, see DAP User's Guide.

• For information about control plan templates, see ACS User's Guide.

Creating a Control Plan from an Existing Structure
You can use an existing control plan structure to create a new control plan. You can also
modify the existing structure and save it as a new structure.

For information about control plan structure and data, see About Control Plan Structures and
Data.

To create a new control plan from an existing control plan structure:

1. From the Control Plan Editor File menu, select New Plan from Existing Structure.

The New Control Plan From Existing Structure dialog box opens, displaying a list of all
control plan structures.

Note: You may restrict the list of control plan structures by using the search and filtering
functions. You may perform steps 2 and 3 in either order.

2. (Optional) You can restrict the list by searching for existing structure names containing
specific characters to use:

• Use the Control Plan Name and enter initial characters of the structure name or
combine with % (match on any number of characters), or _ (match on a single
character).

Examples:

Search for e%SMS will find all structure names beginning with e and containing SMS.

Search for e_han%SMS will find all structure names beginning with e, containing the
string han in positions 3 to 5, and containing SMS.

• The list can be further restricted by entering a maximum number of names to show in
the Max Rows field.

Click the Search button.

3. (Optional) Filter the list of available control plan structures:

• From the Structure Status options, select one of the following:

– Show All Regardless Of Structure Status to list all control plan structures

– Show Only Public to list only public control plan structures

– Show Only Private to list only private control plan structures

• From the Availability Status options, select one of the following:

– Show All Regardless Of Availability Status to list all control plan structures

– Show Only Saved with errors to list only control plan structures for
unsuccessfully compiled control plans

– Show Only Saved without errors to list only control plan structures for
successfully compiled control plans

4. Select the required control plan structure in the list.

5. If you will be editing the control plan structure then deselect the Open Structure as Read-
Only check box.
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6. Click Open.

The CPE displays the control plan structure in the canvas.

7. If you opened the control plan structure for editing, then update the structure as required
by adding or deleting feature nodes.

8. Edit the configuration for the feature nodes in the control plan as required. For each feature
node, perform the following steps:

a. Open the feature node configuration dialog box by doing one of the following:

• Double-click the feature node.

• Right-click the feature node and select Edit Node Data.

• Click the Configure button for the feature node in the search results or in the node
inspector panel.

b. Enter the configuration data required by the control plan. For information on the
configuration fields, click the Help button in the feature node configuration dialog box.

c. Click Save.

Tip: To quickly find a feature node in the control plan, enter search criteria for the feature
node in the Search Canvas field.

9. Verify that the control plan is complete.

a. Click the check mark button on the toolbar:
 

 

The Check Report dialog box appears, displaying a message that verifies whether or
not the control plan is complete.

b. Click OK.

c. If the control plan is not complete, complete it before proceeding to the next step.

Tip: On the canvas, unconfigured feature nodes are colored pink. To find all unconfigured
feature nodes, select Unconfigured nodes from the search canvas list.

10. Click the Save button in the tool bar or select Save from the File menu.

The Save Data/Structure dialog box appears.

11. If you changed the control plan structure, then in the Plan Structure field, enter a unique
name for the control plan structure.

Important: If you change the control plan structure and then save the control plan
structure with the same name, any other control plans linked to this structure will be
invalidated.

12. In the Control Plan Data field, enter a name for the control plan data:

• If you changed the control plan structure, or if you did not change the control plan
structure and you want to reuse it with different set of data, give the data a unique
name.

• To make the control plan a global service control plan, give the control plan data the
name Global Screeningservice_name, where service_name is the name of the
service to which the control plan applies. For example, Global Screening ACS. The
service name must correspond to the service name defined in the acs.conf
configuration file for the appropriate application.
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Important: If you change the control plan data and then save the control plan data using
an existing name, this version of the data will be overwritten.

13. (Optional) In the MF Identifier field, specify an MF identifier of up to eight digits for the
control plan.

Note: You use the MF identifier in the Activate Control Plan node in dial-up management
control plans such as the ACS Management control plan.

14. (Available only to ACS administrators with privilege level 6 or 7.)

If you changed the control plan structure and want to make the structure a public control
plan structure, select the Public Structure check box.

15. (Optional) If you want the structure to appear as a template in the ACS Numbers window,
select the Show In Template Grid check box.

16. (May not be available to all users.)

If the control plan is to be invoked by a third party or imported through WSDL, select the
WSDL operation from the Generate WSDL for operation list.

17. Click Save.

The CPE validates and compiles the new control plan, and then saves it. For more
information about control plan validation, see Validating Control Plans.

Related Information

• For information about simultaneously connecting multiple node exits from a source feature
node to a target feature node, see Connecting Feature Nodes.

• For information about deleting connections between feature nodes, see Deleting a Feature
Node Connection.

• For more information about control plans, see CPE User's Guide.

• For information about viewing a control plan WSDL file in the OSD Operations tab, see
OSD User's and Technical Guide.

• For information about importing a control plan WDSL file into DAP, see DAP User's Guide.

• For information about control plan templates, see ACS User's Guide.

Adding Sub-control Plans to a Control Plan
A sub-control plan is a control plan that is processed as part of the main control plan. When the
sub-control plan finishes processing the session data, it passes the session data back to the
main control plan to continue processing.

To add a sub-control plan to a control plan:

1. Open the control plan for which you want to add a sub-control plan if it is not open already.

Important: Because you will be modifying the control plan structure, ensure you deselect
the Open Structure as Read-Only check box in the Open Existing Control Plan dialog
box.

2. In the feature palette, open the Others group of feature nodes and click and drag a Load
Sub Control Plan feature node to the canvas.

3. Double-click the Load Sub Control Plan feature node icon.

The Configure Load Sub Control Plan window opens.

4. From the list next to the View button, select the control plan you want to run as a sub-
control plan.
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5. Click Save.

The Configure Load Sub Control Plan window closes and you are returned to the control
plan in the canvas.

6. Connect the Load Sub Control Plan feature node to other feature nodes in the service-logic
where you want the sub-control plan to be triggered.

Related Information

• For more information about the Load Sub Control Plan feature node, see Convergent
Charging Controller Feature Nodes Reference Guide.

• For information about connecting feature nodes, see Connecting Feature Nodes.

• For more information about sub-control plans, see CPE User's Guide.

Adding Comments to a Control Plan
You can annotate a control plan with comments so that other users can quickly see what the
control plan does. You add comments to control plans by using Control Plan Notes.

Note: You do not connect Control Plan Notes to feature nodes in the service-logic.

To add a comment to a control plan:

1. In the feature palette, open the Base group of feature nodes and click and drag the
Control Plan Notes icon to the canvas. Place the note where you want the comment to
appear.

2. Double click the note box.

The Edit Comments dialog box appears.

3. Type your comment in the text area, and click OK.

Validating Control Plans
When you save a control plan, it is automatically validated and compiled if there are no errors.

To successfully compile a control plan, all the feature nodes in the control plan must contain
valid configuration data and all the feature node exits must be connected.

A control plan can be saved with errors if it contains either unconnected exits or if a feature
node in the control plan has been configured with invalid data. Control plans saved with errors
have the status "E".

Only successfully compiled control plans that do not contain errors may be assigned to a
service, and used to provide service-logic. Successfully compiled control plans have the status
"S".

Note: If you opened the control plan structure or the control plan data as Read-Only, the read-
only part will not be compiled or saved because it contains no changes.

When you save a control plan, the compiler compiles the control plan structure first, and then
the control plan data. If the compiler finds any errors in the control plan structure, then the
control plan data will not compile. You must fix the errors and try again.
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Saving a Control Plan with Errors
If you save a control plan and it contains an unconfigured feature node, the following message
is displayed in an Information dialog box

Information, Node NodeNumber is not configured.

Where NodeNumber is the number of the unconfigured feature node. You can click:

• Cancel to close the Information dialog box.

• Delete to delete the unconfigured feature node.

• Configure to open the configuration window for the feature node.

• Save Anyway to save the control plan with errors.

Saving a Control Plan with Warnings
If you save a control plan and it contains a feature node with warnings, the following message
is displayed in an Information dialog box

This plan has one or more warnings

You can click:

• Cancel to close the Information dialog box.

• Attempt Compile to compile the plan.

• Save Only to save the control plan without compiling it.

Viewing the Compiler Build Report
The compiler displays the progress of the compilation, and whether the compile succeeded or
failed.

Modifying Control Plans
Modify a control plan to edit the control plan structure, or the control plan data, or both.

Modifying a Control Plan
To modify a control plan:

1. From the Control Plan Editor File menu, select Open.

The Open Existing Control Plan dialog box opens, displaying a list of all control plans.

Note: You may restrict the list of control plans by using the search and filtering functions.
You may perform steps 2 and 3 in either order.

2. (Optional) You can restrict the list by searching for control plan names containing specific
characters:
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• Use the Control Plan Name and enter initial characters of the control plan name or
combine with % (match on any number of characters), or _ (match on a single
character).

Examples:

Search for e%SMS will find all structure names beginning with e and containing SMS.

Search for e_han%SMS will find all structure names beginning with e, containing the
string han in positions 3 to 5, and containing SMS.

• The list can be further restricted by entering a maximum number of names to show in
the Max Rows field.

3. Click the Search button.

4. (Optional) Filter the list of available control plans:

• From the Structure Status options, select one of the following:

– Show All Regardless Of Structure Status to list all control plans

– Show Only Public to list only public control plans

– Show Only Private to list only private control plans

• From the Availability Status options, select one of the following:

– Show All Regardless Of Availability Status to list all control plans

– Show Only Saved with errors to list only unsuccessfully compiled control plans

– Show Only Saved without errors to list only successfully compiled control plans

5. In the list of control plans, select the control plan to modify.

6. If you will be editing the control plan structure then deselect the Open Structure as Read-
Only check box.

7. Click Open.

The CPE displays the control plan in the canvas.

8. If you opened the control plan structure for editing, add and delete feature nodes as
required.

9. Connect exits to and from any unconnected feature nodes you added to the control plan.

10. Edit the configuration for the feature nodes in the control plan as required. Double click the
feature node to open its configuration dialog box.

11. Verify that the control plan is complete.

a. Click the check mark button on the toolbar.

The Check Report dialog box appears, displaying a message that verifies whether or
not the control plan is complete.

b. Click OK.

c. If the control plan is complete, proceed to the next step. If the control plan is not
complete, complete the control plan before proceeding to the next step.

Tip: On the canvas, unconfigured feature nodes are colored pink. To find all
unconfigured feature nodes, select Unconfigured nodes from the search canvas list.

12. Click the Save button in the tool bar or select Save from the File menu.

The Save Data/Structure dialog box appears.
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13. If you changed the control plan structure and you don't want to overwrite the original
structure, then in the Plan Structure field, enter a unique name for the control plan
structure.

Important: If you change the control plan structure and then save the control plan
structure with the same name, any other control plans linked to this structure will be
invalidated.

14. If you do not want to overwrite the original control plan data, then in the Control Plan Data
field, enter a new name for the control plan data.

15. (Optional) In the MF Identifier field, specify an MF identifier of up to eight digits for the
control plan.

Note: You use the MF Identifier in the Activate Control Plan node in dial-up management
control plans such as the ACS Management control plan.

16. (Available only to ACS administrators with privilege level 6 or 7.)

If you changed the control plan structure and want to make the control plan structure a
public control plan structure, select the Public Structure check box.

17. (Optional) If you want the structure to appear as a template in the ACS Numbers window,
select the Show In Template Grid check box.

18. (May not be available to all users.)

If the control plan is to be invoked by a third party or imported through WSDL, select the
WSDL operation from the Generate WSDL for operation list.

19. Click Save.

The CPE validates, compiles and then saves the control plan. For more information about
control plan validation, see Validating Control Plans.

Related Information

• For more information about configuring a specific feature node, click the Help button in the
feature node's configuration window.

• For information about finding feature nodes in the control plan, see Searching for Feature
Nodes in the CPE Canvas.

• For information about simultaneously connecting multiple node exits from a source feature
node to a target feature node, see Connecting Feature Nodes.

• For information about deleting connections between feature nodes, see Deleting a Feature
Node Connection.

• For information about deleting a feature node, see Removing Feature Nodes from a
Control Plan

• For more information about control plans, see CPE User's Guide.

• For information about viewing a control plan WSDL file in the OSD Operations tab, see
OSD User's and Technical Guide.

• For information about importing a control plan WDSL file into DAP, see DAP User's Guide.

• For information about control plan templates, see ACS User's Guide.

Adding Feature Node Comments
You can add comments of up to 2000 characters in length for each feature node in the control
plan.
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To add a comment to a feature node.

1. Open the Comments dialog box by doing one of the following:

• Double click the feature node to open its configuration dialog box and click the
Comments button.

• Click the Comments button that appears when you place the mouse pointer over the
feature node in the search results panel or the node inspector panel:
 

 

2. Type a comment for the feature node.

3. Click Save.

Removing Feature Nodes from a Control Plan
When you remove a feature node from a control plan, the CPE also deletes all the connections
to and from the feature node.

To remove one or more feature nodes, select the feature nodes you want to remove, and click
the Delete button on the toolbar:
 

 

Deleting Control Plans
You can delete the following:

• Control plans that are inactive. A control plan is inactive until it is activated by assigning it
to a Service Number or CLI. When you delete an inactive control plan, the CPE deletes
only the control plan data; it does not delete the control plan structure. See Deleting an
Inactive Control Plan.

• Control plan structures that are unused. A control plan structure is unused if it does not
have any control plan data records linked to it. See Deleting an Unused Control Plan
Structure.

For more information on control plan structures and data, see About Control Plan Structures
and Data.

Deleting an Inactive Control Plan
To delete an inactive control plan:

1. From the Control Plan Editor File menu, select Delete Data.

The Delete Non-Active Control Plan dialog box opens, listing the inactive control plans.

Note: You may restrict the list of control plans by using the search and filtering functions.
You may perform steps 2 and 3 in either order.

2. (Optional) You can restrict the list by searching for existing control plan names containing
specific characters to use:

Chapter 44
Deleting Control Plans

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 10 of 14



• Use the Control Plan Name and enter initial characters of the structure name or
combine with % (match on any number of characters), or _ (match on a single
character).

Examples:

Search for e%SMS will find all structure names beginning with e and containing SMS.

Search for e_han%SMS will find all structure names beginning with e, containing the
string han in positions 3 to 5, and containing SMS.

• The list can be further restricted by entering a maximum number of names to show in
the Max Rows field.

3. Click the Search button.

4. (Optional) Filter the list of control plans available for deletion:

a. In the Structure Status section, select the control plan structure status to display only
control plans with the selected status.

b. In the Availability Status section, select the control plan availability status to display
only control plans with the selected status.

5. In the control plan list, select the control plan to delete.

Tip: Use the Shift or Ctrlkey when selecting control plans to select multiple control plans.

6. Click Delete.

A confirmation message is displayed.

7. Click OK.

The Delete Non-Active Control Plan dialog box closes and the control plan data record for
the selected control plan is deleted.

Note: The CPE does not delete the control plan structure.

Deleting an Unused Control Plan Structure
To delete an unused control plan structure:

1. From the Control Plan Editor File menu, select Delete Structure.

The Delete Unused Structure dialog box opens, listing the control plan structures that have
no control plan data linked to them.

Note: You may restrict the list of control plan structures by using the search and filtering
functions. You may perform steps 2 and 3 in either order.

2. (Optional) You can restrict the list by searching for existing structure names containing
specific characters:

• Use the Control Plan Name and enter initial characters of the structure name or
combine with % (match on any number of characters), or _ (match on a single
character).

Examples:

Search for e%SMS will find all structure names beginning with e and containing SMS.

Search for e_han%SMS will find all structure names beginning with e, containing the
string han in positions 3 to 5, and containing SMS.

• The list can be further restricted by entering a maximum number of names to show in
the Max Rows field.
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3. Click the Search button.

4. (Optional) Filter the list of control plan structures available for deletion:

a. In the Structure Status section, select the control plan structure status to display only
control plans with the selected status.

b. In the Availability Status section, select the control plan availability status to display
only control plans with the selected status.

5. In the control plan structure list, select the structure to delete.

6. Click Delete.

A prompt giving the number of feature nodes in the control plan is displayed.

7. Click OK.

The Delete Unused Structure dialog box closes and the control plan structure is deleted.

Importing and Exporting Control Plans

About Importing and Exporting Control Plans
Export a control plan to a file to save the control plan so that you can import it into another
database or to the same database but for another customer.

When you export a control plan, you create a .cpl text file. You can open and edit a .cpl file
using any plain text editor. A summary of the control plan is provided at the beginning of the
file. To add a comment to the text, start the line with a “#” character.

Additionally, you can export a control plan to an image file. The supported formats are PNG,
JPEG, and GIF. The default format is PNG.

For more information about saving and compiling control plans, see Validating Control Plans.

Exporting a Control Plan to File
To export a control plan to a file:

1. From the Control Plan Editor File menu, select Open.

The Open Existing Control Plan dialog box opens.

2. (Optional) Filter the list of available control plans:

a. In the Structure Status section, select the control plan structure status to display only
control plans with the selected status.

b. In the Availability Status section, select the control plan availability status to display
only control plans with the selected status.

3. In the control plan list, select the control plan you want to export and click Open.

The control plan is displayed in the canvas.

4. From the File menu, select Export to file.

The Save dialog box opens.

5. Navigate to the folder where you want to save the control plan.

6. In the File name field, enter the control plan name.
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The CPE saves the control plan to the specified file name, and adds a text-based summary
of the control plan to the beginning of the file.

7. Click Save.

Control Plan Export and Import Validation
When a control plan is exported on one SMS and then imported into another, you are exposed
to the probable database differences between the two environments, because the exported
parameter format of many CPE feature nodes makes explicit reference to database ID values.

During the export process, most of database IDs used within feature nodes are translated to a
plain text name. When imported in to the new environment, these names are then associated
with a new database ID within that environment.

Some feature nodes store database IDs inside profile tag selector objects. The exported form
of these nodes cannot be made platform independent. For these feature nodes, on control plan
import, there are warnings in that the plan contains problematic nodes, identifying each one by
number and name.

Importing a Control Plan from File
When you import a control plan for a customer, the customer's feature node set should include
all the feature nodes in the control plan. Otherwise, the CPE displays a warning for each
feature node that the customer does not have, informing you that a specific feature node is not
available, and that the control plan may not be saved with that feature node in it.

To import a control plan from file:

1. From the Control Plan Editor File menu, select Import from file.

The Open dialog box opens.

2. Navigate to the folder containing the control plan file you want to import.

The CPE displays the control plan file in the File name field.

3. Click Open.

The CPE imports the control plan and displays it in the CPE canvas in the Control Plan
Editor window.

The control plan is validated. If any feature nodes contain errors or warnings the Issues
tab, listing the issues, is displayed in the search results panel. All feature nodes containing
issues are colored orange.

4. Resolve any issues identified.

5. Save the control plan.

This compiles the control plan and thus ensures that the control plan is valid for the
customer for whom it has been imported.

Troubleshooting Control Plans Using Control Plan Tracing
The control plan tracing feature of the CPE helps you to locate errors in your control plan by
finding which feature nodes in the control plan are referenced during service-logic processing.
You typically copy data from a CDR to use in the control plan trace.

For more information about control plan tracing, see CPE User's Guide.
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Tracing a Control Plan
To trace the feature nodes referenced in a session:

1. If necessary, open the control plan applicable to the trace you want to perform.

Note: If you want to modify the control plan structure, deselect the Open Structure as
Read-Only check box in the Open Existing Control Plan dialog box.

2. From the drop down list next to the canvas search field, select the Control Plan Trace
search type.

3. In the search field, type the control plan trace string, or copy and paste it from a text file
such as a CDR. The control plan trace string must have the following format:

fastkey-number,fastkey-number,fastkey-number,fastkey-number, ...

Where:

• fastkey is the short code used by the CPE for the feature node. For example, AT is
the Attempt Termination feature node fast key.

• number is the number assigned to a feature node in the control plan. This number
identifies the required feature node when the same type of feature node occurs more
than once in the control plan.

Note: The CPE will automatically perform a control plan trace if you enter a search value
that starts with "ST-". ST is the fast key for the Start feature node, and using this value
implies a control plan trace.

The feature nodes referenced in the trace are highlighted in the control plan, and are listed
in the search results.

4. To clear the control plan trace string, in the search field click the X icon:
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45
Feature Nodes and Feature Sets

This chapter explains how to select feature nodes for use in control plans.

A control plan consists of multiple different decision points or actions. These decision points
are represented graphically by symbolic icons known as “feature nodes”. Control plans are
constructed using the ACS Control Plan Editor.

This chapter contains the following topics.

Adding Feature Sets

Adding Feature Sets
The ACS Configuration screen enables feature sets to be maintained. A feature set is a
convenient way of grouping feature nodes.

Customers are allocated one or more feature sets. The feature nodes from those feature sets
can be used in any control plan the customer creates. Only the feature nodes available in the
feature sets assigned to a customer will be displayed on the control plan feature palette in the
Control Plan Editor for that customer.

Feature sets are created and maintained by the system administrator. Therefore, this screen is
only available to the system administrator. The system administrator allocates the feature node
sets maintained in this screen to customers.

It is not possible to delete a feature set that is used in a current customer control plan.

When the Edit button is clicked, the screen will have the check boxes for the nodes that are
currently in the feature node set ticked. If the New button was clicked, a new set may be
created, the Feature Node Set field will be blank and all nodes will be clear.
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46
Nodes in Depth

This chapter lists all the feature nodes that may be available. The actual nodes available are
dependent on the application in which the Control Plan Editor is operating. In some cases,
additional nodes may have been created and installed to fit a specific customer need. These
custom nodes do not appear in this list.

This chapter contains the following topics.

Account Code Entry

Activate Control Plan

Attempt Terminate to Pending TN

Attempt Terminate to Pending TN with Duration

Attempt Termination

Branch on Bearer Type

Branch On Call Forwarding Pending

Branch on Event Report Request BCSM Code

Branch on Indicator

Branch on Protocol

Branch on Service Key

Calculation

Call Filtering

Call Forwarded Branching

Call Initiation

Call Progression

Calling Party

Calling Party Category

Change CDR

Change Ordered Prefix Tree Entry

Check Limitations

Check Prefix Tree Capacity

Collect Date to Tag

Collect Digits to Buffer

Collect Digits to Pending TN
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Collect Digits to Sub-tag

Compare Profile Data

Control Plan Notes

Copy

Copy Hunting List

Create Prefix Tree

Day of Week

Day of Year

Delete Profile Field

Dialled Number

Disconnect Call

Dynamic Switch

End

Event Branching

Event Counting

Event Setting

Geographical Routing

Get Hunting List

Get Hunting Number

Junction

Load Profile

Loop Limit

Modify

NP Destination Selection

NP Home Routing

NP Least Cost Routing

NP Map Trigger

Number Lookup and Translation

Number Matching

Number Normalisation

PIN Authorisation

Play Announcement

Play Ordered Prefix Tree Entry

Play Variable Part Announcement
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Prefix Branching

Prefix Tree Branching

Prefix Tree Entry Extraction

Presence Branching

Profile Branching

Profile Counting

Profile Date Compare

Profile Date Store

Proportional Distribution

Selection Dependent Routing

Send Notification

Send Short Message

Service Handover

Set

Set Carrier Code

Set Cut and Paste

Set Indicator

Set Pending TN from Profile

Set Presence

Set Tariff Code

Sleep

Start

Statistic

Statistic Increment

Sub Control Plan

Table Lookup

TCAP Handover

Terminate to Pending TN

Terminate Unchanged

Test Pending TN Type

Time of Day

Transmission Type Branching

Unconditional Termination
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Account Code Entry
The Account Code entry node prompts for an account number to be entered and collects the
digits. Collected digits are placed in the Account Code buffer.

The access code entered by the caller is added to the Call Data Record.

Account Codes are also known as access codes. You can set the access code policy for
service numbers and CLIs in ACS.

Note: Depending on the Access Code Policy that is selected for the Service Number or CLI,
the account code entered using this node may be one of:

• Not required

• Required and verified

• Required and not verified

See Service Number and CLI New Numbers fields, accessed from the ACS Numbers screen,
for details about Access Mode Management and Access Code Policy.

Node exits – Account Code Entry
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The Account Code was entered
and collected successfully.

2 Not Allowed The Account Code entered is
invalid.

3 Abandoned The Account Number or Code
entered was not found by the
system.

Configuring the node – Account Code Entry
Follow these steps to configure the Account Code Entry node, to set or amend the Main
Account Number Announcement.

1. The main announcement is the announcement that will be played to prompt for an Account
number.

In the Main Announcement area, select the Announcement Set which contains the main
announcement you want to play to the caller.

Result: The Announcement Entry field becomes available.

2. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.

3. Set the Repetition field to the number of times you wish to repeat the announcement, by
increasing or decreasing the value in the spin box. The allowable values are from 1
(default) to 127. If set to zero, the announcement will be repeated for the length of the
duration set.
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4. Set the Duration field to the length of time in seconds that the announcement is to be
played. The allowable values are from 0 (default) to 32767. If set to zero, the
announcement will be played for its full length.

5. Amending the Retry announcement on Invalid Entry.

The retry announcement will be played if the Account Number entered after the main
announcement is not valid.

In the Retry Announcement area, select one of the following as described in steps 1 - 4:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

6. Set the Number of Retries field to the number of times that the node will attempt to collect
the correct Account Number from the caller, before routing the call to the Not Allowed
branch. This value may be between 0 and 10.

7. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Activate Control Plan
This node enables a caller to schedule a control plan using a touch tone phone. It should be
used as part of an IVR control plan (for example, the ACS Management Control Plan).

The caller specifies which control plan to schedule by entering the control plan's control plan ID
(that is, MF Identifier). The node can also be set up to enable the caller to specify the time and
date the control plan will become active. If a time is not specified, the control plan becomes
active immediately.

The control plan can be scheduled against either an SN or CLI according to the following rules:

• If the Load Profile node most recently triggered in the control plan loaded an SN or CLI
profile, the control plan will be scheduled against a number of the same type.

• If neither the SN not CLI profile has been loaded, the node will schedule against the type of
number specified in the pending TN type buffer.

For more information about:

• MF Identifier, see MF Identifier.

• Pending TN type buffer, see Pending termination number variables.

Node exits – Activate Control Plan
This node has one entry and three exits. The number of exits cannot be changed.
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Exit Cause Description

1 Success The control plan was activated
successfully.

2 Not Updated There was a problem with
activating the control plan.

In addition to other possible
faults, this exit is taken if the
node cannot establish whether to
schedule the control plan against
an SN or a CLI.

3 Abandoned The caller abandoned the call.

Configuring the node – Activate Control Plan
Follow these steps to configure the Activate Control Plan node.

1. From the Main Announcement area, select the Announcement Set which contains the
main announcement you want to play to the caller. The main announcement will be played
to prompt for a Control Plan ID (MF identifier).

Result: The Announcement Entry field becomes available.

2. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

4. Set the Duration field to the length of time, in seconds, that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

5. The retry announcement contains the announcement you want to play to the caller if an
invalid ID is entered after the main announcement.

In the Retry Announcement area, select one of the following as described in steps 1 - 4:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be played

6. Set the Number of Retries field to the number of times that the node will attempt to collect
the correct ID from the caller, before routing the call to the Not Updated branch. This value
may be between 0 and 10.

7. If you:

• want to prompt the caller to set an activation date, tick the Prompt for Activation
Time? check box.

• do not want to prompt the caller to set an activation date, go to step 11.

8. From the Timezone Type drop-down list, select the timezone you want to use.

If you select the Explicit Unix TZ option, you need to select a specific region from the Unix
Timezone field.

For more Time zone information, see Time Zones.
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9. The Date Announcement area contains the announcement you want to play to the caller.
Select one of the following as described in steps 1 - 4:

• Date Announcement Set which contains the main announcement

• Date Announcement Entry for the main announcement you want to play, and set the

• Repetition to the number of times to repeat the announcement

• Duration to the length of time, in seconds, that the announcement is to be played.

10. The Retry Date Announcement area contains the announcement you want to be repeat
while the system waits for the caller to take an action. Select one of the following as
described in steps 1 - 4:

• Date Announcement Set which contains the retry announcement

• Date Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the announcement

• Duration to the length of time, in seconds, that the announcement is to be played.

11. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Example use of Activate Control Plan node
Here is an example of using the Activate Control Plan Node to activate a Control Plan for a
Service Number or CLI.

For detailed information on the ACS Management Control Plan, see the chapter - Dial-up
Control Plan Management in ACS.

1. A customer is set up with an 0800 number and the self management screens.

2. The customer creates 2 control plans.

3. The customer phones a number attached to the ACS management control plan to change
which control plan is active for the number.

Here is an example of a Configure Activate Control Plan screen in ACS management control
plan that does this. See the ACS Management Control Plan example in ACS User's Guide to
see the entire control plan.
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In this example, the caller is prompted to enter the:

• Control Plan ID (MF Identifier) and the

• Date to activate the Control Plan.

Attempt Terminate to Pending TN
The Attempt Terminate to Pending TN node attempts to terminate to the number currently held
in the PendingTN variable.

For information about the PendingTN variable, see Pending termination number variables.

Shortcut keys – Attempt Terminate to Pending TN
The shortcut keys to add an Attempt Termination to Pending TN node are Alt+Shift+A

Node exits – Attempt Terminate to Pending TN
This node has one entry and six exits. The number of exits cannot be changed.

Some nodes require telephony (that is, Play Announcement, Unconditional Termination,
Disconnect, Attempt Termination, Selection Dependant Routing, Unconditional Terminate to
Pending TN). Such nodes may follow Exits 2 and 3 of the Attempt Terminate to Pending TN
node. They may not follow exits 1, 4, 5 and 6.

Chapter 46
Attempt Terminate to Pending TN

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 8 of 124



Exit Cause Description

1 Success The call was successfully
connected to the specified
termination number.

2 Busy The Termination Number held in
the Pending TN Buffer was busy
(that is, in use), so the call was
routed to Exit 2.

3 No Answer The call was routed to the
Termination Number specified in
the Pending TN Buffer and that
phone rang for the specified
Timeout time and then was
routed down Exit 3.

4 Abandoned The person placing the call hung
up, so the call was routed to Exit
4.

5 Abort The call will be sent to this exit in
the case of network failure.

6 Routing Failure Due to congestion, the call was
forwarded to this exit.

Configuring the node – Attempt Terminate to Pending TN
Follow these steps to configure the Attempt Terminate to Pending TN node.

1. From the National/International Prefix Location drop down lists, select the profile Data
Type and Location to read Least Cost Routing configuration from.

The location list displays all available fields for the data type selected.

For more information about profile blocks, see Profile Blocks and Tags.

If you do not want to use Least Cost Routing on this destination number, select:None
Selected.

2. You must set the Timeout value for the node. This is the number of seconds that is
allowed to pass before the call is routed down the No Answer branch. The Timeout value
may be between 0 and 180 seconds.

3. Click Save.

Attempt Terminate to Pending TN with Duration
This node is used to connect the call up to a maximum duration and without charging the
caller, for example connecting to a subscription weather service announcement.

Node exits – Attempt Terminate to Pending TN with Duration
This node has one entry and eight exits. The number of exits cannot be changed.

Note: These exit descriptions are specific to the responses received from an Oracle VWS
billing engine. For specific information about how responses from other billing engines map to
these exits, see the technical guide for the interface for billing engine being used.
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Exit Cause Description

1 Busy The Destination Party was busy
and the call could not be
connected.

2 No Answer Destination Party did not answer.

3 RS Failure Route Select Failure. The
network could not connect the
Caller to the Destination Party.

4 Disconnect A-Party The Caller hangs up to end the
call.

5 Disconnect B-Party The Destination Party hangs up
to end the call.

6 Abort The call was terminated at some
time during the processing of this
node.

7 Abandon The call was abandoned.

8 Node Error General case for an un-handled
state in this node.

Configuring the node – Attempt Terminate to Pending TN with Duration
Follow these steps to configure the node.

1. In the No Answer Timeout field, specify the number of seconds the switch should wait for
the called party to accept the connection before assuming there was no answer. Value
range: 0-2047

2. In the Maximum Call Duration field, specify the maximum number of 'deci-seconds'
before the call is disconnected.

3. Tick Record Call in CDR if you wish to generate a 'Call Information' report at the end of
the call. This call information can then be used in the EDR.
Note: Selecting this option may impact other nodes within this control plan. If the Record
Call in CDR check box is ticked, all subsequent attempt termination nodes will request a
CIR.

4. From the Profile IdentifierData Type and Location drop down lists, select the profile to
read Least Cost Routing configuration from.
The location list displays all available fields for the data type selected.

For more information about profile blocks, see Profile Blocks and Tags.

If you do not want to use Least Cost Routing on this destination number, select None
Selected.

5. Click Save.

Attempt Termination
The Attempt Termination node will attempt to terminate the call to a specified termination
number but, if for some reason cannot terminate it to that number correctly, it takes a branch
determined by the status of the call so that (for example) call diversion can be performed by
the next node.

Termination numbers are specified as ranges of numbers in the ACS Configuration screens.
The numbers shown in the Configure Attempt Termination screen are the ranges of termination
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numbers that have been specified for the logged in customer. If the customer for whom the call
plan is being created is a managed customer, the termination numbers that have not been
specified for the customer may be used in the node.

Note: The Attempt Termination feature node can be set to automatically display the TN as the
feature node name by setting the useTNForNodeName parameter in the acsGui.bat/acsGui.sh
file. If this parameter is set, then you may not manually edit the feature node name. For more
information, see Advanced Control Services Technical Guide.

Shortcut keys – Attempt Termination
The shortcut keys to add an Attempt Termination node are Alt+A.

Node exits – Attempt Termination
This node has one entry and six exits. The number of exits cannot be changed.

Some nodes require telephony (that is, Play Announcement, Unconditional Termination,
Disconnect, Attempt Termination, Selection Dependant Routing, Unconditional Terminate to
Pending TN). Such nodes may follow Exits 2 and 3 of the Attempt Termination node. They may
not follow exits 1, 4, 5 and 6.

Exit Cause Description

1 Success The call was successfully
connected to the specified
termination number.

2 Busy The Termination Number was
busy (that is, in use) so the call
was routed to Exit 2.

3 No Answer The call was routed to the
specified Termination Number,
that phone rang for the specified
Timeout time and then was
routed down Exit 3.

4 Abandoned The person placing the call hung
up, so the call was routed to Exit
4.

5 Abort The call will be sent to this exit in
the case of network failure.

6 Routing Failure Due to congestion, the call was
forwarded to this exit.

Configuring the node – Attempt Termination
Follow these steps to edit the Attempt Termination node.

1. To specify a termination number for the node, select the range in which the number lies
from the ranges shown.

Result: The prefix digits will be entered into the Termination Number entry field.

2. Use the Termination Number entry field to complete the number.

The Xs in the range signify the minimum number of digits that are required and the Ys
signify the maximum number of digits in the range.
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3. Type the number of seconds that the call is to ring at the termination number before it is
routed down the No Answer branch of the node.

4. Click Save to commit that termination number to the node.

Note: The Save button will only become available when a number that is within the
selected range is displayed in the Termination Number entry field.

Branch on Bearer Type
The Branch on Bearer Type (Bearer Capability) node will route calls to different branches
depending on the incoming calling party bearer capability or the high layer characteristic and
the node configuration.

Node exits – Branch on Bearer Type
This node has one entry and may have 4 through 10 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

Node exits 1 through 3 are set by the system and may not be changed.

Exit Cause Description

1 No Match Found No match was found for any rule
in the Bearer Capacity structure
extracted from the Initial
Detection Point.

2 Bearer Not Available The bearer specified in the node
was not available in the Bearer
Capacity structure extracted from
the Initial Detection Point.

3 Error A error occurred.

4 to 10 Exit 4 These exits are followed
depending on the rules attached
to them.

Configuring the node – Branch on Bearer Type
Follow these steps to edit the Branch on Bearer node.

1. Edit the node exits to add exits as required. See Editing node exits for details.

Note: The new number of exits is represented on the node icon, but not on the
configuration screen exit list.

2. Open the Configure Branch on Bearer screen.

Result: The Bearer Type Branching tree lists all the exits that have been added, as in the
example below, showing 7 exits.

By default, Branch 1 and Branch 2 are pre-configured.
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Note: The number of branches to configure will always be the total number of exits
configured, minus the three pre-configured branches. In this example node, there are 7
exits, therefore there are 4 configurable branches.

3. In the Bearer Component frame, select the option on which to branch.

• Layer 1 Protocol -

• Info Transfer Rate -

• Info Tran capability -

• Transfer Mode -

• Coding Standard -

• High Layer Character - matches on Octet 4 of the High Layer Characteristics bearer
field.

4. Branches are made up of rules. A rule is either a range of bearer types or a single value.

The maximum number you can enter in the rules is 256. Before you can add rules to any
other branches, you must edit the rules for Branch 2 (that is, 1-256) and change 256 to the
number appropriate to the branch. This will allow you to add rules to the branches.

To edit a rule, right-click on a rule and click Edit.

Result: The Edit Rules dialog will appear.

To create a rule:

• Of a single value, you can enter the value in the left hand field only, or the same
number in both fields.

• For a range of numbers, enter values in both fields. The 'from' value must be lower
than the 'to' value.

Note: The numbers must not overlap any other rule ranges. Make the change and click
OK.

5. To add rules to a branch, right-click on the branch. From the pop-up menu displayed,
select Add. You see the Add Rules screen.

6. Create the rule as required.

7. Click OK.

Result: One of the following will occur:

• The new rule will be added to the rule list.

• If a rule conflicts with an existing rule, a warning dialog box will appear providing more
detail about the conflict.

Note: You may create as many rules per Branch as you require.

8. Edit or delete rules under each branch.

To delete a rule, right-click on a rule and click Delete.
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Result: The rule is deleted from the branch.

9. When rules have been added to all branches, the Save button will become available.

Click Save.

Result: The node data is saved.

Notes:

• After configuration, you may add or remove exits for the node using Edit Node Exits, then
edit the node branches again.

• If you remove exits, when you open the Configure Branch on Bearer screen again you will
see a warning, such as this example.

Click OK to continue, then edit the node.

Branch On Call Forwarding Pending
The Branch On Call Forwarding Pending node branches depending on whether there is a call
forward pending or not.

This node uses the callForwardingSS-Pending parameter flag to determine which branch to
take. See standard 3GPP TS 29.078, version 5.0.0 for full details.

Node exits – Branch On Call Forwarding Pending
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Pending There is a call forward pending.

2 Not Pending There is not a call forward
pending.

Configuring the node – Branch On Call Forwarding Pending
This node requires no configuration data. You may change the Node name, if required.

Branch on Event Report Request BCSM Code
The BoEC node branches depending on the result of the previous Request Report BCSM
Event operation. The TDP codes that the node recognizes are from these events:

• oDisconnect

• tDisconnect

• oCalledPartyBusy

• tCalledPartyBusy

• RouteSelectFailure

Note: The "o" and "t" indicate Originating and Terminating respectively.
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Node exits – Branch on Event Report Request BCSM Code
This node has one entry and initially five exits. You can manually add up to another five exits,
making a total of 10 exits.

Exit Label Cause

1 No match found The cause code being passed to
the node is not defined in any of
the node's branch rules.

2 Code not available ACS did not pass a cause code
to the node.

3 Error A software error occurred.

4 Call Forwarded ACS has been advised that a
terminating call has been
forwarded.

5 through 10 Exit 5 through Exit 10 Determined by branch rules
specified for the exit.

Note: The call-forwarded exit scenario for this node is identical to that of the Call Forwarded
Branching node. Refer to the section on the Call Forwarded Branching node; in particular the
node exits.

Configuring the node – Branch on Event Report Request BCSM Code
Branches are made up of Cause code rules. A rule is either a range of Event Report Request
BCSM Codes or a single value. Each branch can have as many rules as required, provided
that the cause code has not been configured in another rule within this node.

Cause codes are defined in the following two documents.

• ETS 300 374-1

Intelligent Network (IN):

Intelligent Network Capability Set 1 (CS1);

Core Intelligent Network Application Protocol (INAP);

Part 1: Protocol specification

European Telecommunications Standards Institute

In particular, see EventSpecificInformationBCSM.

• ITU-T Recommendation Q.850

Usage of Cause and Location

in the Digital Subscriber Signalling

System No. 1 and the Signalling

System No. 7 ISDN User Part

International Telecommunications Union

Follow these steps to edit the Branch on ERRB Cause Code node.

1. Edit the node exits to add up to another five exits as required. See Editing node exits for
details.
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Note: The new number of exits is represented on the node icon, but NOT on the
configuration screen exit list.

2. Open the Configure Branch on ERRB Cause Code screen.

Result: The ERRB Cause Code Branching tree lists all the exits that have been added, as
in the example below, showing 7 exits.

Note: The number of branches to configure will always be the total number of exits
configured, minus the 4 pre-configured branches. In this example node, there are 7 exits,
therefore there are 3 configurable branches.

3. To add rules to a branch, right-click on the Branch. From the pop-up menu displayed,
select Add. You see the Add Rules screen.

4. Create the rule as required.

To create a rule:

a. of a single value, you can enter the value in the left hand field only, or the same
number in both fields.

b. for a range of numbers, enter values in both fields. The 'from' value must be lower than
the 'to' value.

Note: The numbers must not overlap any other rule ranges. The maximum value of a rule
is 256.

5. Click OK.

Result: Either:

• the new rule will be added to the rule list, or

• if a rule conflicts with an existing rule, a warning dialog box will appear providing more
detail about the conflict.

Note: You may create as many rules per Branch as you require.

6. Edit or delete rules under each branch. To:

• edit a rule, right-click on a rule and click Edit.

Result: The Edit Rules dialog will appear.

Make the change and click OK

• delete a rule, right-click on a rule and click Delete.

Result: The rule is deleted from the branch.

7. When rules have been added to all branches, the Save button will become available.

Click Save.

Result: The node data is saved.

Note: After configuration, you may add or remove exits for the node using Edit Node Exits,
then edit the node branches again.

If you remove exits, when you open the Configure Branch on Bearer screen again you will see
a warning, such as this example.
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Click OK to continue, then edit the node.

Example of the use of the Branch on Event Report Request BCSM Code
node

For a terminating call, suppose you want to select the following outcomes, depending on the
values of cause numbers.

• If ACS was notified of call-forwarding, you want to play an announcement about call-
forwarding.

• For cause number 1, you want to play an announcement about the telephone number
being unallocated.

• For cause numbers 17 through 20, you want to play an announcement about the telephone
number being either busy, unresponsive, unanswered or unanswerable because the
telephone is switched off.

• For all other cause numbers, you want to simply disconnect the call.

To implement this scenario, you could set up the control plan shown below.

Chapter 46
Branch on Event Report Request BCSM Code

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 17 of 124



You would set up the configurable exits of the branch on ERRB Cause Code node as shown
below.

The non-configurable exit branches would remain as shown below.

Branch on Indicator
The Branch on Indicator node allows you to take an exit based on one of the indicators of a
specified number:

• Number incomplete

• Screening

• Presentation restricted
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Node exits – Branch on Indicator
This node has one entry and five exits. The number of exits cannot be changed.

Exit Cause Description

1 Value 0 Bit value of 0

2 Value1 Bit value of 1

3 Value 2 Bit value of 2

4 Value 3 Bit value of 3

5 Error Error

The interpretation of the value depends on the indicator selected.

Configuring the node – Branch on Indicator
Follow these steps to edit the node configuration.

1. Select the indicator option:

• Presentation Restricted

• Screening

• Number Incomplete

2. Select the number from the drop down list.

• CallingPartyNumber

• AdditionalCallingPartyNumber

• OriginalCalledPartyID

• RedirectingPartyID

• LocationNumber

• LocationInformationLocationNumber

3. Click Save.

Interpretation of values – Branch on Indicator
This table describes the meaning of each value, depending on the indicator selected.

Value Presentation
Restricted

Screening Number Incomplete

0 The presentation is
allowed

User provided, but not
verified

Complete

1 The presentation is
restricted

User provided, verified
and passed

Incomplete

2 The address is not
available

User provided, verify
failed

NA

3 Spare Network provided NA
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Branch on Protocol
The Branch on Protocol node allows you to determine the protocol used by the current call and
branch accordingly.

Node exits – Branch on Protocol
This node has one entry and six exits. The number of exits cannot be changed.

Exit Cause Description

1 CS1 CS1 Protocol

2 Nokia (for future use)

3 CAP 2 CAP 2 protocol

4 CAP 3 or higher CAP 3, or higher, protocol

5 CAP 3 or higher SMS (for future use)

6 Failed to determine Unspecified error

Configuring the node – Branch on Protocol
This node requires no configuration data. You may change the Node name, if required.

Branch on Service Key
The Branch on Service Key (BoSK) feature node compares an ACS IDP service key with a
fixed value configured in the feature node. The feature node routes calls to different branches
depending on the feature node configuration and whether or not a match is found.

You configure the BoSK feature node by allocating a service key number or range of numbers
to each exit. The service key number can have up to 10 digits and must be less than or equal
to 2147483647.

To increase the number of available exits for which you can specify service key numbers and
ranges, edit the feature node structure.

Node exits – Branch on Service Key
This feature node can have between three and ten exits. You can configure the number of exits
within this range as required, using the Edit Node Exits option on the shortcut menu. See 
Editing Feature Node Exits.

Exits 1 and 2 are set by the system and may not be changed by the user.

Exit Cause Description

1 No match found No match was found for the
service key extracted from the
Initial Detection Point.

2 Error The service key rules are
incorrectly configured or an
internal error has occurred.
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Exit Cause Description

3 to 10 Exit 3 These exits are followed
depending on the rules attached
to them.

Configuring the node – Branch on Service Key
Follow these steps to edit the feature node configuration.

1. Edit the number of feature node exits to create one or more additional exits. See Editing
node exits for details.

Note: The new number of exits is represented on the feature node icon, but NOT in the
exit list in the feature node configuration window.

2. Open the Configure Branch on Service Key window.

The Service Key Branching tree displays, listing all the configurable exit branches. This will
be the total number of feature node exits, minus the two pre-configured exits. You
configure the feature node by specifying the branching rules for each exit, where a rule is
either a range of service keys or a single value.

For example, the following diagram shows the service key rules configured for two exit
branches.

3. Add the rules to each branch by performing the following steps:

a. Right-click on the branch, and select Add from the pop-up menu. The Add Rules
dialog displays.

b. Specify the service key values for the rule. To specify:

• A single value, enter the value in the left hand field only, or the same number in
both fields. A service key number can have up to 10 digits and must be less than
or equal to 2147483647.

• A range of numbers, enter values in both fields. The 'from' value must be lower
than the 'to' value.

• Click OK. The rule is added to the list of rules for the selected branch.

If a rule conflicts with an existing rule or the rule is invalid, an Invalid Rule dialog
box appears informing you about the error.

Note: You can add multiple rules to a branch, but you must specify at least one rule for
each branch.

4. To edit a previously configured rule, perform the following steps:

a. Right-click on the rule you want to change and select Edit from the pop-up menu.

The Edit Rules dialog appears, displaying the previously configured rule values.
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b. In the text fields enter the new rule values. The numbers for the rule must not overlap
any other rule range.

c. Click OK.

5. To delete a previously configured rule, right-click on the rule and select Delete from the
pop-up menu.

6. Click Save to save the feature node configuration.

Note: You must configure at least one rule for each branch before you will be able to save
the feature node configuration.

Note: You can configure additional exits for, or remove exits from the feature node, at any time.
If you remove an exit then the next time you open the Configure Branch on Service Key
window, a warning message displays:

Calculation
The Calculation feature node allows basic calculations on two input values. The input values
can be retrieved either from profile fields, or from a profile field and a fixed value. The result of
the calculation is then stored to another profile field.

You use the Calculation feature node to perform the following operations:

• Addition: Adding two source numbers (2+2=4)

• Subtraction: Subtracting the second source number from the first (5-2=3)

• Multiplication: Multiplying two source numbers together (2×2=4)

• Division: Dividing the second source number into the first (10÷2=5)

• Modulus: Finding the remainder when one number is divided into another (10 mod 6=4)

Node exits – Calculation
This node has one entry and three exits. The number of exits cannot be changed.

Exit Name Cause

1 Success All calculation results have been
stored successfully.

2 Error The unrounded result is too large
for the type of target profile tag,
or an error occurs (other than
divide by zero).

3 Divide by zero The calculation divides a number
by zero.
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Configuring the node – Calculation
Follow these steps to configure the node.

1. In the First Number section, specify the input value for your mathematical calculation by
performing the following steps:

a. From the Profile Value Data Type list, select the type of value for your mathematical
calculation. Depending on your selection, different options for Profile Value Location
will be available to you.

b. From the Profile Value Location list, select the location of the value for your
mathematical calculation.

c. From the Profile Value Field list, select the field that contains the value for your
mathematical calculation.

2. In the Operation section, select the mathematical operation you wish to perform (Multiply,
Divide, Add, Subtract, or Modulus).

3. In the Second Number section, specify the input value needed to complete your
mathematical calculation by performing the following steps:

a. From the Profile Value Data Type list, select the type of value of the second number
needed to complete your mathematical calculation.

b. If your profile value data type is a fixed value: In the Profile Value Fixed Value
section, enter the number by which you wish to add, subtract, multiply, or divide.
Otherwise, leave Profile Value Fixed Value blank.

4. In the Rounding section, select the option for the type of rounding you prefer (Truncate,
Ceiling, Median Up, Bankers, or Floor).

5. In the Destination section, specify the profile field in which to store the calculation result
by performing the following steps:

a. From the Destination Profile Data Type list, select the type of value of the profile
field.

b. From the Destination Profile Location list, select the profile, database, or storage
associated with your destination profile field.

c. From the Destination Profile Field list, select the profile field in which to store the
calculation result.

6. Click Save.

Call Filtering
Use the Call Filtering feature node to check the number in the selected call-digits buffer to
determine whether it matches a number in the allowed or barred list stored in the configured
profile location.

Node exits – Call Filtering
This feature node has one entry and three exits. The number of exits cannot be changed.
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Exit Cause Description

1 Barred The call is barred, so it is routed
down branch 1. This may then be
followed by the required
functionality, such as a Play
Announcement or Disconnect
feature node.

2 Allowed The call is allowed, so it is routed
down branch 2. This may then be
followed by the required
functionality, such as a
Termination Unchanged feature
node.

3 Data Not Found No data is found to identify the
number as allowed or barred.
The call is routed down branch 3.
It may then be followed by the
required functionality, such as a
Play Announcement or
Disconnect feature node.

Configuring the node – Call Filtering
To edit the Call Filtering feature node:

1. From the lists in the Compare With Which Buffer area, select the buffer that contains the
number to check in the allowed or barred numbers list. You specify the number list to use
in the location fields.

2. From the Location Of List Type lists, select the profile field that sets whether the list type
is allowed or barred.

3. From the Location Of List Data lists, select the prefix tree profile field that contains the list
of allowed or barred numbers.

4. From the Location Of Ignore Flag lists, select the profile field that sets whether the list
should be used or ignored. When the value in the profile field is set to true, the list is
ignored and all numbers are allowed.

5. Click Save.

Call Forwarded Branching
This node branches in either of two directions, depending on whether or not ACS has been
advised that a terminating call has been forwarded.

ACS may receive advice about call-forwarding from a Service Switching Point (SSP) that
complies with the CAMEL Application Part (CAP) specification. To use the Call Forwarded
Branching node, you need to be familiar with the CAP specification. The specification is
contained in the following document.

3GPP TS 29.078 v3.7.0

3rd Generation Partnership Project;

Technical Specification Group Core Network;

Customised Applications for Mobile network Enhanced Logic
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(CAMEL) Phase 3

CAMEL Application Part (CAP) specification

(Release 1999)

Note: This node can only be used with terminating calls passed to ACS by an SSP that
complies with the CAP specification.

Node exits – Call Forwarded Branching
The Call Forwarded Branching node has one entry and two exits. The number of exits is fixed
and cannot be changed.

Exit Label Cause

1 Call Forwarded ACS has been advised that a
terminating call has been
forwarded.

2 Call Not Forwarded ACS has not been advised that a
terminating call has been
forwarded.

Note: ACS is advised that a terminating call has been forwarded when an EventReportBCSM
is received from the SSP. EventReportBCSM indicates to ACS's tBusy and tNoAnswer
detection points that a "call forwarded" has been received.

Configuring the node – Call Forwarded Branching
This node requires no configuration data. You may change the Node name, if required.

Example of the use of the Call Forwarded Branching node
For a terminating call, you may want to play an announcement if the call has been call-
forwarded and simply terminate the call if it has not been call-forwarded.

To implement this scenario, you could set up the control plan shown below.
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Call Initiation
The Call Initiation feature node enables a call attempt to be initiated from within the control
plan. The feature node initiates a call attempt (ICA) to an IN switch to create a call that can be
processed by ACS as if it had been a standard dialed call.

When the response (answered, noAnswer, busy, or Route Selection Failure) to the call is
received, the feature node performs both the following actions:

• Process the current control plan as normal by taking the appropriate exit

• Transfer the new dialog (on which the ICA was sent) back into ACS as an IDP. The new
call is processed in the normal way, running a new control plan based on the standard
service loading rules.

If the customer has a restricted termination range policy, the available termination ranges will
be displayed in the top left hand corner of the configuration screen.

Notes:

• The IDP is constructed from information supplied in the Configure Call Initiation screen, the
standard control plan number buffers and the call information from the initiating call.

• The available network switches are defined in acs.conf and made available to this feature
node (Switch Name list) through the acsGui.bat/acsGui.sh or smsGui.bat/smsGui.sh
files (ssfs parameter). See ACS Technical Guide, topic Customizing the screens for details.

• The destination for the ICA is configurable within the feature node. The SLEE interface for
the ICA network is configurable in acs.conf. See ACS Technical Guide for details.

• This feature node may not be available, depending on the license agreement with Oracle.
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Node exits – Call Initiation
This node has one entry and six exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The response the ICA received
was 'Answer'.

2 Busy The response the ICA received
was 'Busy'.

3 No Answer The response the ICA received
was 'No Answer'.

4 Route Select Failure The response the ICA received
was 'Route Select Failure'.

5 Transient Failure Either the node cannot find the
network entity for the specified
name, or it cannot find the
service interface.

6 Permanent Failure No response was received for the
ICA.

Specifying values in profile selection fields
For each combo box combination on this screen, there are two methods of entering a value:

1. Use the drop down lists in the Data Type, Location and Field boxes, as in this example,
to select the relevant values:

2. Select Fixed Value in the Data Type box.

Result: The fields will change, as in this example, and you can type the required value in
the Fixed Value field.

Configuring the node – Call Initiation
Follow these steps to edit the node configuration.

1. In the Switch area, select the Name of the network entity for the ICA destination from the
drop down list .

2. (Optional) In the Calling Party frame, specify the value for the Calling Party ICA. Specify
either an ACS termination number or an ACS buffer.
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3. (Optional) In the Prefix Calling Party field, type a prefix for the calling party. This could be
used, for example, so that the switch will not be re-triggered on the terminating leg.

4. (Required) In the Party to call frame, specify the value for the Called Party ICA. Specify
either an ACS termination number or an ACS buffer.

5. In the No Answer Timeout field, type the number of seconds the switch should wait for
the called party to accept the connection before assuming there was no answer. The No
Answer Timeout value must be greater than zero.

Note: The wait time is automatically increased by a configurable amount defined in
acs.conf. See ACS Technical Guide for details.

6. (Optional) In the Controller area, enter the Service Key for the IDP.

7. For each IDP, specify the values for the following optional fields:

• callingPartyNumber

• calledPartyNumber

• redirectingPartyID

• locationNumber

• additionalCallingPartyNumber

8. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Call Progression
The Call Progression node allows you to configure the following parameters in the outgoing
connect message:

• Suppress Switch Announcements

• Set OCSI Applicable

Node exits – Call Progression
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The node parameters have been
set.

2 Failure The node parameters have not
been set.
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Configuring the node – Call Progression
Follow these steps to edit the node configuration.

1. Select the Suppress Ann check box to suppress switch announcements in the outgoing
Connect message.

2. Select the OCSIApplicable check box to set the OCSIApplicable parameter in the
outgoing Connect message.

3. Click Save.

Calling Party
This node routes calls based on the telephone number from which the call is made. This allows
callers whose phone numbers have specified prefixes to be routed to different exits. Calls are
routed to the exit that is mapped to the best match between the calling party number and the
prefixes that are in the node data.

Example: If the prefixes entered into the node data are 04, 09, 04477 and 044, a caller from
044773384 will be routed down the branch associated with 04477, as this is the best match
found for the calling party number.

For calls where there is no match found in the prefix list, the call is routed down the default exit.

Shortcut keys – Calling Party
The shortcut keys to add a Calling Party node are Alt+C.

Node exits – Calling Party
This node has one entry and may have two through 20 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

Configuring the node – Calling Party
Follow these steps to configure the node.

1. Edit the node exits to add up to another eighteen exits as required. See Editing node exits
for details.

2. Click Add Prefix.

Result: A highlighted entry appears in the display grid. This creates the new Prefix entry,
and is edited in the following steps.

3. Type the prefix in the entry field to the left of the Branch box.

Calls made from numbers with this prefix are routed to the exit specified in this step.

4. Use the Branch box to select the exit these calls should be routed to.

5. Click Change.

Result: The Prefix appears in the display grid, with the exit displayed in brackets.

6. Repeat Steps 1 – 4 for as many prefix additions as required.
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7. Set the default branch for all calls which do not match a specified prefix.

8. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Calling Party Category
This node routes a call based on the category of phone from which the call originates. A
category number identifies calls within the system, indicating the type of telephone from which
the call is made (for example, pay phones, hotels or prisons).

This node is used by System Administrators only, for advanced editing. It will only work if the
Telco’s system is set up to provide the IDP calling party category information. This
configuration must be configured on the switch at system level.

Shortcut keys – Calling Party Category
The shortcut keys to add a Calling Party Category node are Alt+Shift+C.

Node exits – Calling Party Category
This node has one entry and may have two through seven exits. You can configure the number
of exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

Configuring the node – Calling Party Category
Follow these steps to edit the Calling Party Category node.

1. Edit the node exits to add up to another five exits as required. See Editing node exits for
details.

2. Select the default branch.

Where the system is not configured to process calling party category data, the system will
use the default branch for any calls using a Control Plan containing this node.

3. Click Add Entry.

Result: A highlighted entry appears in the display grid. This creates the new entry, and is
edited in the following steps.

4. Use the Calling Party Type spin box to select the category number of the required type of
phone.

Any value from 0 – 255 may be used to indicate any given category of phone. These
values are network-specific, so they may be set to reflect the needs of the market. The
table below details the standard values used for ISUP.

Result: Calls from phones of the selected calling party type will route down the selected
branch.

Example: If values are selected from the ITU/ETSI CS1 standards, category 4 represents
calls from the Russian language operator, and category 15 represents calls from
payphones.

If the incoming call is from an undefined category, or if the system is not configured to
process calling party category data, the call will be routed down the default branch.

5. Use the Branch spin box to select the exit.
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This is the exit to which calls made from phones of this category are routed.

6. Click Change.

Result: The Category appears in the display grid, with the exit displayed in brackets.

7. Repeat Steps 1 – 4 for as many category additions as required.

8. Click Save.

Note: Save is not available until all the required information has been selected or entered.

ISUP: Enumerated Values for Calling Party Category
The table below details the standard values.

Integer value Station type

-1 Unknown (not provided)

0 Unknown

1 Operator, language French

2 Operator, language English

3 Operator, language German

4 Operator, language Russian

5 Operator, language Spanish

6 - 8 Available to administration for selecting a particular language by mutual
agreement

9 Reserved

10 Ordinary Calling subscriber

11 Calling subscriber with priority

12 Data call (voice band data)

13 Test call

14 Spare

15 Payphone

16 - 223 Spare

224 - 254 Reserved for national use

255 Spare

The following table shows values for the IS-41 NP(MSID) type.

Integer value Station type

0 Mobile Identification Number

1 International Mobile Station Identity

For more information about the Calling Party Category, see ITU-T standard Q763.

Change CDR
The Change CDR node allows control plan designers to alter and add EDR tags to ACS EDRs
during call flow. The EDR tag and value can be defined as whatever the designer requires
within the rules listed in the Configuring the node procedure.
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Note: The Change CDR node alters the EDR at the point in the control plan where it is placed,
future events may further alter the EDR, either through external events (such as, the end of a
call) or through other Change CDR nodes.

System-generated EDR tags
This is a list of the system-generated tags. These may be used in the Change CDR node, but
their values will not be changed, a new tag of the same name will be added to the end of the
EDR instead.

CID, OA, OTI, CUST, SN, TN, CGN, CLI, SK, TCS, TCE, LPN, LAC, CS, CPC, CC, CPNI,
PCNA, TPNI, PTNA, CGNA, TGNA, TFN, LGID, CPN, CAET, CCET, CA, RELC, OCPI, CPNN,
CGNN, CPPI, NOAT, CBAT, FATS, CCTS, HTS, AIDL, EXTn

Node exits – Change CDR
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The EDR has been successfully
updated with the details specified
for the CDR tag and new CDR
value.

2 Error This branch is taken only in the
event that node configuration is
incorrect. Technical limitations
limit the validation done on the
node configuration at compile
time, and therefore must be done
at run time. The following
situations will cause the Error
branch to be taken:

• The CDRTag field is left
empty

• The CDRValue field is left
empty

Configuring the node – Change CDR
Follow these steps to edit the node configuration.

1. Select the ForceAppend check box to force the specified EDR tag to be appended to the
EDR. If the tag already exists in the EDR, it will not be altered and the EDR will end up with
the same tag in multiple places. The tag values in this case will not necessarily be the
same.

If this box is not selected and the EDR already includes the tag configured in the node,
then the tag in the EDR is modified to have the value defined in the node. If the tag does
not exist in the EDR, then the tag/value pair is added to the EDR. This means the tag
defined in the node is always included in the EDR..

2. The value in the CDRTag field must be between 1 - 50 characters long.

It defines the EDR tag to modify or add to the EDR. Any character may be used in this
field, however the following rules apply:

• Use only uppercase A-Z characters.
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• Do not use the characters | and =

Warning: The use of any of the system generated tags causes the original to remain
unchanged and a second tag added to the end of the EDR, as if ForceAppend had been
selected.

3. Select the Tag Value source, Options are:

• Fixed Value - from CDRValue field when this option selected.

• Profile Value - from profile location when this option selected.

4. If Fixed Value selected, enter the CDRValue field, this must be between 1 - 50 characters
long.

It specifies the EDR value for the defined EDR tag. You may use any character in this field,
except the characters | and =.

Note: If the profile value is selected, this field is grayed out.

5. If Profile Value selected, select the location from the Data Type, Location and Field drop
down lists.

Note: If the fixed value is selected, these fields are grayed out.

6. Click Save.

Change Ordered Prefix Tree Entry
The Change Ordered Prefix Tree Entry node changes the contents of an ordered prefix tree.

This table describes the valid actions.

Action Description

Add a new entry This will add the contents of an ACS number buffer
to the end of an ordered prefix tree.

Note: If the prefix tree is missing a profile field will
be created as a prefix tree with the new entry in it.

Change an existing entry The feature node will replace the specified entry in
the tree with the contents of an ACS number buffer.

Delete an existing entry The specified entry will be removed from the tree.

Note: All of these operations will maintain the ordering of the tree entries (see Ordered prefix
trees).

Node exits – Change Ordered Prefix Tree Entry
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The change was successful.
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Exit Cause Description

2 Error The change failed, due to one of:

• Specified entry not present
in the prefix tree (change or
delete action)

• Entry profile field not set
(change or delete action)

• General node processing
error (including add action
failure)

Configuring the node – Change Ordered Prefix Tree Entry
Follow these steps to edit the node configuration.

1. Select the Operation Type option:

• Add Entry

• Update Entry

• Remove Entry

Result: The field availability changes as listed:

For Add Entry:

• Ordered Prefix Tree fields

• Number Source fields

For Update Entry:

• Ordered Prefix Tree fields

• Entry to be Updated/Removed fields

• Number Source fields

For Remove Entry

• Ordered Prefix Tree fields

• Entry to be Updated/Removed fields

2. In the Ordered Prefix Tree area, using the drop down lists, select the Prefix Tree.

3. For Update or Remove options, in the Entry to be Updated/Removed area, using the drop
down lists, select the required Prefix Tree entry.

4. For Add or Update options, in the Number Source area, using the drop down lists, select
the entry value to use.

5. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).
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Check Limitations
The Check Limitations node compares the contents of a number profile block against the
limitations for a specified limited type. See About Prefix Tree Feature Nodes for information on
limitations.

Node exits – Check Limitations
This node has one entry and five exits. The number of exits cannot be changed.

Exits 2 through 4 are all types of "Error".

Exit Cause Description

1 Number Allowed The number meets all criteria for
acceptance.

2 Number Barred The entered number was either
included in the barred list, or
excluded from the allowed list,
depending on the limitation prefix
tree type.

3 Number Too Short The entered number was not
long enough for the given profile
field.

4 Number Too Long The entered number was too
long for the given profile field.

5 Error General Error.

Configuring the node – Check Limitations
Follow these steps to edit the node configuration.

1. From the Source Primary Tag drop down list, select the limitation to use.

Note: The available limitation types for this feature node are:

• Limited Ordered Prefix Tree

• Limited Number String

2. From the drop down lists in the Number Source area, select the Source Data Type,
Location and Field containing the number to compare against the selected limitation type.

3. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).
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Check Prefix Tree Capacity
The Check Prefix Tree Capacity node enables you to:

• Check how many entries there are in a prefix tree

• Optionally, for a limited ordered prefix tree, play the configured capacity type value (if
played, the value is stored in the profile field configured in the node)

The capacity type value which can be played is one of the following:

• The number of entries available (only for limited ordered)

• The number of entries used (all types)

• The maximum number of entries for the tree (only for limited ordered)

If the prefix tree profile field is missing from the profile, the node assumes it is a tree with zero
entries.

Node exits – Check Prefix Tree Capacity
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 Free Entries The prefix tree is not full.

2 Full The prefix tree is full.

3 Abandon The user hung up during the
announcement.

4 Error General error handling

Configuring the node – Check Prefix Tree Capacity
Follow these steps to edit the node configuration.

1. Select the Play Announcement check box to play the capacity result.

Result: The Play Capacity Announcement Set and Announcement Entry fields become
available and the Save button becomes unavailable.

2. Select the Prefix Tree Type.

Result: If you selected:

• Normal, the Source fields in the Source Prefix Tree area and the Target fields in the
Capacity Storage area become available. Go to step 4.

• Limited Order, in addition, the Capacity Type options and the rest of the fields in the
Source Prefix Tree area become available. Go to step 3.

3. Select the Capacity Type option to use for capacity calculations:

• Entries count - the number of entries available,

• Entries left - the number of entries used, or

• Capacity - the maximum number of entries for the tree.

4. In the Source Prefix Tree area select the source limited ordered prefix tree to query using
the Source drop down lists.
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5. If you selected Limited Order:

• From the Limit drop down lists, select where the limit (value of the maximum capacity
of prefix trees) is stored.

• From the Alternate Limit drop down lists, select an alternate location if the limit is
empty (optional fields).

6. In the Capacity Storage area, using the drop down lists, select the capacity store target.

7. In the Play Capacity area, select the announcement to play for the selected capacity type.

Result: The Save button becomes available.

8. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Collect Date to Tag
Collects and saves a date and/or time to a profile field. Input is either another profile or
subscriber.

Node exits – Collect Date to Tag
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The date and /or time was
successfully saved in the target
location.

2 Error Any of:

• Maximum number of retries
has been reached without
getting any valid date and/or
time.

• Equipment failure during
interaction with Subscriber

3 Abandoned Any of:

• The subscriber hung up
before completing the date/
time request.

• The subscriber pressed the
star key to cancel the
selection of the date or time.
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Response defaults – Collect Date to Tag
When collecting date and /or time from a subscriber, there are defaults used if the complete
date or time are not entered.

The defaults for dates are:

• The month value must be entered by the subscriber.

• Missing year is substituted by the current sysdate year value.

• Missing day is substituted by "01".

• When time only collected, date is defaulted to "01/01/1970"

The defaults for times are:

• The hour value must be entered by the subscriber.

• Missing minutes are substituted by "00".

• Missing seconds are substituted by "00".

• When date only collected, time is defaulted to "00240000".

Configuring the node – Collect Date to Tag
To configure User Interaction:

1. Select User Interaction for the source profile tag.

2. Select what data is to be requested from the subscriber. The options are:

• Collect Date Only

• Collect Time Only

• Collect Date + Time

Result: The relevant date/time fields are available or grayed out.

3. Select Maximum number of retries from the scroll box.

Notes:

• Each announcement also has a number of allowed retries, collectively these may be
greater than the Maximum number of retries.

• If there is a timeout, or an invalid date or time selected by the user, the Retry prompt is
played to invite the user to provide another date or time.

• After the announcement Repetition or Maximum number of retries failures, the
feature node branches to Error.

• When the Collect Date + Time option has been selected and the date is valid before
running out of allowed retries, then the number of retries for the time selections are set
to the Maximum number of retries value.

4. For the option:

• Collect Date Only: Follow the procedure for Configuring the date only interaction.

• Collect Time Only: Follow the procedure for Configuring the time only interaction.

• Collect Date + Time:

a. Follow the procedure for Configuring the date only interaction.
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b. Follow the procedure for Configuring the time only interaction.

5. Follow the steps for Target Selection.

6. Click Save.

To configure Profile Tag:

1. Select ProfileTag for the source profile tag..

2. Select the Source Profile Tag from the Data Type, Location and Field drop down lists.

3. Select the date and time format from the Source Tag Mask drop down list.

4. Follow the steps for Target Selection.

5. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Configuring the date only interaction (Collect Date to Tag)
Follow these steps to configure the date only interaction.

1. Select the date entry announcement to play from the Collect Date Main Configuration
drop down lists.

2. Select the maximum number of times to repeat the announcement from the Collect Date
Main Configuration Repetition scroll box.

3. Select the maximum duration (in seconds)to wait for user interaction from the Collect Date
Main Configuration Duration scroll box.

4. Select the retry announcement to play from the Collect Date Retry Configuration drop
down lists.

5. Select the maximum number of times to repeat the announcement from the Collect Date
Retry Configuration Repetition scroll box.

6. Select the maximum duration (in seconds)to wait for user interaction from the Collect Date
Retry Configuration Duration scroll box.

7. Select the confirmation announcement to play from the Collect Date Confirmation
Configuration drop down lists.

8. Select the maximum number of times to repeat the announcement from the Collect Date
Confirmation Configuration Repetition scroll box.

9. Select the maximum duration (in seconds) to wait for user interaction from the Collect Date
Confirmation Configuration Duration scroll box.

10. Select the Date Format from the drop down list.

Configuring the time only interaction (Collect Date to Tag)
Follow these steps to configure the time only interaction.
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1. Select the time entry announcement to play from the Collect Time Main Configuration
drop down lists.

2. Select the maximum number of times to repeat the announcement from the Collect Time
Main Configuration Repetition scroll box.

3. Select the maximum duration (in seconds)to wait for user interaction from the Collect Time
Main Configuration Duration scroll box.

4. Select the retry announcement to play from the Collect Time Retry Configuration drop
down lists.

5. Select the maximum number of times to repeat the announcement from the Collect Time
Retry Configuration Repetition scroll box.

6. Select the maximum duration (in seconds)to wait for user interaction from the Collect Time
Retry Configuration Duration scroll box.

7. Select the confirmation announcement to play from the Collect Time Confirmation
Configuration drop down lists.

8. Select the maximum number of times to repeat the announcement from the Collect Time
Confirmation Configuration Repetition scroll box.

9. Select the maximum duration (in seconds) to wait for user interaction from the Collect Time
Confirmation Configuration Duration scroll box.

10. Select the Time Format from the drop down list.

11. Select the Timezone type from the drop down list. Options are:

• SCP Local Time

• GMT

• Explicit Unix TZ

• TZ of Service Number

• TZ of Logical CLI

• TZ of Network CLI

12. If you selected the type - Explicit Unix TZ, select the Unix Timezone from the drop
down list.

Configuring the date and time data target (Collect Date to Tag)
To select the target for storing the date and time data, select in the Target Selection frame, the
target Data Type, Location and Field drop down lists.

Note: This may require scrolling to the bottom of the screen.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).
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Collect Digits to Buffer
This node prompts the user to enter digits which it then stores in the nominated buffer or profile
location. The digits may be retrieved later and used in the Control Plan. Any buffer may be
selected; however some buffers may be used by subsequent nodes that are expecting a
different value.

Node exits – Collect Digits to Buffer
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The correct number of digits was
collected successfully.

2 Not Updated The correct number of digits was
not collected after the specified
number of retries.

3 Abandoned The caller abandoned the call.

Configuring the node – Collect Digits to Buffer
Follow these steps to edit the feature node.

1. The Type of Digits to Collect field is only relevant if you are going to select CC Pending
Termination Number from the Buffer Field list. See Step 2.

If relevant, select a value for this field; otherwise ignore it.

2. From the lists in the Buffer frame, select the location to use to store the collected digits.

Notes:

• If you want to copy the type of digits data to Pending TN Type, select the Pending
Termination Number buffer.

•

3. From the Main Announcement frame, select:

• The announcement set that contains the main announcement you want to play to the
caller from the Announcement Set list.

• The announcement to play from the Announcement Entry list.

4. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

5. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

6. The retry announcement contains the announcement you want to play to the caller if the
number of digits collected is not within the range specified.

In the Retry Announcement frame, select the:

• Announcement Set that contains the retry announcement.

• Announcement Entry for the retry announcement you want to play.
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Then set:

• Repetition to the number of times to repeat the retry announcement.

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

7. In the Number of Retries field, set the number of times that the feature node will attempt
to collect data from the caller, before routing the call to the Not Updated branch. This value
may be between 0 and 10.

8. In the Minimum Number of digits field, set the minimum number of digits that must be
collected. The value set must be between 1 and 32.

The minimum number of digits must be less than, or equal to, the maximum number of
digits.

9. In the Maximum Number of digits field, set the maximum number of digits that must be
collected. The value set must be between 1 and 32.

The maximum number of digits must be greater than, or equal to, the minimum number of
digits.

10. (Optional) To include a prefix before the digits collected value, enter the prefix in the Digit
Prefix field.

The prefix may be up to 32 valid characters. Valid characters include 0-9, A-F.

11. From the Cancel Character options, select the character that the caller can use to cancel
the digit collection.

The switch on the answering device is used by default.

12. From the End Character options, select the character that the caller can use to indicate
the end of the digit collection.

The switch on the answering device is used by default.

13. (Optional) To check that the collected digits are within the TN ranges for this client, select
the Verify Against TN Ranges? check box.

This will check the termination number range rules set up for this customer (through the
New or the Edit Customer screen in ACS) and verify according to the rules set. For more
information, see the discussion on Adding customers in ACS User's Guide.

14. Click Save.

Note: The Save button becomes available when you have entered all the required
information.

Result: The feature node data will be saved.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Collect Digits to Pending TN
This node prompts the caller to enter digits which it then stores in a buffer (the Pending TN
Buffer). The digits may be retrieved later and used in the control plan. The nodes that read
from this buffer are:

• Terminate to Pending TN
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• Attempt Terminate to Pending TN

Node exits – Collect Digits to Pending TN
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The correct number of digits was
collected successfully.

2 Not Updated The correct number of digits was
not collected after the specified
number of retries.

3 Abandoned The caller abandoned the call.

Configuring the node – Collect Digits to Pending TN
Follow these steps to edit the feature node.

1. Select the Type of Digits to Collect from the drop-down list. The type may be:

• Off Net

• On Net

• Speed Dial

• Service Number

• CLI

2. From the Main Announcement frame, select the Announcement Set that contains the
main announcement you want to play to the caller.

Result: The Announcement Entry drop-down box will become available.

3. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.

4. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

5. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

6. The retry announcement contains the announcement you want to play to the caller if the
number of digits collected is not within the range specified.

In the Retry Announcement frame, select one of the following as described in steps 2 - 5:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play

• Set the Repetition to the number of times to repeat the retry announcement

• Set the Duration to the length of time, in seconds, that the retry announcement is to
be played.

7. In the Number of Retries field, set the number of times that the node will retry collecting
data from the caller (after an initial failure), before routing the call to the Not Updated
branch. This value may be between 0 and 10.
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8. In the Minimum Number of digits field, set the minimum number of digits that must be
collected. This box accepts values between 1 and 32.

The minimum number of digits must be less than, or equal to, the maximum number of
digits.

9. In the Maximum Number of digits field, set the maximum number of digits that must be
collected. This box accepts values between 1 and 32. The maximum number of digits must
be greater than, or equal to, the minimum number of digits.

10. If a prefix is to be included before the digits collected, enter this in the Digit Prefix field.

The prefix may be up to 32 valid characters. Valid characters include 0-9, A-F.

11. From the Cancel Character options, select the character which the caller can use to
cancel the digit collection.

The default option will use the switch on the answering device.

Notes:

• If the caller uses this digit and the maximum number of retries has not been met, it will
return the caller to the retry prompt and add one to the retry count.

• If the caller uses this digit and the maximum number of retries has been met, it will
take the Not Updated branch.

12. From the End Character options, select the character which the caller can use to indicate
the end of the digit collection.

The default option will use the switch on the answering device.

13. If you want to check that the collected digits are within the TN ranges for this client, tick the
Verify Against TN Ranges? check box.

This will check the Termination Number Range Rules set up for this customer (via the New/
Edit Customer screen in ACS) and verify according to the setting. For more information,
refer to Adding customers in the ACS Customer screen.

14. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Result: The node data will be saved.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Collect Digits to Sub-tag
This node will prompt the user to enter digits, and will save the digits to a sub-tag. This sub-tag
will be a part of a profile block (for example, the speed dial block contains the sub-tag list of
speed dial numbers). See Sub-tags for a definition.

The node can be used to add digits to a sub-tag in a profile, or to access a previously
configured sub-tag in a profile. Consequently, this node is usually used immediately before a
profile node.

Refer to the Copy node, Use Stored Sub-Tag description for an example of using this node, in
conjunction with the Copy node, to change a speed dial number.
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Node exits – Collect Digits to Sub-tag
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The digits were entered and
collected successfully.

2 Not Updated The digits could not be collected.

3 Abandoned The caller abandoned the call.

Configuring the node – Collect Digits to Sub-tag
Follow these steps to edit the Collect Digits to Sub-Tag node.

1. From the Main Announcement area, select the Announcement Set that contains the main
announcement you want to play to the caller. The main announcement will be played to
prompt for digits to enter into a sub-tag.

Result: The Announcement Entry drop-down box will become available.

2. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

4. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

5. The retry announcement contains the announcement you want to play to the caller if the
sub-tag value is not within the range specified in step 7.

In the Retry Announcement area, select one of the following as described in steps 1 - 4:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

6. In the Number of Retries field, set the number of times that the node will attempt to collect
data from the caller, before routing the call to the Not Updated branch. This value may be
between 0 and 10.

7. In the Minimum Sub Tag Value and Maximum Sub Tag Value fields, set the minimum
and maximum sub-tag value to be collected. This is the range of values that the user can
set, for example, speed dial numbers between 10 and 20.

8. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.
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Compare Profile Data
The Compare Profile Data node allows you to compare the value of two profile fields and then
branch on the outcome.

The compare is initially done at the field length level and then at the content level if the two
fields are the same length.

Node exits – Compare Profile Data
This node has one entry and five exits. The number of exits cannot be changed.

Exit Cause Description

1 A < B Profile field value A is less than
profile field B.

2 A = B Profile field value A is equal to
profile field B.

3 A > B Profile field value A is greater
than profile field B.

4 Missing Field Either profile field A or profile
field B is missing from their
respective profiles.

5 Error Any of:

• Invalid field type length
• Failed to retrieve profile

fields
• General Error
• Unrecognized field type

Content comparison rules – Compare Profile Data
This table describes how the field contents are compared when the two field lengths are equal.

Profile Field Type Comparison

BOOLEAN Integer comparison where false = 0, and true = 1.

BYTE Integer comparison.

INTEGER Integer comparison.

DATE Integer comparison, where the dates are
represented as a positive integer (seconds since
the Epoch).

STRING, NSTRING, LNSTRING Lexicographical comparison between the two equal
length strings (finding the order of two words as
they would appear in a dictionary).

PREFIX, OPREFIX, LOPREFIX Perform byte by byte comparison of the two
compiled prefix trees. Branches based on the
difference between the two bytes in the two prefix
trees that differ.

PATTERNs, UINTEGER, UINTEGER64 Perform a memory compare between the two
fields.
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Configuring the node – Compare Profile Data
Follow these steps to edit the node configuration.

1. Select the profile field type for the comparison from the Type drop down list.

Note: Not all the list items are valid for comparison. See the Content comparison rules
table.

2. Using the drop down lists in the Profile Field A area, select the first profile field to compare.

3. Using the drop down lists in the Profile Field B area, select the other profile field to
compare.

4. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Control Plan Notes
Allows you to place notes on the CPE canvas. The note box can be expanded or contracted by
clicking and dragging the resizing handle in the bottom right hand corner of the feature node.

Note: There is no feature node icon for this, just a yellow box for entering notes.

Control plan notes are simply notes you can place anywhere on the canvas to add
understanding to the control plan, including behind feature node icons to add comments to a
group of feature nodes. They add no functionality to the control plan.

Once a note has been placed on the canvas, it may be moved around, duplicated, or deleted
as required. Control plan notes will 'stick' where they are placed when the control plan is saved
and reloaded.

Node exits – Control Plan Notes
This node has no entries or exits, as it is not connected to other nodes within a control plan.

Editing Control Plan Notes
Follow these steps to add a note to a control plan.

1. Drag the node on to the canvas and drop into place.

The Control Plan Notes feature node icon appears in the canvas.

2. Double click the Control Plan Notes feature node icon.

The Edit Comments window displays.

3. Click inside the editable area and type the text that is to appear in the control plan note.
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Note: All text appears in the note exactly as it is entered. To ensure that text does not
appear in a long line, break it up with manual line breaks.

4. Click Ok.

The text appears in the note box.

Copy
The Copy feature node allows you to copy data (for example - digits) from one profile field to
another. You can always copy a profile field to another profile field of the same type. In
addition, you can use the Copy feature node to convert between the following profile field
types:

• Boolean

• Byte

• Short

• Integer

• Unsigned Integer

• Unsigned 64-bit Integer

• String

• Numeric String

• Limited Numeric String

• Bounded Integer

• Price (from Integer or String)

The Copy feature node first converts the source field to a character string (except when it is
already a string or a numeric string field) and then converts the character string to the target
type, according to a set of predefined Profile Field Conversion Rules.

If the source profile field type is OPREFIX or LOPREFIX, then the Copy feature node copies
the source field content directly into a corresponding prefix tree without any conversion.

Profile Field Conversion Rules – Copy
This table lists the types of conversions and the corresponding conversion rules used by the
Copy feature node to convert profile field data to and from character strings.

Type of Conversion Conversion Rule

Boolean to character string Interprets the stored bytes as a signed four byte
integer that is represented in base 10, and:

• Converts false to zero (0).
• Converts true to a non zero integer (usually

either one (1), or 16777216).

Character string to boolean Converts the following values to true:

• Non-zero integers.
• "true", "t", "yes", "y", and "on".
Converts all other values, including an empty
string, and zero (0) to false.
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Type of Conversion Conversion Rule

Byte to character string Converts bytes (assumed to be unsigned) to a
value in the range of "0" to "255".

Short to character string Converts shorts (assumed to be unsigned) to a
value in the range of "0" to "65535".

Integer to character string Converts integers (represented in base 10) to a
value in the range of "-9223372036854775808" to
"9223372036854775807".

Note: Integers are either four bytes or eight bytes
long.

Unsigned 64-bit integer to character string Converts unsigned integers (represented in base
10) to a value in the range of "0" to
"18446744073709551615".

Character string to one of:

• Unsigned Integer
• Unsigned 64-bit integer
• Integer
• Short
• Byte

Converts the string to the required number type.

If the character string starts with "0x", then the
Copy feature node discards the "0x" and interprets
the string as a base 16 number. Otherwise the
Copy feature node interprets the string as a base
10 number.

Unsigned integer to character string Converts unsigned integers (represented in base
10) to a value in the range of "0" to "4294967295".

String, limited numeric string, or numeric string to
character string.

Character string to string, limited numeric string, or
numeric string.

No conversion needed. The Copy feature node
copies these types of profile fields to another
profile field of the

same type.

Bounded integer to character string The Copy feature node cannot copy a bounded
integer to a character string.

Character string to bounded integer Converts the character string to a four byte integer

and puts it in bytes 9, 10, 11 and 12 of the

bounded integer.

Note: Bytes one to four hold the lower bound, and
bytes five to eight hold the upper bound. To
successfully copy an integer to a bounded integer,
the source integer must be between the two
bounds.

Integer

• INTEGER
• UINTEGER
• UINTEGER64

to Price

A Price profile tag contains a string with the strict
format DDDDDDCC, where DDDDDD are the big
units (for example, Euros) with zero padding and
CC are the small units (for example, Cents) also
zero padded.

Conversion from an integer value will assume the
value is expressed in small units with the lowest
two digits providing the CC part.

The conversion (and copy) will fail if the integer
value is bigger than 99999999.

Example:
An integer value 95642 will be converted to"
00095642" which equates to 956.42 (Euros).
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Type of Conversion Conversion Rule

String

• STRING
• NSTRING
• LNSTRING

to Price

A Price profile tag contains a string with the strict
format DDDDDDCC, where DDDDDD are the big
units (for example, Euros) with zero padding and
CC are the small units (for example, Cents) also
zero padded.

Conversion from a string value will accept two
forms of input. A string containing a decimal point
will be assumed to contain a value already in cost
form.

A string conversion will fail if the input value is too
large (the max is either "999999.99" or
"99999999").

Behaviors:

• A string containing "8.71" will be converted to
"00000871".

• Any decimal places more than 2 will be
stripped so "19.563" will be converted to
"00001956".

• A string containing no decimal point will be
assumed to contain a value expressed in small
units (like the integer values). So a string
containing "11223" will be converted to
"00011223" which equates to 112.23.

Node exits – Copy
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success Branch Data successfully saved to the
profile.

2 Not Updated Branch Data could not be saved.

Include Pending TN Type (Copy)
The Include PendingTN Type check box appears when the Source Field selection is CC
Pending Termination Number, as shown in this example of part of the screen.
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Treat Target as Prefix (Copy)
The Use Source as Prefix check box appears when the Source Field and Target Field
selections are of type string or number string, as shown in this example of part of the screen.

Use Stored Sub-Tag (Copy)
The Use Stored Sub-Tag check box appears when the Target Field selection contains sub-
tags (for example, the Speed Dial Block contains the sub-tag list of speed dial numbers. For
more information, see Sub-tags), as shown in this example of part of the screen.
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In this example, earlier in the control plan, the sub-tag (e.g. the speed dial number, let's say 50)
has been specified using the Collect Digits to Sub-tag node. The telephone number, e.g.
08001234567, to associate with it has then been stored in the CC Pending TN buffer using the 
Collect Digits to Pending TN node. Using the Copy node, that number is copied into the Speed
Dial block, so that the speed dial number 50 is set to call 08001234567.

Configuring the node – Copy
Follow these steps to configure the Copy node.

1. From the drop down lists in the Source Profile area, select the source stored data
location.

Notes: If you set a customer-specific profile, the profile set in this field must belong to the
customer who will be running the Control Plan.

If the Control Plan is owned by the Boss user:

• the profile must be set to Control Plan, or

• a customer id must be specified at an earlier point in the Control Plan.

2. From the drop down lists in the Target Profile area, select the target that the data is to be
copied to.

3. If the Include Pending TN Type check box is displayed, then either:

• tick: the node will save the Pending TN to the profile with the Pending TN Type
prefixed.

• Clear: the node will save just the Pending TN to the profile.

4. If the Use Source as Prefix check box is displayed, then either:

• tick: the node will prefix the target value with the source value.

• Clear: the node will copy the source value to the target value.

5. If the Use Stored Sub-Tag check box is displayed, select the required target field format
from the Target sub-tag Storage Format drop down list. The node will save the sub-tag
value with the required format in the target field.

6. Click Save.
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Note: Save is not available until all the required information has been selected or entered.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

For information about using the Call Context Profile, refer to ACS Buffers.

Copy Hunting List
This node prompts the user for a hunting list and copies the hunting list contents to the pending
TN buffers. The hunting list can be one of:

• Identified by name

• The hunting list selected by the hunting planner

Only the first ten numbers in the list are used. The first number in the list is copied to the
pending TN and the next nine numbers are copied to the additional pending TNs. Any further
numbers are discarded.

Note: To use this node either VPN or FMC must be activated on your system. If you are using
this node with VPN then the hunting lists and hunting planner must be formatted according to
the format used by the VPN product and must be located within the
VPN_PT_HUNTING_CONFIG profile tag. See VPN Technical Guide for more details.

The node also gives the user the option to override the no answer timer with one of:

• A fixed value held in a user defined profile field

• The highest timer found within the hunting list

Node exits – Copy Hunting List
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The hunting list numbers have
been successfully copied.

2 Success Trunct The hunting list contains more
than ten numbers. Only the first
ten numbers have been copied.

3 Failure No Planner The node has been configured to
copy the list selected by the
hunting planner but no hunting
planner was defined.

4 Failure No List The specified list name does not
match an existing hunting list.
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Configuring the node – Copy Hunting List
Follow these steps to configure the node.

1. In the Hunting list panel set the hunting list to be copied, to copy:

• the hunting list chosen by the hunting planner, select the Use planner list option

• a specified list, select the Use list below option and type the hunting list name in the
List name box.

2. If required, set the override for the No answer timeout. To use:

• the current No Answer Timeout value, ensure Leave unchanged is selected

• the highest timer within the hunting list, select the Use max from list option, or

• a value from a profile tag, select the Read from profile option and set the Data Type,
Location and Field holding the timer using the drop down lists.

Note: If you selected Read from profile and the node cannot find the specified profile field,
then the No Answer Timeout will not be overridden.

3. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Create Prefix Tree
The Create Prefix Tree node creates a prefix tree from a delimited input string. Each entry in
the input string is checked against the limitation profile tag field specified in the node. This
checks whether the entry is one of:

• Allowed

• Barred

• Too long

• Too short

Delimiters – Create Prefix Tree
This table lists the delimiters allowed between entries in the input string.

Delimiter Description

" " Space

"," Comma

":" Colon

"|" Pipe
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Note: Delimiter characters may be combined, for example, so that spaces and commas can be
used between entries.

Node exits – Create Prefix Tree
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The node has successfully
inserted all the entries from the
source string into the selected
prefix tree.

2 Entries Limited The limitations set in the node
prevented one or more source
entries from being inserted into
the selected prefix tree.

3 Error Indicates none of the source
entries were inserted into the
selected prefix tree or an error/
failure occurred.

Configuring the node – Create Prefix Tree
Follow these steps to configure the node.

1. From the drop down lists in the Source String area, select the profile tag field containing
the string you want to use to create the prefix tree.

2. From the drop down lists in the Destination Profile area, select the profile tag field where
the prefix tree will be stored.

3. To limit the allowable entries in the source string, tick the Use Limitations check box.
Then, from the Limitation Primary Tag drop down list, select the profile tag field to use.

Note: The Product Type profile will be used if available, otherwise the Service Provider
profile will be used.

4. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Day of Week
The Day of Week node allows branching based on the day of the week on which the call is
placed. This branching decision is made according to the data that is entered into the node
through the Configure Day of Week Node edit screen.
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To configure this node, the user adds a day of week range and maps that range to a specified
exit. Calls made on any day of the week within the range are routed down that exit, to be
processed according to the nodes that follow.

Shortcut keys – Day of Week
The shortcut keys to add a Day of Week node are Alt+W.

Node exits – Day of Week
The Day of Week node has one entry and may have 2 through 7 exits. Each exit is mapped to
a day of week range, and must be connected to an appropriate node. You can configure the
number of exits within this range as required, using the Edit Node Exits option on the shortcut
menu. See Editing Feature Node Exits.

Configuring the node – Day of Week
Follow these steps to configure the day of week node.

1. Edit the node exits to add up to another five exits as required to accommodate the dates
you are planning to configure. See Editing node exits for details.

2. From the Timezone Type field, select the timezone to use.

If you select Explicit Unix TZ, you must select a specific region from the Unix Timezone
field.

Note: The GMT+ and GMT- time zone names adhere to POSIX Unix conventions, which
use positive (+) signs for West of Greenwich and negative (-) signs for East of Greenwich.
For example, GMT+4 corresponds to 4 hours behind GMT.

For more time zone information, see Time Zones.

3. Select the Default branch in the box on the left of the screen. Any calls made on a day not
specified in an allocated range route down the default branch.

4. Map the required day of week ranges to the appropriate exits, as detailed below.

5. Once all the data is correct, click Save.

The Save button will not be available if a range has not been accepted, or if the ranges
overlap.

Adding a branch/range mapping – Day of Week
Follow these steps to map a day of week range to an exit, using the Configure Day of Week
screen.

1. Click Add Range.

To the left of the Branch field, the drop-down lists will be populated.

2. Select the day required in each list, to show the first and last day in the range. A range of:

• Wed – Wed affects only calls made on Wednesday of each week.

• Mon – Thur affects calls made on any day from Monday to Thursday.

3. Note that the range may not overlap any existing range. The ranges specified do not need
to include all possibilities. Any calls made on a day not specified in an allocated range
routes down the default branch.
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4. Select the branch that is to be mapped to the specified range. Calls made within that range
are routed down the exit selected in the branch list.

It is possible to have several ranges routing down the same branch or to have branches
that no calls will ever take.

5. Click Change.

Result: The branch/range mapping will appear in the display field.

To delete a mapping, select the entry and click Delete Range.

Day of Year
This node allows control plan branches to be taken based on the current day of the year.

Dates may be specified as individual days or as named holidays, as set in the Holidays tab on
the ACS Configuration screen. Multiple dates and ranges of dates can be specified for each
branch from the node.

To configure this node, the user adds a day of year range and maps that range to a specified
exit. Calls made on any day of the year within the range are routed down that exit, to be
processed according to the nodes that follow.

For more information about configuring holiday sets, see ACS User's Guide.

Shortcut keys – Day of Year
The shortcut keys to add a Day of Year node are Alt+Y.

Node exits – Day of Year
The Day of Year node has one entry and may have 2 through 20 exits. Although this node
accepts up to 20 exits, it is recommended that this number is restricted to a maximum of 10,
due to the width restraints of the node. The default number of exits is 2.

There are three types of exit:

• A specific date or date range (which can be mapped to any free branch)

• A default branch (if the current date is not specified in any of the dates or date ranges, this
branch will be followed)

• Any holiday in set (if it matches any of the dates in the chosen set that have not been
specifically assigned a branch, this branch will be followed)

You cannot map two dates or date ranges to the same branch. Ensure you do not specify the
same day twice (either in a holiday set or on a specified branch), as your control plan data will
not compile successfully.

If you do not want to use the Any Holidays branch, set it to the same exit as the default.

You can configure the number of exits within this range as required, using the Edit Node Exits
option on the shortcut menu. See Editing Feature Node Exits.

Adding a branch/range mapping – Day of Year
Dates may be entered in this node in two forms, as one of the following:

• Holiday entries as entered in a specified holiday set
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• Explicit date ranges

If a date is included as a holiday set, but is not specifically assigned a branch, the call is routed
down the Any Holiday exit.

For calls where there is no match found to any specified date, the call is routed down the
default exit.

Configuring the node – Day of Year
Follow these steps to configure the day of year node.

1. Edit the node exits to add up to another eighteen exits as required to accommodate the
dates you are planning to configure. See Editing node exits for details.

2. From the Timezone Type box, select the timezone you want to use.

If you select the Explicit Unix TZ option, you must choose a specific region from the Unix
Timezone box.

For more Time zone information, see Time Zones.

3. Specify the exit for dates which match a date within the specified Holiday Set, but do not
match a date entry with a specific branch assigned to it.

4. Enter the holiday details by either:

• specifying each date or date range explicitly, or

• mapping the entries from a holiday set to the appropriate branches.

5. More information about entering dates is provided on the next two pages.

6. Select the Default branch in the box on the left of the screen. Any calls made on a day not
specified in an allocated range route down the default branch.

7. Once all the data is correct, click Save.

Note: The Save button will not be available if a range has not been accepted, or if the
ranges overlap.

Adding holiday set entries – Day of Year
Follow these steps to add holiday set entries, using the Configure Day of Year Node screen.

1. Select the holiday set required from the drop-down box.

2. If the selected holiday set has:

• More than one entry in it, you can add them all by clicking Add Whole Set.

• Only one entry or if you only want to add the first entry from the set, click Add Entry.

3. Result: The chosen entries will be added to the display list.

4. In the list box below the display area, select the holiday entry that is required.

5. In the Branch field, select the branch the specified days should route to.

6. Click Change.

Result: The selected default entry in the display area will be changed to the holiday entry
and branch selected.

7. Repeat steps 3 and 4 until all the holiday entries have been mapped to different branches.
(They must be mapped to different branches or the control plan will not compile.)
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8. Click Save.

Adding explicit date ranges – Day of Year
Follow these steps to add explicit date ranges, using the Configure Day of Year Node screen.

1. Click Add Entry.

Result: A default entry will be added to the display list, as a selected entry.

2. Select the (Explicit Date Range) option in the Holiday Entry selection box.

Result: The Start and End Date fields will become available.

3. Select the date range required.

Note: The date ranges are inclusive. For example, a date range of January 1 to January
12 will route calls made on 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11 and 12 January down the
selected branch.

To specify a single date, set both the Start and End Date fields to the same day.

4. Select the branch to be taken by calls within that range.

5. Click Change Entry.

Result: The selected default entry in the display area will be changed to the explicit date
range and branch selected.

6. Select a holiday data set. This information will not be used, but is required for the Control
Plan data to compile correctly.

7. Click Save.

Delete Profile Field
The Delete Profile Field node allows you to delete the specified profile field from the profile
(that is, the field as well as the contents are removed from the profile).

Node exits – Delete Profile Field
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The delete was successful.

3 Error The delete failed.

Configuring the node – Delete Profile Field
Follow these steps to edit the node configuration.

1. In the Profile Field area, using the drop down lists, select the profile field to delete.

2. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.
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The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Dialled Number
The Dialled Number node allows branching, based on the service number (SN) that was dialed
by the person making the call. This allows several service numbers to use the same control
plan and be routed down different branches, based on the service number that the caller used.

Node exits – Dialled Number
This node has one entry and may have 2 through 20 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

Configuring the node – Dialled Number
Follow these steps to add a prefix to the node data, using the Configure Dialled Number
screen.

1. Edit the node exits to add up to another eighteen exits as required to accommodate the
numbers you are planning to configure. See Editing node exits for details.

2. Click Add Prefix.

Result: You see an undefined prefix displayed in the list box to the left of the button.

3. Enter the prefix into the field to the left of the Branch field, as shown below.

To determine the routing, prefixes (or the entire number) must be entered into the node
data. The routing will be based on the best match between the dialed number and the
prefixes that are in the node data. The dialed number list takes up to 1500 characters in
total, which limits the number of entries in the list. It is recommended that a maximum of 50
entries be made in the list.

Example: If 0800447732 is dialed and the prefixes entered into the node data are 0800,
0900, 0800447 and 080044, the call will be routed down the branch associated with
0800447 because this is the best match found for the number dialed.

4. In the Branch field, select the branch down which calls whose dialed number best
matches this prefix are to route. When the entry is correct, click Change.

5. Repeat steps 1-4 until you have specified the dialed number ranges required.
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6. From the Default box, select the branch that dialed numbers that do not match any prefix
entered into the node will route down.

7. Click Save.

Disconnect Call
This node will disconnect a call. The disconnect call will use the cause value 31 by default.
This may be changed using the node editing screen.

Shortcut keys – Disconnect Call
The shortcut keys to add a Disconnect Call node are Alt+R.

Node exits – Disconnect Call
This node has one entry and one exit. The number of exits cannot be changed.

Configuring the node – Disconnect Call
To edit the Disconnect Call node, enter the value that is to be sent to the switch in the
ReleaseCall operation. The value entered determines the tone or message played to the caller
on disconnection of the call.

The cause value defaults to 31. Other values are listed in ITU-T recommendation Q850.

Some examples are:

Value Cause of Disconnection

16 Normal call clearing

17 User busy

19 No answer from user

31 Normal unspecified

Dynamic Switch
The switching node allows calls to be routed to a specified exit. The switching node is simply a
switch. It can point to one exit at any time and does not make any decision-based routing. All
calls that reach that node are directed to the exit to which the switch points.

It is possible to enable the switch to be changed by the customer over the phone. This
achieved in conjunction with profile nodes.

A control plan may contain as many Dynamic Switch nodes as required.

Node exits – Dynamic Switch
This node has one entry and 2 through 20 exits. Although this node accepts up to 20 exits, it is
recommended that this number is restricted to a maximum of 10. You can configure the
number of exits within this range as required, using the Edit Node Exits option on the shortcut
menu. See Editing Feature Node Exits.

Only one exit at a time may be used, and all calls will be routed to the active exit.
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Configuring the node – Dynamic Switch
Follow these steps to change the exit to which the switch points.

1. Edit the node exits to add up to another eighteen exits as required to accommodate the
branches you are planning to configure.. See Editing node exits for details.

2. Use the arrows to change the exit number displayed.

Result: As the exit number is changed, the diagram to the right will graphically
demonstrate the exit to which the switch is set.

3. Click Save.

End
This node signifies the end of the control plan branch.

A control plan may contain as many End nodes as required. The end node must be the last
node in each branch of the control plan. There may not be any other node attached after the
end node.

Note: If the control plan is going to be used by any sub control plan nodes, there is a maximum
of 20 End nodes allowed in the control plan.

Shortcut keys – End
The shortcut keys to add an End node are Alt+E.

Node exits – End
This node has one entry and no exit. It is possible to attach several branches of the control
plan to the entry of a single End node.

Configuring the node – End
This node requires no configuration data. You may change the Node name, if required.

Event Branching
This node will enable alternative control plan branches to be taken, based on the value of a
particular event count. A comparison of the current value of a particular counter may be made
against a constant value or another event count.

To configure this node, two statistics counters are specified, or a statistics counter and a
constant value. The two counters (or the counter and the constant) are compared according to
a specified comparison operation. For example, a constant value of 6 may be specified, with a
comparison operation of “greater than”. In this case, calls will be routed down the “Comparison
is True” branch whenever the first statistics counter registers a value greater than 6. All other
calls are routed down the “Comparison is False”.

A control plan may contain as many Event Branching nodes as required.
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Node exits – Event Branching
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 True The result of the comparison is
true for the factors set in the node
screen.

2 False The result of the comparison is
false for the factors set in the
node screen.

Configuring the node – Event Branching
Follow these steps to configure the Event Branching node.

1. From the Counter list, select the counter that is to be monitored by the node.

2. Counters are configured through the Event Counters tab on the ACS Resources screen.
For more information, see ACS User's Guide

3. From the Operation list, select the type of comparison that is to be made.

4. From the Counter or Constant list, select a statistics counter or (Compare with Constant
Value). If comparing with a constant value, enter the value in the field above the list field.

5. Click Save.

Event Counting
This node increments a specified counter by a specified amount, each time a call is routed
through the node.

The Event Counting Node must be given a statistics counter in which to save the statistics, and
an amount by which to increment each time the node has a call routed through it. This is set in
the Configure Event Counting screen shown below. The Configure Event Counting screen is
available from the Edit Node Data option on the shortcut menu.

A control plan may contain as many Event Counting nodes as required.

Node exits – Event Counting
This node has one entry and one exit. The number of exits cannot be changed.

Configuring the node – Event Counting
Follow these steps to configure the Event Counting node.

1. Select the event counter from the drop-down list to which this Event Counting node is
counting. Event counters are set up in the Event Counters tab on the ACS Resources
screen.

2. In the Increment field, enter the number that the counter will increment each time a call is
routed through the node.

The increment value must be between -99999 and 999999.
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3. Click Save.

Event Setting
This node will reset a event counter to a specified number each time a call is routed through
this node.

The Event Setting node must have a statistics counter that is to be reset specified and the
amount that the statistics counter is to be reset to. These things are set in the Configure Event
Setting screen.

A control plan may contain as many Event Setting nodes as required.

Node exits – Event Setting
This node has one entry and one exit. The number of exits cannot be changed.

Configuring the node – Event Setting
Follow these steps to configure the Event Setting Node.

1. Select the event counter that is to be reset from the drop-down list.

Event counters are set up in the Event Counters tab on the ACS Resources screen.

2. Enter the number to which the statistics counter is to be reset. A Statistics Counter may be
reset to any value between -99999 and 999999.

3. Click Save.

Geographical Routing
This node allows a control plan to branch based on the geographic location of the calling party.
This node may be used to offer different service to calls from certain locations. For example,
routing to a local office.

A control plan may contain as many Geographic Routing nodes as required.

Shortcut keys – Geographical Routing
The shortcut keys to add a Geographical Routing node are Alt+Shift+G.

Node exits – Geographical Routing
This node has one entry and may have two through 20 exits. Although this node accepts up to
20 exits, it is recommended that this number is restricted to a maximum of 10. You can
configure the number of exits within this range as required, using the Edit Node Exits option
on the shortcut menu. See Editing Feature Node Exits.

Geographic routing
A geography set is made up of multiple nested geography entries. Each entry is mapped to a
unique prefix, and may also be connected to a (or several) region. A region is a group of
geography entries. The entries contained in a single region may come from different branches
and different nested levels, or may contain whole branches.
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Routing may be based on either region or geography entry prefix. A geography entry may only
appear once on a branch. That is, it may not appear on two branches.

The routing will be based on the best match between the calling party number (or other
selected buffer) and the number prefix that has been set for the region in the Geography tab of
the configuration screens.

Nested subtrees
If an entire nested subtree within a geography set is allocated to a branch then the root of the
subtree should be allocated to the branch.

Example: If the number prefix entered for a region used in this node was 0447 and the number
prefix for another region used in this node was 04477, a caller from 044773384 will be routed
down the branch associated with 04477 because this is the best match found for the calling
party number.

Allocating individual prefixes vs allocating folders
It can be visually clearer to allocate every individual prefix to a branch in the All Geo Areas
frame but this is not necessary. When allocating a folder to a branch all prefixes (and sub-
folder prefixes) will route down that branch even though the Branch Geo Area (right side)
does not list each prefix. However if any prefixes or sub-folders in the root folder are allocated
to another branch then calls to those prefixes will route down the new branch instead. You will
notice that the prefixes or sub-folders will not be highlighted in the All Geo Areas (left side) of
the root folder when allocated to other branches.

Example:

The geography set has a folder called Eastern Province which contains 3 prefixes, 2 of which
are in a sub-folder called Northern District.

If the Eastern Province folder is allocated to a branch then all matched prefixes will go down
that branch (even though the Branch Geo Areas frame will only display the Eastern Province
folder name).

If the sub-folder, Northern District, is now allocated to another branch then all calls that best
match the prefixes in this sub-folder will go down the new branch.

While the third prefix, Southern District (Prefix 12), will still go down the branch allocated to the
root folder Eastern Province.

The Northern District folder will not be highlighted in the All Geo Areas frame indicating it is
allocated on another branch instead.

Default branch
For calls where there is no match found for the allocated prefixes in the Branch Geo
Areasframe, the call will be routed down the default exit branch, as specified by the Default
Branch field.

Add a geographic entry or Region to an exit branch – Geographical Routing
Follow these steps to add a geographic entry or region to an exit branch.

1. Select the location of the number data from the Source Data Type, Location and Field
drop down lists.
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2. Select the required geography set from the list. The list will display all the Geography sets
that the customer has access to. To the left of the screen is the full tree structure of the
geography set. Branches of the tree may be condensed and expanded by:

• Using the left and right arrow keys

• Clicking on the  and 

3. Enter the branch number to which the geographic entry or region is to be routed in the
Number field.

Example:

4. Select the entry that is to be routed to that branch from the geography tree at the left.

Notes:

• You can select the root branch by pressing Alt+S, and navigate around the tree using
the arrow keys. You can also select any of the first nine entries by pressing Ctrl and
the corresponding number key.

• To route based on geography regions select the 74 Regions tab.

• When routing to exit branches using regions the entries that belong to the region will
be assigned to the exit branch.

• It is important to ensure that an entry is only routed to one exit branch.

5. Either press Ctrl+B or click Move to Branch >>. The entry will be added to the tree
structure for the specified branch. If a condensed branch of the geography tree is added to
the branch sub-tree, the entry selected and all levels below that will be added to the branch
sub-tree. To add geography entries to another branch, select a new branch and use Move
to Branch >> or << Replace in Set to add and remove geography tree entries.

6. Add entries and regions to all branch exits as required.

7. Select the Default Branch.

8. When you have finished all editing, click Save.

Note: Save is not available until changes have been made.

Remove geography entries from a branch subtree – Geographical Routing
Follow these steps to remove Geography Entries from a Branch sub-tree.

1. Select the geography set that is required from the list. The list will display all the geography
sets that the customer has access to. To the left of the screen is the full tree structure of
the geography set. Branches of the tree may be condensed by:

• Using the left and right arrow keys

• Clicking on the  and expanded by clicking on the 

2. Select the branch to which a geography tree branch is currently routed by entering a
number into the Branch field.

3. From the Branch Geo Areas frame, select the entry that is to be removed.
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Note: You can select the root branch by pressing Alt+B, and navigate around the tree
using the arrow keys. You can also select any of the first nine entries by pressing Ctrl and
the corresponding number key.

4. Either press Ctrl+S or click << Replace in Set.

Result: The geography entry is replaced in the full geography set tree. This entry may now
be added to another branch sub-tree if required.

5. When finished all editing, click Save.

Note: Save is not available until changes have been made.

Finding a number in the geographic tree – Geographical Routing
Follow these steps to find where a specific telephone number or prefix is in the geography tree.

1. In the Configure Geographical Routing screen, press Ctrl+R to place your cursor into the
field next to the Find button.

2. Type the number or prefix you want to search for and press Ctrl+F to activate the Find
button.

Result: The All Geo Areas tree will expand and highlight the best match for your query.

Example control plan – Geographical Routing
Here is an example control plan containing a Geographical Routing feature node.

This control plan will route calls to different service centers based on where the call originates
from (for example, routes to the nearest Pizza shop).

This control plan is triggered when the caller dials a certain termination number (for example
0800 PIZZA).
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Get Hunting List
Reads hunting list from subscriber's profile, and copies hunting list contents to the additional
pending TN buffers.

Node exits – Get Hunting List
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Unsupported Any outcome other than success,
for instance:

• List could not be found
• Software error

2 Success The hunting list numbers were
retrieved and passed to the ACS
Context.

Configuring the node – Get Hunting List
Follow these steps to configure the node.

1. In the Hunting list area set the hunting list to use from the Hunting List Data Type, Location
and Field drop down lists.

2. Set the Timeout. To use:

• a value from a profile tag, select the Read from profile option and set the Data Type,
Location and Field holding the timer using the drop down lists, or

• a node configured value, select the Use default value option and enter the value in
the Default Timeout field.

Note: If you selected Read from profile and the node cannot find the specified profile field,
then the No Answer Timeout will not be overridden.

3.

4. Click Save.

Note: The drop down lists display Limited Order Prefix Tree profiles.

For more information on profile blocks and tags, see ACS User's Guide.

Get Hunting Number
The Get Hunting Number node is used to search a list of termination numbers and timeout
pairs within any available profiles.

On each iteration the node sets the PendingTN and timeout using the next number on the list
until no numbers remain.

Notes:

• There are no data provisioning screens in ACS for this node. Provisioning the data
required by this node requires a custom product like VPN.
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• The information for the node is stored in a profile, with the node searching all the profiles it
has, in turn, until it finds the hunting information.

Node exits – Get Hunting Number
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Next Number A number is found

2 No More Numbers No numbers remain

3 Failure General failure

Configuring the node – Get Hunting Number
This node requires no configuration data. You may change the Node name, if required.

Example – Get Hunting Number
As an example, assuming that the following hunting configuration data has been placed in a
profile block:

0x030020 Hunting Config

SubTags (2):

0x000001 356 Hunting Lists (tag 1):

Hunting List ID 1 (name = 'Hunting List 1'):

Rank 1 termination number:

Digits: 04111222

On network ID: 5

Timeout: 10

Rank 2 termination number:

Digits: 1234

Off network number

Timeout: 20

Hunting List ID 2 (name = 'Hunting list 2'):

Rank 1 termination number:

Digits: 04333444

On network ID: 5

Timeout: 30

Rank 2 termination number:

Digits: 4321

Off network number
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Timeout: 40

0x000002 380 Hunting Planner (tag 2):

Time Data 0:

Location pattern: ^7777

CLI pattern: ^77777

Time of Day

Start Time: 04:15

End Time: 08:17

Hunting List ID: 1

Time Data 1:

Location pattern: ^6666

CLI pattern: ^76666

Day of Week and Time of Day

Start Time: Sunday 05:00

End Time: Monday 06:00

Hunting List ID: 2

Time Data 2:

Location pattern: ^5555

CLI pattern: ^75555

Day of Year and Time of Day

Start Time: 28 December 01:12

End Time: 29 December 02:15

Hunting List ID: 1

Default Hunting List ID: 1

When the node is used for the first time in a call, it works out which hunting list to use from the
hunting planner information, based on time of day, and other factors. The hunting list is an
ordered list of termination numbers to try, and a no answer timeout. So, the first list in the
example above says try private number 04111222 on network 5 for 10 seconds. The second
list says try public number 1234 for 20 seconds.

Each time the get hunting number node is processed, it puts a new number from the list in the
pending termination number buffer and the corresponding timeout value in the no answer timer
variable in call context. If the end of the list is reached, the get hunting number node exits
down branch 2.

The idea is that there is a loop back from the no answer branch of an attempt terminate to
pending TN node to a Get Hunting Number node.
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Junction
Use the Junction feature node to collect all incoming feature node connections into a single
exit point.

The usefulness is being able to position this feature node in a strategic position to move
connecting lines clear of other feature nodes, thus making it easier to see what the control plan
is doing.

Node exits – Junction
This feature node has one entry and one exit. The number of exits cannot be changed.

Exit Cause Description

Branch 1 NA Connects all the incoming feature
nodes to the destination feature
node.

Configuring the node – Junction
This node requires no configuration data. You may change the Node name, if required.

Load Profile
This node will load the specified profile.

This allows you to read the profile in the database and makes it available to be updated by
other nodes that can write back to the profile.

Node exits – Load Profile
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success Branch The profile was loaded
successfully.

2 Not Loaded Branch The profile was not loaded.

3 Abandoned Branch The caller abandoned the call.

Configuring the node – Load Profile
Follow these steps to configure the Load Profile node.

1. From the Main Announcement area, select the Announcement Set that contains the main
announcement you want to play to the caller.

Result: The Announcement Entry drop-down box will become available.

2. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.
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Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries,
see Announcements.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

4. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

5. The retry announcement contains the announcement you want to play to the caller if the
number of digits collected is not within the range specified.

In the Retry Announcement area, select one of the following as described in steps 1 - 4:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

6. In the Number of Retries field, set the number of times that the node will attempt to collect
data from the caller, before routing the call to the Not Updated branch. This value may be
between 0 and 10.

7. Using the drop down lists in the Load From Data Type and Load From Location fields,
select the Profile block from which information is to be loaded onto the node.

Note: This lists only the profiles that can be updated. For more information about profile
blocks, see Profile Blocks and Tags.

8. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Example use of Load Profile node
Here is an example of using the Load Profile node to load the customer profile, in order to
access the dial-up self management options.

For detailed information on the ACS Management control plan, see the chapter - Dial-up
Control Plan Management in ACS.

1. A customer is set up with an 0800 number and the self management screens.

2. The customer phones a number attached to the ACS management control plan.
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Here is an example of a Configure Load Profile screen in ACS Management control plan that
prompts the caller for a Customer Profile. See the ACS Management Control Plan example in
ACS User's Guide to see the entire control plan.

In this example, the caller is prompted to enter their management ID.

Loop Limit
The Loop Limit feature node allows ACS to traverse an instance of the node up to a specified
number of times during the control plan processing.

This node can be used in the control plan to create loops composed of other nodes not using
telephony.

Node exits – Loop Limit
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Below Limit The traverse limit has not been
reached.

2 Limit Reached This node cannot be traversed
any more for this instance of the
control plan.

Configuring the node – Loop Limit
Follow these steps to configure the node.

1. In the Value field type the number of iterations for the loop. The value must be between 1
and 1000.

2. Click Save.
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Modify
The Modify feature node allows you to add, change or remove digits from the start or end (or
both) of a number.

Node exits – Modify
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Modified The number was modified.

2 Error Error

Configuring the node – Modify
Follow these steps to edit the node.

1. In the Modify area, using the drop down lists, select the field to modify.

Note: ACS normalisation will have already been applied to this number.

2. Type the number of digits that are to be stripped from the front of the number.

Example: If a value of 2 is entered, 2 digits are removed from the start of the number.

3. Type the number of digits that are to be stripped from the end of the number.

4. Type the characters to prepend to the start of the number.

5. Type the characters to append to the end of the number.

6. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

NP Destination Selection
The NP Destination Selection node determines the owner of the called number (that is, is the
number ported or non ported?). Based on the porting status and whether the number is owned
by the operator (internal) or owned by another operator (external), it can be configured how the
call number is modified.

Optionally, the NP Least Cost Routing node can be used after the NP Destination Selection
node to select the most appropriate route towards the operator that owns the number based on
rules configured in nodes within the control plan. If the control plan has been triggered by
receiving a MAP message, then the NP MTA node must follow the NP DS node (or NP LCR
node if used). However it is possible to have non telephony in between.
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Node exits – NP Destination Selection
This node has one entry and 11 exits. The number of exits cannot be changed.

Exit Cause Description

1 DN Number Violation The Destination Number is not
valid.

2 No Destination Found There is no matching Routing
Destination for the called party
number.

3 Internal Not Ported F The node has successfully
selected an internal destination
on your network where the
Routing Number (for a fixed
destination call) matches an
operator entry in
NP_DN_RANGES or a PQYZ
entry (depending on the runtime
configuration).

4 External Not Ported F The node has successfully
selected an external destination
(one that belongs to another
operator) where the Routing
Number (for a fixed destination
call) matches an operator entry in
NP_DN_RANGES or a PQYZ
entry (depending on the runtime
configuration).

5 Internal Ported In F The Routing Number (for a fixed
destination call) has been ported
in to your network from another
operator and has an associated
subscriber match within the
NP_DN_RANGES table.

6 External Ported Out F The Routing Number (for a fixed
destination call) has an
associated subscriber match
within the NP_DN_RANGES
table and has been ported out
from your network to another
operator.

7 Internal Not Ported M The node has successfully
selected an internal destination
on your network where the
Routing Number (for a mobile
destination call) matches an
operator entry in
NP_DN_RANGES or a PQYZ
entry (depending on the runtime
configuration).
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Exit Cause Description

8 External Not Ported M The node has successfully
selected an external destination
(one that belongs to another
operator) where the Routing
Number (for a mobile destination
call) matches an operator entry in
NP_DN_RANGES or a PQYZ
entry (depending on the runtime
configuration).

9 Internal Ported In M The Routing Number (for a
mobile destination call) has been
ported in to your network from
another operator and has an
associated subscriber match
within the NP_DN_RANGES
table.

10 External Ported Out M The Routing Number (for a
mobile destination call) has an
associated subscriber match
within the NP_DN_RANGES
table and has been ported out
from your network to another
operator.

11 Processing Error An internal error has occurred.

Configuration fields – NP Destination Selection
This table describes the function of each field.

Field Description

TN unmodified (Internal or External) Do not change the pending Termination Number.

Prepend TN with RN

(Internal or External)

Prefix the pending Termination Number with the
Additional Routing Number. If this is not available
use the Routing Number.

Replace TN with RN

(Internal or External)

Replace the pending Termination Number with the
Additional Routing Number. If this is not available
use the Routing Number.

Append URI Include the URI associated with the Called Party
Number in an Extension field that will be sent in the
INAP CONNECT operation to the client interface.

Configuring the node – NP Destination Selection
Follow these steps to configure the node.

1. Select the required Internal option.

2. Select the required External option.

3. Select the Append URI check box if required.

4. Click Save.
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NP Home Routing
The NP Home Routing node is used to determine the routing destination for a call within the
network.

The node looks up the called number in the subscriber list. If the called number is:

• A regular subscriber, then the node retrieves the destination from the DN range that
matches the called number. Least cost routing can then be used to select an appropriate
carrier for the call.

• A special number, then no routing destination is set and the Special Number node exit is
used

Otherwise the No Destination exit is used.

Node exits – NP Home Routing
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 Home Dest Selected The node has successfully
matched the called number to a
home routing number.

2 Special Number The node has successfully
matched the called number to a
special number.

3 No Destination The called number is not your
subscriber. The destination could
not be found.

4 Error An internal error has occurred.

Configuring the node – NP Home Routing
This node requires no configuration data. You may change the node name, if required.

NP Least Cost Routing
The NP Least Cost Routing node is used to determine which carrier to use during call
processing based on least cost rules.

The routing destination set by the Destination Selection node or the Home Routing node
determines which list of carriers to try from the rule set. An attempt is made to connect the call
to the carriers in sequence until one of:

• The call is successfully connected

• No more carriers are available

Prior to each connection attempt, the pending calling and called numbers of the call will be
modified in accordance with the preferred number format of the carrier, their country code,
optional override NOA and called party prefix.

Note: Standard ACS feature nodes, such as the Time of Day, or Day of Week routing nodes
may be used to select different rule sets for different scenarios.
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Node exits – NP Least Cost Routing
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 Route not found The node could not find the route
specified for the carrier.

2 Carrier Available The call has been successfully
connected to the selected carrier.

3 No More Carriers Attempts to connect to each
carrier in the Rule Set were
unsuccessful.

4 Error An internal error has occurred

Configuration fields – NP Least Cost Routing
This table describes the function of the field on this screen.

Field Description

Rule Set Defines the list of rules available for least cost
routing that determine which carrier and routing
destination will be used.

Configuring the node – NP Least Cost Routing
Follow these steps to configure the node.

1. Select the Rule Set from the drop down list of carriers to use for least cost routing.

2. Click Save.

NP Map Trigger
The NP Map Trigger node is used to determine the appropriate response to the Map message
that triggered the IN service.

For example, in an MNP environment the MAP message can be one of:

• Acknowledged with the MAP response message

• Acknowledged with the MAP error message (TCAP_ERROR message being returned)

• Aborted at the TCAP level (TCAP_U_ABORT message being returned)

• Relayed at the SCCP level to the appropriate HLR for processing

Node exits – NP Map Trigger
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Config Applied SCI successfully configured.
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Exit Cause Description

2 Processing Error Unable to apply configuration.

Configuration fields – NP Map Trigger
This table describes the function of each field.

Note: The DRA is the destinationRoutingAddress field in the INAP CONNECT and is derived
from the pendingTN buffer.

Field Description

Map with DRA Sends MAP response and puts the Destination
Routing Address (DRA) in the configured MAP field
(NOA value for configured MAP field).

Map Error Sends MAP Error where the error cause is set to
the MAP Error field value.

TCAP Abort Sends TCAP_ABORT - U_ABORT with the cause
value set to the TCAP Error field value. (Cause
value mapped to appropriate alarm by MAP trigger
application).

SCCP Relay 1 Updates the SCCP called Global Title (GT) with
the DRA, performs GT Translation on the DRA,
and sets Routing Information = route on PC (NOA
value for the SCCP called GT NOA).

SCCP Relay 2 Updates the SCCP called GT with the DRA, does
not perform GT Translation on the DRA, and
Routing Information = route on GT (NOA value for
the SCCP called GT NOA).

SCCP Relay 3 No change to SCCP called GT digits, performs GT
Translation on the DRA, and Routing Information =
route on Point Code (NOA value for the SCCP
called GT NOA).

NOA Sets the Nature of Address value for one of these
options:

• Map with DRA
• SCCP Relay 1
• SCCP Relay 2
• SCCP Relay 3
Valid values are in the range 0-127, and 255.

TCAP Error Sets the TCAP Error cause value for the TCAP
Abort option.

Map Error Sets the Map Error value for the Map Error option.

Configuring the node – NP Map Trigger
Follow these steps to configure the node.

1. Select the required option.

2. If you selected one of the following options, then in the NOA field, set the NOA:

• Map with DRA

• SCCP with GTT
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• SCCP no GTT, or

• SCCP with GT digits

3. If you selected the MAP Error option then select the map error message to use from the
Map Error drop down list.

4. If you selected the TCAP Abort option then in the TCAP Error field, type the cause value.

5. Click Save.

Number Lookup and Translation
This node takes a number that is either entered by the user or is held as a data item, and
translates it to another number.

The new number is stored in a field in a specified location for later use, for example, as a
pending termination number.

Node exits – Number Lookup and Translation
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The number has been
successfully translated.

2 Not Translated The number has not been
translated.

3 Abandoned The caller has abandoned the
call.

4 Not Updated The number could not be
updated.

Configuring the node – Number Lookup and Translation
Follow these steps to configure the node.

1. In the Read number translation list from field, select the location in which the number
translations are stored. The Control Plan designer must verify that this field contains the
correct selection.

Note: If this number translation has been established by using the ACS > Resource > 
Number Translations screen, the information will always be in Customer Profile, Sub-field
1.

2. In the Sub-field field, enter the sub-tag that selects a group of number translations. This
field entry does not have a default value. See Sub-tags for a definition of sub-tags.

The list that is stored under the sub-field is a prefix tree data structure, which allows the
input number to be quickly looked up and verified.

Example:

• Sub-field 1 could be Marketing translations between account codes and phone
numbers.

• Sub-field 2 could be Sales Department quick dial numbers.

3. Select the method of obtaining the number:
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• Retrieve stored number

Result: The Retrieve number from location and Retrieve number from field fields
are activated. Go to Step 4.

• Prompt and collect number

Result: The Announcement areas are activated. Go to Step 6.

4. If you selected the Retrieve stored number option, in the Retrieve number from location
and Retrieve number from field drop down lists, select the location of the data to retrieve.

5. Go to Step 12.

6. If you selected the Prompt and collect number option, from the Main Announcement area,
select the Announcement Set that contains the main announcement you want to play to
the caller.

Result: The Announcement Entry drop-down box will become available.

7. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller.

Note: All announcements are established in the ACS > Configuration > Announcements
screens.

8. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

9. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.

10. The retry announcement contains the announcement you want to play to the caller if the
digits they enter are not recognised.

In the Retry Announcement area, select one of the following as described in steps 5 - 9:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

11. In the Number of Retries field, set the number of times that the node will attempt to collect
data from the caller, before routing the call to the Not Translated branch. This value may
be between 0 and 10.

12. From the Store translated number to Location and Store translated number to Field
drop down lists, select where to store the translated number.

13. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.
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Example – Number Lookup and Translation
The following have been set up in the ACS > Resource > Number Translation screens (list of
Sub-field 1 numbers):

Input Number Termination Number

08004567 041234567

08009876 063456789

The number to translate is compared to the Input Number list.

When a match is found, the matching termination number is stored in the configured location.

Number Matching
The Number Matching node finds numbers that match:

• One or more search patterns

• A profile block and field

Node exits – Number Matching
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Number Found The selected number matches a
search pattern.

2 Number Not Found The selected number does not
match a search pattern.

3 Number is Undefined One of:

• The buffer to compare is
empty

• There is no number list found
at the profile and field
combination provided

Search patterns – Number Matching
The Number Matching feature node allows you to enter one or more search patterns in the
Static Pattern List field.

The search patterns are entered using regular expressions. Some characters have special
meaning when used in a regular expression; other characters stand for themselves. Under
ACS, telephone number matching is customized for patterns of telephone numbers. The
"number" character set is represented by digits zero through nine, asterisk, pound sign (hash
mark), and the letters A through F.

The control plan compiler notifies you if the pattern entered is invalid.

Special characters

Here are the definitions of special characters used in search patterns.
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Special Character Definition

c For the purposes of this feature node, the
character c refers to the "number" character set as
defined above.

? Any single character in the pattern.

(r) The regular expression r. For example, (r)x(y)z is
the combination of regular expressions rxyzy. This
is typically used to group number sequences as
distinct units.

r% Zero or more successive occurrences of the
regular expression r. The longest left-most match is
chosen.

rx The occurrence of regular expression r, followed by
the occurrence of regular expression x.

r<m:n> Any number of m through n successive
occurrences of the regular expression r. The
regular expression r<m> matches exactly m
occurrences; r<m:> matches at least m
occurrences. The occurrence counting angle
brackets allows only numbers and a colon within
the brackets. The angle brackets and colon have
no meaning outside of this context.

[s] Any character in the set s, where s is a sequence
of characters and/or a range of characters, for
example [0-9]. When used in square brackets, the
dash denotes a range, for example [cc].

Note: The dash has no special meaning if it occurs
immediately after the open bracket, or before the
closing bracket: for example, ([-c] or [c-]).

[^s] Any character not in the set s, where s is defined
as in the previous entry. The circumflex has the
meaning "complement of", where it immediately
follows the open bracket for example, [^s]. A
circumflex is not part of a telephone number, so a
match will never be found for a pattern where the
circumflex does not immediately follow the open
bracket.

Examples:

Here are some examples of search patterns.

Search Pattern Definition

123 Match digit sequence '123' exactly

123% Match digit sequence '12' followed by none or more
'3' digits {matches 12, 123, 1233, 12333}

123<1:> Match digit sequence '12' followed by one or more
'3' digits {matches 123, 1233, 12333, ..}

(123)% Match none or more entire sequences of '123'
{matches nothing, 123, 123123, 123123123, ...}

(123)<1:2> Match on at least one and no more than two
sequences '123' {matches ONLY 123 and 123123}

021?<6:7> Match on prepaid (at least 6 of any digits) &
subscriber (most 7 digits)
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Search Pattern Definition

025?<6:> Match on at least 6 of any digit, no upper limit of
digits

02[15]?<6:> Match on a number that starts with 02, is directly
followed by a single digit 1 or 5, and followed by at
least 6 occurrences of any digit

123?% Match on a number where 123 is followed by
anything or nothing

??123??? Match on any 8-digit number where the 3rd to 5th
digits are 123

?%123 Match on any number ending in 123, including 123

Configuring the node – Number Matching
Follow these steps to configure the node.

1. In the Number to Match frame, using the drop down lists, specify the number to match.

2. Select the pattern list location. If you select:

• Node dialog, the Static Pattern List field is active.

• Profile, specify the data type, location, and field.

3. If you selected Node dialog, fill in the Number Match Pattern List field. See Search
patterns – Number Matching for a list of example patterns.

Warning: Do not leave this field empty. If you leave this field empty, exit 2 will be taken, as
there is nothing to match against.

If you selected Profile, select from the drop-down lists:

• Pattern List Data Type

Note: Only String data types are accepted. To be able to find a profile with an Integer
data type, you must add a Copy node to your control plan just before the Number
Matching Node. Configure the Copy node to temporarily change the profile data type
from Number to String.

• Pattern List Location

• Pattern List Field containing the pattern to match against

4. Click Save.

Note: If any control plan containing Number Matching nodes were exported prior to the profile
block functionality being introduced and you import them again, you will need to re-save to
allow the control plan to recompile.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).
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Example – Number Matching
This example is based on the configuration screen shown for this node:

• The number to match against is held in the Calling Logical Number field in the call context.

• The search pattern looks for the digits 123, starting in position 3, in an eight digit number.

The exit taken is shown in this table for the various Calling Logical Number examples:

CLN Exit taken Why

NA 3 - Number is Undefined No number found at configured
location - Logical Calling Number
buffer is empty.

04123678 1 - Number Found 123 found, starting at position 3,
in an eight digit number.

0412367 2 - Number Not Found Not an eight digit number - only 7
digits.

12345678 2 - Number Not Found 123 not at position 3 - occurs at
position 2.

0212345678 2 - Number Not Found Not an eight digit number - 9
digits.

Number Normalisation
The Number Normalisation node normalizes the number currently held in the selected buffer,
following the rules defined in acs.conf.

Note: Any changes made to acs.conf will necessitate a SLEE restart for the changes to be
registered with this node.

Node exits – Number Normalisation
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The caller has successfully exited
the node.

2 Error Invalid value found in selected
buffer.

Error exit branch is followed
whenever the value held in buffer
is NULL/empty or has more than
32 characters.

Configuring the node – Number Normalisation
Follow these steps to edit the node configuration.

See the ACS technical Guide, topic acsChassis Normalisation Parameters (SCP) for
information on number normalisation.
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1. Using the drop down lists in the Number Buffer area, specify the buffer containing the
number to normalise.

2. Type the Source NOA value.

3. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

PIN Authorisation
This node checks that there is a PIN in the PIN buffer. If there is none there, it prompts the user
to enter their PIN and places the received digits in the PIN buffer. It then checks that the PIN is
correct. If it is not, then it prompts for PIN entry (maximum of ten times). It then collects the PIN
accesses in the station profile (if there is none, it uses the network profile default). A check is
made that the attempted action is permitted.

Note: A PIN can be set for a service number or CLI number in ACS. See Service Number and
CLI New Numbers fields, accessed from the ACS Numbers screen, for details.

Node exits – PIN Authorisation
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The valid PIN is entered.

2 Not Allowed The entered PIN is not
recognized.

3 Abandoned An error has occurred and the
PIN has not been collected.

Configuring the node – PIN Authorisation
Follow these steps to edit the PIN Authorisation node.

1. From the Main Announcement area, select the Announcement Set that contains the main
announcement you want to play.

Result: The Announcement Entry drop-down box will become available.

2. From the Announcement Entry drop-down list, select the main announcement you want
to play to the caller to request a PIN.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

4. Set the Duration field to the length of time in seconds that the announcement is to be
played. If set to zero, the announcement will be played for its full length.
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5. The retry announcement contains the announcement you want to play to the caller if an
incorrect PIN is entered.

In the Retry Announcement area, select one of the following as described in steps 1 - 4:

• Announcement Set which contains the retry announcement

• Announcement Entry for the retry announcement you want to play, and set the

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

6. In the Number of Retries field, set the number of times that the node will attempt to collect
the correct PIN from the caller, before routing the call to the Not Allowed branch. This value
may be between 0 and 10.

7. Tick the Access Rights Required check boxes that you wish to give right of access to the
information that the node requires. These relate directly to the application in which the PIN
was stored.

8. Select the profile blocks in which the information that the node requires is located. A profile
block must be selected for each of the PIN, the Access Rights, and the default Access.

Note: For information about profile blocks, see Profile Blocks and Tags.

9. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Play Announcement
This node will play a specified recorded announcement to the caller.

Shortcut keys – Play Announcement
The shortcut keys to add a Play Announcement node are Alt+P.

Node exits – Play Announcement
This feature node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Completed The announcement completed
playing to the caller without any
problems, the caller interrupting
(by pressing keys on their
telephone or speaking in a voice
recognition system), or hanging
up.
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Exit Cause Description

2 Abandoned The playing of the announcement
was abandoned for some reason.
This could be that the caller hung
up before the announcement had
completed playing, or the
announcement could not be
played correctly as there was
some sort of error.

3 Error Continue session control after
announcement failures and
terminations.

Configuring the node – Play Announcement
Follow these steps to edit the Play Announcement node.

1. In the Main Announcement frame, select the Announcement Set which contains the
main announcement to play to the caller.

Result: The Announcement Entry field becomes available.

2. From the Announcement Entry drop-down list, select the main announcement to play to
the caller.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement is played for
the duration set.

4. Set the Duration field to the length of time, in seconds, that the announcement is to be
played. When set to zero, the announcement will be played for its full length.

5. Click Save.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Play Ordered Prefix Tree Entry
The Play Ordered Prefix Tree Entry node plays a single selected entry from an ordered prefix
tree to the caller.

If the entry number profile field is not present, the first prefix tree entry (entry number zero) is
used in the announcement.

Selection keys – Play Ordered Prefix Tree Entry
Selection keys (digits 0 to 9) to cater for “Forward”, “Backward”, “Select”, and “Exit” operations
can be optionally configured to enable scrolling through a prefix tree.

When configured, the announcement is played as a prompt and collect operation. If an
incorrect digit is collected, the Invalid Key error branch is taken.

When not configured, the announcement is played as a variable announcement with two parts
in the following order:
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1. Entry Number

2. Prefix Tree Entry

Node exits – Play Ordered Prefix Tree Entry
This node has one entry and nine exits. The number of exits cannot be changed.

Exits 1 through 5 are optional and therefore available only when configured.

Exit Cause Description

1 Next The caller entered the “Next” key
(digit 0 to 9).

Note: Checks (listed under exit 6
below) are made before
branching which could result in
exit 6 being taken instead, see
exit 6 below.

2 Previous The caller entered the “Previous”
key (digit 0 to 9).

3 Exit The caller entered the “Exit” key
(digit 0 to 9).

4 Selected The caller entered the “Select”
key (digit 0 to 9).

5 Timed Out The user did not enter a digit
within the configured menu
timeout period.

6 Last Played One of the following occurred.

• The last entry was played in
the tree.

• The next entry in the tree is
outside the maximum
number of entries (and
Check Limitations was set).

• The entry number was not
valid for this tree (in which
case the last entry (or last
applicable entry in the case
of limitations being applied)
will have been played).

• The prefix tree is not present
in the profile.

• The prefix tree has no
entries.

7 Invalid Key The caller entered an invalid key.

8 Abandoned The caller hung up during the
announcement.

9 Error General Error Handling.

Configuration fields – Play Ordered Prefix Tree Entry
This table describes the function of each field.
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Field Description

Check Limitations When selected, restricts the maximum number of
entries that may be played to the maximum
number of entries for the source prefix tree.

Announcement Set List of all the announcement sets (configured in the
ACS Configuration screen in ACS).

Announcement Entry List of all the announcements belonging to the
selected announcement set.

Source Data Type The source data type for the prefix tree.

Source Location The profile block containing the prefix tree location.

Source Field The prefix tree location field within the profile block.

The available field types listed are:

• Limited Ordered Prefix Tree
• Ordered Prefix Tree

Entry Data Type The data type of the prefix tree entry number to
play.

Entry Location Profile block that contains the prefix tree entry
number to play.

Entry Field Profile field containing the entry number to play.

Forward Sets the key for "Next" operation. This is optional,
and if not set, no next option will be available to the
caller. Single 0 to 9 digit not configured else where.

Backward Sets the key for "Previous" operation. This is
optional, and if not set, no previous option will be
available to the caller. Single 0 to 9 digit not
configured else where.

Exit Sets the key for "Exit" operation. This is optional,
and if not set, no exit option will be available to the
caller. Single 0 to 9 digit not configured else where.

Select Sets the key for "Selected" operation. This is
optional, and if not set, no selected option will be
available to the caller. Single 0 to 9 digit not
configured else where.

Menu Timeout Seconds to wait for a key entry (when selection
keys are configured) before branching "Timed out".
Range is 0 to 99 seconds.

Note: The lower this value is the more likely a
timeout is going to occur (that is, 0 would result in
100% certain timeout).

Configuring the node – Play Ordered Prefix Tree Entry
Follow these steps to edit the node configuration.

1. Tick the Check limitations check box to restrict the maximum number of entries to play to
the source prefix tree maximum number of entries.

Non-selection will allow all the available entries to be played.

2. In the Play Entry area, using the drop down boxes, select the Announcement Set and
Announcement Entry for the prefix tree entry announcement to play.

3. In the source Prefix Tree area, using the drop down boxes, select the prefix tree.
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4. In the Entry Number to be Played area, using the drop down boxes, select the prefix tree
number to play.

5. In the Forward field, enter the unique digit (0 to 9) the caller must enter to use the forward
function. This is optional.

6. In the Backward field, enter the unique digit (0 to 9) the caller must enter to use the
backward function. This is optional.

7. In the Exit field, enter the unique digit (0 to 9) the caller must enter to use the exit function.
This is optional.

8. In the Select field, enter the unique digit (0 to 9) the caller must enter to use the select
function. This is optional.

9. In the Menu Timeout field, optionally enter a number of seconds (0 to 99). This is the
amount of time to wait for a response from the caller before taking the Timed out exit.

Note: The lower this value is, the more likely a timeout is going to occur. 0 results in 100%
certain timeout.

10. Click Save.

Note: In steps 5 to 8, the digit must be unique for this configuration. Any conflicts will be
reported and must be resolved before saving.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Play Variable Part Announcement
The Play Variable Part Announcement feature node announces to the user up to five variables
that were loaded from the profile block.

The feature node must have an announcement selected with variable parts. This
announcement will be played and the variable parts specified will be played in the
announcement.

You can configure variable part announcements to comply with the 3GPP CAMEL
specification: 3GPP TS 29.078, by setting the TypeOfIVR parameter to CAMEL in the srf
(Special Resource Function) configuration in the acs.conf configuration file. When set, the
Play Variable Part Announcement feature node plays dates sent over the network with a size of
four octets in announcements. By default, the feature node plays dates sent over the network
with a size of three octets. For more information about srf configuration, see the discussion on
acsChassis srf configuration in ACS Technical Guide.

Node exits – Play Variable Part Announcement
This feature node has one entry and two exits. The number of exits cannot be changed.

Note: These exit descriptions are specific to the responses received from an Oracle
VWSbilling engine. For specific information about how responses from other billing engines
map to these exits, see the technical guide for the interface for billing engine being used.
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Exit Cause Description

1 Completed The announcement completed
playing to the caller without any
problems, the caller interrupting
(by pressing keys on their
telephone or speaking in a voice
recognition system), or hanging
up.

2 Abandoned The playing of the announcement
was abandoned for some reason.
This could be that the caller hung
up before the announcement had
completed playing, or the
announcement could not be
played correctly as there was
some sort of error.

3 Error Continue session control after
announcement failures and
terminations.

Configuring the node – Play Variable Part Announcement
Follow these steps to edit the Play Variable Part Announcement node.

1. From the Main Announcement frame, select the Announcement Set which contains the
main announcement you want to play to the caller.

Result: The Announcement Entry list becomes available.

Select the main announcement you want to play to the caller from the Announcement
Entry drop down list.

2. For each of the variable parts:

• In the Data Type field, select the profile data type.

• In the Location field, select the location where the field is stored.

• In the Field field, select the field to be played.

• Select the Denormalisation check box, if you wish the number in this field to be
denormalized. See ACS Technical Guide, Play Variable Part Announcement
Configuration topic , for this node's denormalization rules.

3. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.
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• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Prefix Branching
The Prefix Branching node allows you to compare the contents of an ACS number buffer
against the specified profile field, and will branch according to whether the profile field content
is a prefix of the ACS number buffer value.

Node exits – Prefix Branching
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Matched The specified profile field’s value
was a prefix of the number
buffer’s value.

2 Not Matched The specified profile field’s value
was not a prefix of the number
buffer’s value.

Editing the node – Prefix Branching
Follow these steps to edit the node configuration.

1. Using the drop down lists in the Number String area, select the source prefix tree.

2. Using the drop down lists in the Number Source area, select the ACS number buffer
containing the number to compare with the prefix tree.

3. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Prefix Tree Branching
The Prefix Tree Branching node allows you to compare the contents of an ACS number buffer
against the specified prefix tree, and will branch according to whether the tree contains a prefix
of the number.

If a match is found, the value associated with the matched entry (often the order of a limited
prefix tree) will be stored in the specified profile field.

Node exits – Prefix Tree Branching
This node has one entry and three exits. The number of exits cannot be changed.
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Exit Cause Description

1 Matched A prefix of the number was found
in the tree.

2 Not Matched A prefix of the number was not
found in the tree.

3 Fully Matched The number was found in the tree
(full match, not a prefix)

Configuring the node – Prefix Tree Branching
Follow these steps to edit the node configuration.

1. In the Prefix Tree area, using the drop down boxes, select from the list of prefix trees.

2. In the Number Source area, using the drop down boxes, select the source for the number
to match.

3. If you want to temporarily store a matched number in a specified field so that the node
doesn't change the prefix tree:

a. Tick the Enabled check box in the Use Selected Entry area.

b. Then use the drop-down lists in the Selected Entry area to specify where to store the
number.

4. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Prefix Tree Entry Extraction
The Prefix Tree Entry Extraction feature node enables one or more entries in a profile prefix
tree to be extracted and stored in other profile fields.

Looping – Prefix Tree Entry Extraction
If there is more than one entry in the prefix tree that requires processing then the Prefix Tree
Entry Extraction node should be set up in a loop in the control plan. If no external data will be
supplied to the Prefix Tree Entry Extraction node, then the following additional nodes will be
required in the control plan:

• Set feature node

• Loop Limit feature node

• Profile Counting feature node
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Loop process – Prefix Tree Entry Extraction
This process describes how a loop can be used to process multiple entries from the prefix tree
specified in the Prefix Tree Entry Extraction (PTEE) node in the control plan.

1. The Set node is used to initialize the first entry position for the PTEE node. This means it
must be placed in the control plan before the PTEE node.

2. The PTEE node will extract the initial entry and follow the More Entries path (if more
entries exist).

3. Following any required processing, the Loop Limit node will be checked to ensure the
maximum number of iterations has not been reached and its counter will be incremented.

4. The Profile Counting node must be placed after the Loop Limit node in the control plan. It
will increment the entry position to be used by the PTEE node.

5. The PTEE node will extract the entry indicated by the Profile Counting node and if more
entries exist it will exit through the More Entries path.

6. This processing will continue until there are no more entries in the prefix tree or the loop
limit is reached. The loop will then be exited following any required processing.

Node exits – Prefix Tree Entry Extraction
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 More Entries There are some more entries to
extract.

2 No More Entries The entry position is pointing to
the last entry indicating that there
are no more entries to extract.

3 Invalid Position The entry position is either 0 or
greater than the limit.

4 Error The specified profile does not
exist.

Configuration fields – Prefix Tree Entry Extraction
This table describes the function of each field.

Field Description

Source Data Type The data type of the source profile block.

Source Location The profile block containing the prefix tree.

Source Field The prefix tree field within the profile block.

The available field types listed are:

• Limited Ordered Prefix Tree
• Ordered Prefix Tree

Entry Data Type The data type of the entry profile block.

Entry Location The profile block that contains the prefix tree entry
number to extract.
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Field Description

Entry Field The profile field containing the entry number to
extract. This will be an integer field.

Destination Data Type The data type of the profile to use to store the
extracted data.

Destination Location The profile block location for the extracted data.

Destination Field The profile field where the extracted data will be
stored. This will be an integer field.

Configuring the node – Prefix Tree Entry Extraction
Follow these steps to configure the node.

1. From the Source Prefix Tree area, using the drop down boxes, select the prefix tree.

2. From the Entry Position to be Extracted area, using the drop down boxes, select the prefix
tree number to extract.

3. From the Destination Profile Field area, using the drop down boxes, select the destination
profile field for the extracted data.

4. Click Save.

For more information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Fields.

For more information about profile field configuration, see the discussion on profile tag
configuration in Convergent Charging Controller Advanced Control Services User's Guide.

Presence Branching
This node sends a request via ACS to a third party presence server to query a selected
location for the presence and availability of a specified subscriber or presence entity. It then
branches accordingly.

Note: The node relies on a protocol specific presence querying chassis action to process the
request. The library used is delivered separately by another package, such as scaScp.

Following are the standard set of locations and availabilities, delivered at installation, that may
be queried.

Standard Locations:

• Home

• Office

• PlaceOther

Standard Availabilities:

• Available

• Away

• Busy

• N/A
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Node exits – Presence Branching
This node has one entry and up to eight exits depending on which availabilities the user
configures for the selected query location.

Exits 1 through 4 are determined by the system and cannot be changed.

Exit Cause Description

1 No presence entity The specified presence entity
could not be found.

2 No presence domain The presence domain profile tag
does not exist and no default
presence domain has been
configured.

3 No match The availability retrieved by the
presence server does not match
any of the configured
availabilities.

4 Error The presence server has
reported an error.

5 Available At the configured location the
presence entity is:

• Available

6 Away • Away

7 Busy • Busy

8 N/A • Not available

Note: Exits 5 through 8 will be in the order configured, and therefore not necessarily in the
order shown here.

Configuring the node – Presence Branching
Follow these steps to edit the node configuration.

1. From the drop down lists in the Presence Entity panel, select the Data Type, Location and
Field where the presence entity name or number is held.

Note: The selected Field must be of type STRING.

2. If required, set the Domain Name field to the name of the domain to append to the
presence entity name or number.

Note: The domain will not be appended to the presence entity if it is already present in the
Field selected in the Presence Entity panel.

3. From the drop down lists in the Presence Domain panel, select the Data Type, Location
and Field that identifies the presence query chassis action protocol. The selected Field
must be of type INTEGER.

Note: Currently only the SIP protocol is supported.

4. Set the action to be taken if the presence domain cannot be found. Select:

• Error - to report an error, or

• Use default below - to use the default presence domain. Select the default presence
domain from the drop down list.
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5. Set the Location to query for the presence entity.

6. Set the Availabilities to query for the selected location.

• To add an availability to the location query, select it in the drop down list and click Add
branch.

• To remove an availability from the location query, select it in the drop down list and
click Remove branch.

7. Note: Each time you add or remove an availability, an exit is either added or removed from
the node.

8. Click Save.

Profile Branching
The Profile Branching feature node checks the value of a specified profile field against a set
value.

Node exits – Profile Branching
This node has one entry and three exits. The number of exits cannot be changed.

Note: These exit descriptions are specific to the responses received from an Oracle VWS
billing engine. For specific information about how responses from other billing engines map to
these exits, see the technical guide for the interface for billing engine being used.

Exit Cause Description

1 True The result of the comparison is
true for the factors set in the node
screen.

2 False The result of the comparison is
false for the factors set in the
node screen.

3 Data Not Found Data required by the node has
not been found. No comparison
has been made.

Configuring the node – Profile Branching
Follow these steps to configure the Profile Branching node.

1. In the Source Data Type field, select the data type of the source profile block.

2. In the Source Location field, select the profile block in which relevant information is
stored.

3. In the Source Field field, select the profile tag that identifies the information required by
the node.

4. Select either to compare the Value, or the Length of the source.

5. From the Comparison Operator list, select the type of comparison that is to be made.

This field describes the relationship between the value in the specified profile field and the
value set as the Constant.
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Example: In the screen shown above, the value in the specified profile field is required to
be greater than 0. Therefore, the Comparison Operator is set to “Greater than” and the
Comparison Constant is set to “0”.

6. Type the Comparison Constant that is required.

Result: The specified Profile field will be compared with the set constant value.

7. Click Save.

Note: The Save button becomes available when the Primary Tag field is populated with a
value other than 0.

Profile Counting
The Profile Counting node resets the configured integer profile field by one of:

• Setting the profile field content with this nodes configured value

• Incrementing the profile field content by this nodes configured value

Node exits – Profile Counting
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The profile counting field was
updated successfully.

2 Error General Error.

Configuring the node – Profile Counting
Follow these steps to edit the node configuration.

1. In the Profile Counter Field area, using the drop down boxes, select the target profile
counter field.

2. Type the number to set to or increment the profile counter by in the Value field.

3. To set the profile counter to the value, tick the Set Absolute check box.

To increment the profile counter by the value, clear the Set Absolute check box.

4. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Chapter 46
Profile Counting

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 99 of 124



Profile Date Compare
The Profile Date Compare node compares the selected Profile Date with the current system
date, and branches according to the following rules:

• the stored date is in the past (stored date is less than current date),

• the stored date is in the future (stored date is greater than current date),

• the stored date is today's date (stored date equals current date).

Node exits – Profile Date Compare
This node has one entry and five exits. The number of exits cannot be changed.

Exit Cause Description

1 Failure There was an internal error.

2 Not Found The selected Profile Date could
not be found.

3 Past The selected Profile Date is
earlier than the current system
date.

4 Today The selected Profile Date is the
same as the current system date.

5 Future The selected Profile Date is later
than the current system date.

Configuring the node – Profile Date Compare
Follow these steps to edit the Profile Date Compare node.

1. From the drop down lists in the Location of Date area, select the profile Data Type,
Location and Field that holds the stored Profile Date you want to be compared against the
current system date.

2. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Profile Date Store
The Profile Date Store feature node stores a date extension number depending on the type of
extension selected. The extended date is stored within the requested profile, for future use.

The stored date is either:

• The current system date plus the date extension (not specified = current system date).
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• The date retrieved from the store location plus the date extension.

• The best date of either the first two options.

Note: Only whole days may be stored.

Node exits – Profile Date Store
The Profile Date Store feature node has one entry and two exits. The number of exits cannot
be changed.

Exit Cause Description

1 Failure The date could not be stored for
one or more of the following
reasons:

• The date was invalid
• The profile date was missing

from the selected Profile
when a date was expected

• There was an general error

2 Success The date has been stored to the
selected profile date for the
selected profile.

Configuring the node – Profile Date Store
Follow these steps to edit the Profile Date Store feature node.

1. From the drop down lists in the Store Date To area, select the Data Type, Location and
Field where you want to retrieve and/or store the Profile Date.

Note: The available profile data is the same for all service providers on the system.

2. In the Units area select whether to add Days, Months or Years to the stored date.

3. In the Number to add area, configure the number of units of the selected type to add to the
stored date. Do one of the following:

• In the Time to add field enter the number of units to add.

• Tick the Use Profile check box and select the profile Data Type, Location and Field
where the number you want to add is stored.

The feature node checks the extended date to ensure that it is not greater than the
maximum Unix time defined for the system.

Note: If you do not specify a value here, then a value of zero is assumed.

4. If you chose Months in the Units area, then in the End month algorithm area select the
required option for adjusting end of month dates.

• Adjust up – Adding a month to the end of the current month sets the date to the last
day in the following month. Also sets the date to the last day in the following month if
the current date is the day before the last day in the month and the following month
has fewer days.

• Adjust down – Adding a month to the end of the current month sets the date to the
last day in the following month for months which have the same or fewer days than the
current month. Where the following month has more days than the current month, it
sets the date to the same day number in the month.
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• Add # days in month – Adds the number of days in the current month to the selected
Extend From date.

5. For further clarification, see Adding months example.

6. Select the type of extension required from the Extend From options.

• Today – To add the specified number of units to the current system time.

• Profile – To add the specified number of units to the date currently stored.

• Later of the two – To store the later date out of the Today and Profile options.

7. In the Timezone area select the required time zone from the drop down lists.

8. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Adding months example – Profile Date Store
This table shows some example month end adjustment results after adding one month to the
current date.

Current Date Adjust up Adjust down Add # days in month

30 January 28 February 28 February 2 March

30 April 31 May 30 May 30 May

Proportional Distribution
This node allows calls to be routed to different exits, based on the proportion of calls that are
received. The user may configure the proportions of calls to be routed to each exit.

For example, you may wish 20% of calls to be routed to one exit, and 80% of calls to be routed
to a second exit. This could be achieved by entering 20:80 in the node edit screen, or by
entering 1:4.

Shortcut keys – Proportional Distribution
The shortcut keys to add a Proportional Distribution node are Alt+D.

Node exits – Proportional Distribution
This node has one entry and may have 2 through 20 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.
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Configuring the node – Proportional Distribution
Follow these steps to configure the node.

1. Ensure that you have enough exits specified to accommodate the proportions you are
planning to configure.

2. Using the spin box for each exit, change the number displayed to show the proportion of
calls that are routed down that exit.

Note: The proportion is calculated per total across all exits. To configure the node on a
percentage basis, the total must equal 100. If there are two exits, configured with the digits
1 and 4, 1 out of 5 calls will route down exit 1 and the remaining 4 calls will route down exit
2.

3. When all proportions are as required, click Save.

Selection Dependent Routing
Use the Selection Dependent Routing feature node to play an announcement to the caller and
to route the call according to their response. In addition, you can configure a fast timeout
period that enables callers to exit directly from the feature node after timing out. For example,
you can use this feature to connect calls directly to the operator after timing out.

This feature node routes calls based on a single digit, letter, or character entered on the
caller’s telephone keypad. You map valid digits, letters, or characters to the feature node exits
in the feature node configuration window. Valid digits, letters, and characters are:

• Numbers ranging from 0 (zero) to 9

• Letters ranging from A to F

• Special characters * and #

You configure the fast timeout period (in seconds) by mapping the letter "T" to the required
feature node exit and entering a value for the fast timeout period in the Configure Selection
Dependent Routing configuration window. When you configure this option, the caller is not
prompted for a number after timing out. For details, see Setting the Fast Timeout Period –
Selection Dependent Routing.

Shortcut keys – Selection Dependent Routing
The shortcut keys to add a Selection Dependent Routing node are Alt+M.

Node exits – Selection Dependent Routing
This node has one entry and may have 2 through 20 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

There are two cases in which a caller will be sent to a branch other than the branch
corresponding to a digit selected by the caller. These are:
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Exit Cause Description

1 Not Collected The branch that the call will be
sent to after the Timeout
Announcement is played to them
the number of times set in the
Max Iterations field.

2 Hang Up The branch that the call is to be
routed down, when the caller
hangs up or there is a network
error.

Configuring the node – Selection Dependent Routing
Follow these steps to configure the Selection Dependent Routing node.

1. From the Main Announcement area, select the Main Announcement Set that contains the
main announcement to play to the caller.

Note: It is not necessary to have all the announcements that are to be played by this node
in the same announcement set.

Result: The Main Announcement Entry drop-down box will become available.

2. From the Main Announcement Entry drop-down list, select the main announcement to
play to the caller.

3. Set the Repetition field to the number of times to repeat the main announcement while the
system waits for the caller to take an action. If set to zero, the announcement will be
repeated for the length of the duration set.

4. The timeout announcement contains the announcement you want to play to the caller
when the caller has waited too long before entering a digit.

In the Timeout Announcement frame, select the following, as described in steps 2 - 5:

• Timeout Announcement Set which contains the timeout announcement

• Timeout Announcement Entry for the announcement to play

• Repetition to the number of times to repeat the announcement

• Duration to the length of time, in seconds, that the announcement is to be played.

5. The invalid digit announcement contains the announcement you want to play to the caller
when the caller has entered a disallowed digit.

In the Invalid Digit Announcement frame, select the following, as described in steps 2 -
5:

• Invalid Digit Announcement Set which contains the announcement

• Invalid Digit Announcement Entry for the announcement to play

• Repetition to the number of times to repeat the retry announcement

• Duration to the length of time, in seconds, that the retry announcement is to be
played.

6. In the Number of Retries field, set the number of times that the node will attempt to collect
a number from the caller, before routing the call to the Not Collected branch. This value
may be between 0 and 10.
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7. In the standard range entry field in the lower half of the screen, map the digits that a caller
may enter to an exit branch.

To add a digit:

• Click Add Digit

Result: A new default entry appears.

• In the Digit drop-down box, select the required digit.

• In the Branch drop-down box, select the exit to which calls receiving the entry of that
digit are to be routed.

• Click Change.

8. Repeat for the required number of mappings.

9. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The announcement set and announcement entry lists are populated with data that is
specified using the Announcements tab of the ACS Configuration screen.

For more information about configuring announcement sets and announcement entries, see
the Announcements tab of the ACS Configuration screen.

Setting the Fast Timeout Period – Selection Dependent Routing
To configure the Selection Dependent Routing feature node to exit directly after timing out:

1. Open the configuration window for the Selection Dependent Routing feature node.

2. Specify the branch that you want to use for the fast timeout exit by changing the current
configuration for a branch to T or by adding T to a branch.

To change the current configuration for a branch to T.

a. Select the digit and branch combination you want to change from the list in the digit
table.

b. Select T from the Digit list and click Change.

To add T to a branch.

a. Use the Branch arrow keys to select the branch you want.

b. Select T from the Digit list and click Add.

The Fast Timeout Period field is enabled and set to the preconfigured default value of 10.

Note: If set, the value for the SDRfastTimeoutDefault parameter in the smsGui.bat/
smsGui.sh file overrides the fast timeout period default value. For more information on
configuring ACS smsGui.bat/smsGui.sh parameters, see Advanced Control Services
Technical Guide.

3. (Optional) Change the timeout period by performing the following steps:

a. In the digit table, select T.

b. In the Fast Timeout Period field, enter the timeout value in seconds and click
Change.

4. Click Save.

The feature node configuration is saved.
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Send Notification
This node constructs message text from the given notification template and then sends the
message using one of the available transport mechanisms.

Node exits – Send Notification
This node has one entry and eleven exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The notification was constructed
and sent.

2 Delivery Failure The notification was constructed,
but encountered a problem when
attempting to send.

3 No Language No language was selected in the
node configuration.

4 No Template No template could be found to
construct the message.

5 Missing Information The template expected more
information than could be found.

6 Subscriber Opt-out The subscriber has opted out of
receiving any notifications. This
option is set in ACS
Configuration > Notifications
tab > Add/Edit Notification
Type panel.

7 Node Failure Internal node error. Message not
sent.

8 Timeout Did not get the expected
response within the Timeout
number of seconds.

9 Temporary Error The returned cause code maps
to a temporary error.

10 Permanent Error The returned cause code maps
to a permanent error.

11 Abort The returned cause code maps
to an abort error.

Note: The temporary, permanent and abort errors are all configured in the Messaging Manager
Action and Error Codes screens. From the main SMS screen, see Services > Messaging
Manager > Action and Error Codes and the Error Type column.

Configuring the node – Send Notification
Follow these steps to configure the node.

1. In the Template section, do one of:

• Provide the location of the template by selecting a profile location from the Data Type,
Location and Field lists

• Select the template to use from the Fixed lists
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• Select the location where notification template name for a specific Application type can
be found from the Data Type, Location and Field lists

2. In the Language section, do one of:

• Select Automatically determined to have the system determine the language

• Select the location where the language can be found from the Data Type, Location
and Field lists

• Select the language to use from the Fixed list

3. If a response is expected, to avoid missing the response, select the Wait for Response
check box and then enter the number of seconds to wait for the response in the Timeout
field in the Options section.

Tip: If the check box is deselected, then the node will exit the Success exit immediately.

4. Click Save.

Send Short Message
Warning: This feature node has now been deprecated and should no longer be used. This
feature node will still function in existing control plans. For new control plans please use the
Send Notification feature node.

This feature node sends a short message to the caller when triggered by a nominated
application.

Node exits – Send Short Message
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The short message was
successfully sent.

2 Failure The message could not be sent.

Configuring the node – Send Short Message
Follow these steps to configure the Send Short Message node.

1. From the Application drop down list, select application that will trigger the short message
to be sent.

2. From the Message drop down list, select the message that will be sent.

Note: Messages are created and maintained through the ACS > Configuration >
Notification tab.

3. From the Language drop down list, select the language the message will be sent in.

Note: Available languages are maintained through the ACS > Tools > Language tab.

4. Click Save.

Notes:

• The calling number is normalized before it is sent to the notificationIF.

• This node sends a SLEE notification event to the notificationIF.
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• The notificationIF will then forward the message to either Messaging Manager or the
SMSC interface depending on configuration.

• See SMSC Technical Guide for details on how to install and configure the notificationIF.

Service Handover
The Service Handover feature node allows the call to be passed to another service that runs a
control plan as if it were a new call.

Node exits – Service Handover
This node has one entry and two exits. The number of exits cannot be changed. Since this
node passes the call to another control plan, a Success exit is not required.

Exit Cause Description

1 Data Not Found The control plan selected for
handover is not found.

2 Chain Count Exceeded The chain count limit has been
exceeded, and the call may not
be passed to another control
plan.

Note: The chain count limit is set
in the acsChassis section of the
acs.conf - refer to ACS Technical
Guide.

Configuring the node – Service Handover
Follow these steps to configure the Service Handover node.

1. In the Handover to list, select a service. Calls passing through this node will be transferred
to this service.

2. Click Save.

Set
This node stores the entered digits in a data field. They may be later collected from this profile
and used in the control plan.

A percentage character will have a special meaning during the node processing. If a '%' is
entered in the digits field on the node edit screen it will be replaced by the current value of the
buffer and the buffer will be updated with that final result. Only the first occurrence of the '%'
char will be treated this way. Any other occurrences of the percentage character will be
ignored.

Node exits – Set
This node has one entry and two exits. The number of exits cannot be changed.
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Exit Cause Description

1 Success Value has been set in target
profile.

2 Error Error occurred.

Configuring the node – Set
Follow these steps to configure the Set node.

1. In the Value field type the number (in digits) to save in the selected target profile field.

2. In the Target Profile area, using the drop down boxes, select the target profile.

3. Click Save.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Set Carrier Code
This node sets the identity of the carrier for the call. The carrier code is a string of digits that
are prefixed onto the Destination Routing Address (DRA) of the connect sent by following
Termination feature nodes.

The carrier code can be set in any of the available profile blocks (for example, the Service
Number Profile).

Note: This node has no effect if the CarrierCodeDisposal parameter in acs.conf is set to 1. For
more information, see ACS Technical Guide.

Node exits – Set Carrier Code
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 CC Set Branch Used when the data is found and
the carrier code is set.

2 CC Not Set Branch Used when profile-based data is
not found. Is also used if the
length of the number string in the
profile field specified for the
carrier code is greater than the
allowable length of the carrier
code.
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Configuring the node – Set Carrier Code
Follow these steps to configure the Set Carrier Code node.

1. Select the option of:

• using the carrier number entered into this screen, or

• reading the carrier number from a profile block.

The fields relating to the non-selected option are disabled and cannot be edited.

2. Where the following option is selected:

• Use This Carrier Number

Type the carrier code in the Use This Carrier Number field.

Carrier codes may include any hexadecimal character (0-9, a-f, A-F, and # and *). You
can enter up to 20 characters.

Note: If this option is selected and the text field is empty, then the carrier code field will
be cleared when this node is triggered. Use to clear a carrier code set by an earlier Set
Carrier Code node.

• Read from Profile Block

Select the profile field to read the carrier code from using the Read From Data Type,
Read from Location and Read From Field drop down lists.

Note: If the length of the number string in the profile field specified for the carrier code
is greater than the allowable length of the carrier code, an alarm is raised and the “CC
Not Set Branch” is taken.

3. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: If you import a previously exported control plan which contains Set Carrier Code nodes
prior to the profile block functionality being introduced, then you will need to re-save in order to
allow the control plan to recompile.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

The primary tag lists are configured in the SMS > Services > ACS Service > Configuration >
Profile Tag Details and Profile Tag Mapping tabs (see ACS User's Guide, Profile Tag Details
for more information).

Set Cut and Paste
The number entered in the node configuration dialog is sent in all following INAP Connect
operations as the value of the cutAndPaste parameter.

For details about the effect of cutAndPaste, see ETS 300 374-1.

Node exits – Set Cut and Paste
This node has one entry and one exit. The number of exits cannot be changed.
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Exit Cause Description

1 Cut and Paste Set The cut and paste has been set.

Configuring the node – Set Cut and Paste
Follow these steps to configure the Set Cut and Paste node.

1. In the Cut Value field, enter the value to set the cutAndPaste parameter to in INAP
Connect operations sent to the switch from here on.

Note: If you set Cut Value to 23 or more, ACS will stop setting the cutAndPaste parameter
in INAP Connect operations.

2. Click Save.

Set Indicator
The Set Indicator node allows you to set the value one of the indicators of a specified number
sent in the CONNECT message:

• Number incomplete

• Screening

• Presentation restricted

Node exits – Set Indicator
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success Value successfully set.

2 Error Value not set due to error

Configuring the node – Set Indicator
Follow these steps to configure the node.

1. From the Select Indicator options, select the indicator to set:

• Presentation Restricted

• Screening

• Number Incomplete.

2. From Select Number drop down list, select the phone number to apply the indicator to.

• CallingPartyNumber

• AdditionalCallingPartyNumber

• OriginalCalledPartyID

• RedirectingPartyID

• LocationNumber

• LocationInformationLocationNumber
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3. Note: This list contains all the valid phone number options.

4. From the Set Indicator options, select the value to apply to the selected phone number
indicator.

Refer to the interpretation of values table below.

5. Click Save.

Interpretation of values – Set Indicator
This table describes the meaning of each value, depending on the indicator selected.

Value Presentation
Restricted

Screening Number Incomplete

0 The presentation is
allowed

User provided, but not
verified

Complete

1 The presentation is
restricted

User provided, verified
and passed

Incomplete

2 The address is not
available

User provided, verify
failed

NA

3 Spare Network provided NA

Set Pending TN from Profile
The Set Pending TN from Profile feature node takes a number from the profile and places it in
the pending termination number buffer.

This node can also be used to set the NoAnswer timeout.

Node exits – Set Pending TN from Profile
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The number has been placed in
the Pending TN buffer.

2 Data Not Found The number has not been placed
in the Pending TN buffer.

Configuring the node – Set Pending TN from Profile
Follow these steps to configure the Set Pending TN from Profile node.

1. Using the drop down lists in the Location of TN Data Type, Location and Field boxes,
select where the number is to be read from.

Notes:

• If you set a customer-specific profile, the profile set in this field must belong to the
customer who will be running the control plan.

• If the control plan is owned by the Boss user then the profile must be set to control
plan, or a customer ID must be specified at an earlier point in the control plan.
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2. Using the drop down lists in the Location of Timeout Data Type, Location and Field fields,
select where the timeout period is to be read from.

3. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Note: The list of data types is fixed at installation time for each feature node or screen.

Further reference:

• For information about profile blocks (data type, location, and field) and how to use them,
see Profile Blocks and Tags.

• The primary tag lists are configured in the SMS > Services > ACS Service >
Configuration >Profile Tag Details and Profile Tag Mapping tabs (see ACS User's
Guide, Profile Tag Details for more information).

Set Presence
This node sends a request through ACS to a third party presence server to set the availability
at a selected location of a specified subscriber or presence entity.

Before sending the request, the node prompts the user to select the following:

• The number and domain name for the presence entity to set

• An availability and location

• The implementation of the presence setting chassis action to invoke. Currently only SIP is
supported.

The presence entity number can be specified using fields which may contain (for example) the:

• Called number

• Calling party number

• Subscriber phone number

• Subscriber name

Notes:

The node relies on a protocol specific presence setting chassis action to process the request.
The library for the presence setting chassis action is delivered separately by another package,
such as scaScp.

Only one availability per location may be set for a presence entity. Each time you specify a new
availability for a particular location, the previous one is overwritten.

Following are the standard set of locations and availabilities that are delivered at installation
and that may be set for a presence entity.

Standard Locations

• Home

• Office

• PlaceOther

Standard Availabilities

• Available
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• Away

• Busy

• N/A

Node exits – Set Presence
This node has one entry and four exits. The number of exits cannot be changed.

Exit Cause Description

1 No presence entity The specified presence entity
could not be found.

2 No presence domain The presence domain does not
exist and no default presence
domain has been configured.

3 Error The presence server has
reported an error.

4 Success The presence entity was
successfully set to the configured
location and availability.

Configuring the node – Set Presence
Follow these steps to edit the node configuration.

1. From the drop down lists in the Presence Entity panel, select the Data Type. Location and
Field where the presence entity name or number is held.

2. If required, set the Domain Name field to the name of the domain to append to the
presence entity name or number.

Note: The domain will not be appended to the presence entity if it is already present in the
Field selected in the Presence Entity panel.

3. From the drop down lists in the Presence domain panel, select the Data Type, Location
and Field where the presence setting chassis action information is held.

Note: Currently only SIP presence setting is supported.

4. Set the action to be taken if the presence domain cannot be found. Select:

• Error – to report an error, or

• Use default below – to use the default presence domain. Select the default presence
domain from the drop down list.

5. Set the Location for the presence entity.

6. Select the Availability that will be set by the node for the selected location.

7. Click Save.

Set Tariff Code
This feature node sets the billing information that is sent to the switch. This may be a Furnish
Charging Information (FCI) request or a Send Charging Information (SCI) request.

Note: The SCI operation may contain a tariff code.
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It is used in conjunction with the optional Tariff Codes tab of the ACS Resources screen.
Where the Tariff Code tab has not been purchased as part of ACS, this node is not available
for use within a control plan. For more information about configuring tariffs, see ACS User's
Guide.

Node exits – Set Tariff Code
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Tariff Set A failure has occurred and a text
message has not been sent.

2 Tariff Not Set A text message has been
successfully sent.

Configuring the node – Set Tariff Code
Follow these steps to set the tariff code.

1. Use the drop-down list to select the type tariff applied to the current call. The tariff code
names available in the list are set on the Tariff Codes tab of the ACS Resources screen.

2. Click Save.

Note: Save is not available until all the required information has been selected or entered.

Sleep
The Sleep node allows time for background tasks to complete before proceeding to the next
step in the control plan.

The value used should be large enough for the background task to finish, but short enough to
avoid holding up the Control Plan unnecessarily.

Node exits – Sleep
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The control plan slept for the
configured amount of time.

2 Error In theory, should never be able to
take this branch.

Configuring the node – Sleep
Follow these steps to configure the node.

1. Enter the Sleep Time Value in milliseconds the node is to wait before branching down the
Success branch.

Note: There is a maximum sleep time allowed of 600000ms (ten minutes)

2. Click Save.
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Start
The start node must be the first node in the control plan. All feature nodes in the control plan
must be available on a branch starting from the Start node.

Shortcut keys – Start
The shortcut keys to add a Start node are Alt+S.

Note: If there is already a Start node in the Control Plan, pressing this key combination will
select the Start node.

Node exits – Start
This node has no entry and one exit. The number of exits is fixed and cannot be changed.

Configuring the node – Start
The Start node does not need to have any control plan data attached to it when operating in
standard mode, although the user must accept the default settings by opening the node edit
screen and clicking Save.

Follow these steps to configure the Start node.

1. In the Standard Mode of operation, the control plan may not contain loops. For some
advanced control plans, loops may be required. to allow loops in the control plan, select
the Loops Allowed check box.

Note: The control plan compiler will permit loops within the control plan, as long as those
loops contain at least one feature node that performs a telephony action. For example, an
attempt termination node or node that plays an announcement.

2. Click Save.

Statistic
The Statistic node either resets or increments a specified statistical counter, which may be a
specific named statistic or a profile location.

Node exits – Statistic
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success Statistic was successfully
incremented or reset.

2 Profile Update Fail Storing the statistic value failed.

3 Failure Failure to read the configured
profile tag.
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Configuring the node – Statistic
Follow these steps to configure the Statistic Increment node.

1. Select the Statistic Action, either:

• Reset - reset the statistic value to zero.

• Increment - increments the statistic by one.

2. Select the Statistic Name to action location, either:

• From a profile field - check the Derive From Profile check box.

• A named statistic - uncheck the Derive From Profile check box.

3. Select the Statistic Name to action, either:

• From a profile field - select location from the Data Type, Location and Field drop
down lists.

• Named statistic - select from the Application Id and Statistic ID drop down lists.

Note: This list is populated from entries made in the Statistic Management screens. Refer
to the SMS User's Guide for more information.

4. Optionally set the Statistic Storage location. Check the Store check box and then
selection the storage location from the Data Type, Location and Field drop down lists.

5. Click Save.

Statistic Increment
This node allows you to use statistics that you wish to track for a specific application or statistic
within an application.

Node exits – Statistic Increment
This node has one entry and two exits. The number of exits cannot be changed.

Exit Cause Description

1 Success Statistic was successfully
incremented.

2 Node Error General case for an un-handled
state in this node.

Configuring the node – Statistic Increment
Follow these steps to configure the Statistic Increment node.

1. (Required) Select the Application ID using the Application ID field drop down list.

2. (Required) Select the Statistic ID using the Statistic ID field drop down list.

Note: This list is populated from entries made in the Statistic Management screens. See
SMS User's Guide for more information.

You can produce reports on the statistic from the Service Management System Operator
Functions, Report Functions menu option. See SMS User's Guide for more information.
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Sub Control Plan
The Load Sub Control Plan node runs a successfully compiled control plan.

When this control plan is compiled, this node is effectively replaced by the other plan to create
a single run time control plan. In the CPE this plan shows the Load Sub Control Plan node with
the relevant exits that apply for the other plan.

Node exits – Sub Control Plan
This node has one entry and a varying number of exits that are set as a result of the sub
control plan. A user cannot change the number of exits.

Configuring the node – Sub Control Plan
Follow these steps to edit the node configuration.

1. (Optional) In the Search By field enter the control plan name prefix to use to filter the list of
available control plans. You can enter the following wildcards in the search string:

• % (percent) to match any string of any length

• _ (underscore) to match a single character

Tip: You can limit the number of control plans found by entering a value in Max Rows.

2. From the Control Plans list, select the control plan to load into the main control plan as a
sub-control plan.

3. (Optional) To view the selected control plan, click View.

The selected control plan opens in a new Control Plan Editor window. The control plan
structure will be read-only, but you will be able to edit the control plan data, and save it to a
new version of the control plan, if required.

• To save any changes to the control plan data, select Save from the File menu. In the
Save Data/Structure dialog box, enter a new name in the Control Plan Data field, and
click Save.

• To close the control plan, click the close window button in the top right corner of the
Control Plan Editor window.

4. Click Save.

Table Lookup
The Table Lookup feature node maps a specified prefix or CLI to a geographical routing code,
such as a postal code or an exchange code, by looking up the code in a selected table lookup
dataset. The feature node stores the resulting code in a profile field. The exit taken from the
feature node depends on whether or not a match is found for the prefix or CLI.

About table lookup datasets
A table lookup dataset contains a group of related codes, for example, for a specific
geographic area or suburb.
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A table lookup dataset can be public or private. A private table lookup dataset belongs to a
specific customer. It is only available to that customer and the parent customers linked to that
customer in the customer hierarchy. A public table lookup dataset is available to all customers.

Node exits – Table Lookup
This node has one entry and three exits. The number of exits cannot be changed.

Exit Name Cause

1 Matched A prefix has been mapped to a
code.

2 No Match No matching prefix was found in
the dataset

3 Error An internal error has occurred.

Configuring the node – Table Lookup
To configure the Table Lookup feature node:

1. Open the configuration window for the Table Lookup feature node.

2. In the Lookup Input source area select the location of the prefix or CLI that you want the
feature node to look up from the Source Data Type, Source Location and Source Field
lists.

3. In the Lookup Result target area select the location to store the resulting code from the
Target Data Type, Target Location and Target Field lists.

4. From the Dataset list, select the dataset that corresponds to the type of code you want.
You can select a publicly owned dataset or a dataset that belongs to the customer. For
more information about table lookup datasets, see About table lookup datasets.

5. Click Save.

TCAP Handover
The TCAP Handover node calls a chassisAction to construct an IDP on the existing SLEE
dialog. It then calls the TCAP interface to hand over the SLEE dialog to an external network
entity.

The available network entities are defined in acs.conf and made available to this node (SCP
Name list) through the acsGui.bat/acsGui.sh or smsGui.bat/smsGui.sh files (scfs
parameter). These will typically be SLCs, see ACS Technical Guide, topic Customizing the
screens for details.

The following IDP parameters can be configured in the node to use a specific ACS termination
number or buffer:

• Calling Party Number

• Called Party Number

• Redirecting Party ID

• Location Number

• Additional Calling Party Number

The available buffers are listed in the Buffer list.
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Note: All other fields in the constructed IDP are taken from the calling information for the
original call.

Node exits – TCAP Handover
This node has one entry and three exits. The number of exits cannot be changed.

Exit Cause Description

1 Success The node successfully passed
the TCAP dialog to another entity.

2 Bad Destination The hand over destination
defined for the specified network
entity could not be found.

3 Failure The hand over was unsuccessful.

Specifying values in profile selection fields – TCAP Handover
For each combo box combination on this screen, there are two methods of entering a value:

1. Use the drop down lists in the Data Type, Location and Field boxes, as in this example,
to select the relevant values:

2. Select Fixed Value in the Data Type box.

Result: The fields will change, as in this example, and you can type the required value in
the Fixed Value field.

Configuring the node – TCAP Handover
Follow these steps to edit the TCAP Handover feature node.

1. Select the SCP Name of the network entity for the handover destination.

2. In the IDP Parameters area, for each IDP parameter, specify the value.

You can specify the following optional IDP parameters:

• callingPartyNumber

• calledPartyNumber

• redirectingPartyID

• locationNumber

• additionalCallingPartyNumber
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3. When a TCAP handover is performed it is often desirable to preserve fields from original
incoming IDP into fields in outgoing IDP. By default, the original IDP parameter values are
preserved - the Preserve Attributes check box is selected.

To disable the original IDP parameter values preservation, deselect the check box .

4. Click Save.

For more information on profile blocks and tags, see ACS User's Guide.

Terminate to Pending TN
The Terminate to Pending TN node terminates unconditionally to the number assigned to the
PendingTN variable. For information about the PendingTN variable, see Pending termination
number variables.

This node is sometimes called Unconditional Terminate to Pending TN.

Shortcut key – Terminate to Pending TN
The shortcut key to add a Terminate to Pending TN node is Alt+Shift+U.

Node exits – Terminate to Pending TN
This node has one entry and one exit. The number of exits cannot be changed.

Configuring the node – Terminate to Pending TN
Follow these steps to configure the Terminate to Pending TN node.

1. From the National/International Prefix Location Fixed Value drop down list, select the
profile to read least cost routing configuration from. The list displays a list of all profiles
which can be read from.

For more information about profile blocks, see Profile Blocks and Tags.

If you do not want to use Least Cost Routing on this destination number, select None
Selected.

2. Click Save.

Terminate Unchanged
The number that was dialed is used to connect the call.

Node exits – Terminate Unchanged
This node has one entry and one exit. The number of exits is fixed and cannot be changed.

Exit Cause Description

1 Unconditional termination Terminate call, taking no other
actions.
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Configuring the node – Terminate Unchanged
This node requires no configuration data. You may change the Node name, if required.

Test Pending TN Type
The Test Pending TN Type node branches in one of six ways depending on the value assigned
to the PendingTNType variable.

The PendingTNType variable classifies an associated termination number as any one of:

• A number of an unknown type

• A number that accesses the PSTN directly (sometimes called an Off-Net number)

• A number that passes through a private network on its way to the PSTN (sometimes called
an On-Net number)

• A speed-dial number

• A service number

• A calling line identification (CLI)

For more information about the PendingTNType variable, see Pending termination number
variables.

Node exits – Test Pending TN Type
This node has one entry and six exits. The number of exits cannot be changed.

Exit Cause Description

1 Unknown Number type is unknown.

2 Public Network Number type is public network.

3 Private Network Number type is private network.

4 Speed Dial Number type is speed dial.

5 Service Number Number type is service number.

6 CLI Number type is CLI.

Configuring the node – Test Pending TN Type
This node requires no configuration data. You may change the Node name, if required.

Time of Day
The Time of Day node allows branching based on the time of day that the call is placed. The
branching decision is made according to the data that is entered into the node.

Shortcut keys – Time of Day
The shortcuts key to add a Time of Day node are Alt+T.
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Node exits – Time of Day
This node has one entry and may have 2 through 20 exits. You can configure the number of
exits within this range as required, using the Edit Node Exits option on the shortcut menu.
See Editing Feature Node Exits.

Configuring the node – Time of Day
Follow these steps to add a time range to the node data.

1. From the Timezone Type drop down list, select the timezone to use.

If you select Explicit Unix TZ, you need to select a specific region from the Unix
Timezone drop down list.

For more time zone information, see Time Zones.

2. From the Default field, select the branch calls that do not match a time of day range
should be routed to.

3. Click Add Range and make the changes necessary to the time range given, then choose
the branch down which calls made in this time range are to route.

4. Enter the time range in the boxes to the left of the Branch field and click Change.

5. To add another range, repeat steps 3 and 4.

6. Click Save.

Transmission Type Branching
The Transmission Type Branching node allows you to route the call to different branches
depending on the incoming calling party transmission type.

Node exits – Transmission Type Branching
This node has one entry and seven exits. The number of exits cannot be changed.

Exit Cause Description

1 Speech NA

2 Unrest. Digital Unrestricted Digital

3 Restricted Digital NA

4 3.1kHz audio NA

5 Unret. Dg. Tones Unrestricted Digital Tones

6 Video NA

7 No Bearer Cap NA

Configuring the node – Transmission Type Branching
This node requires no configuration data. You may change the Node name, if required.

Chapter 46
Transmission Type Branching

Advanced Control Services Help
G47633-01
Copyright © 2026, Oracle and/or its affiliates.

January 26, 2026
Page 123 of 124



Unconditional Termination
The Unconditional Termination node directs the call to be terminated to a specified termination
number (TN).

Termination numbers are specified as ranges of numbers in the ACS Configuration screens.
The numbers shown in the Configure Unconditional Termination screen are the ranges of
termination numbers that have been specified for the logged in ACS Customer. If the customer
for whom the control plan is being created is a managed customer, termination numbers that
have not been specified for the customer may be used in the node. For more information about
setting up ranges of numbers, see ACS User's Guide.

Note: The Unconditional Termination feature node can be set to automatically display the TN
as the feature node name by setting the useTNForNodeName parameter in the acsGui.bat/
acsGui.sh file. If this parameter is set, then you may not manually edit the feature node name.
For more information, see Advanced Control Services Technical Guide.

Shortcut keys – Unconditional Termination
The shortcut keys to add an Unconditional Termination node are Alt+U.

Node exits – Unconditional Termination
This node has one entry and one exit. The number of exits cannot be changed.

Exit Cause Description

1 Unconditional termination Terminates to the configured
termination number.

Configuring the node – Unconditional Termination
Follow these steps to configure the node.

1. To specify a termination number for the node, select the range in which the number lies
from the ranges shown.

Result: The prefix digits will be entered into the Termination Number field.

2. Use the Termination Number field to complete the number.

The Xs in the range signify the minimum number of digits that are required and the Ys
signify the maximum number of digits in the range.

3. Click Save to commit that termination number to the node.

The Save button will become available when a number that is within the selected range is
displayed in the Termination Number field.
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